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STATEMENT OF LIMITED WARRANTY

The warranties provided by IBM* in this Statement of Limited Warranty apply 
only to Machines you originally purchase for your use, and not for resale, 
from IBM or an IBM authorized re-seller. The term “Machine” means an IBM 
machine, its features, conversions, upgrades, elements, or accessories, or 
any combination of them. Machines are subject to these terms only if 
purchased in the United States or Puerto Rico, or Canada, and located in the 
country of purchase. If you have any questions, contact IBM or your re-seller.

Production Status 

Each Machine is manufactured from new parts, or new and serviceable used 
parts (which perform like new parts). In some cases, the Machine may not be 
new and may have been previously installed. Regardless of the Machine’s 
production status, IBM’s warranty terms apply.

The IBM Warranty

IBM warrants that each Machine 1) is free from defects in materials and 
workmanship and 2) conforms to IBM’s Official Published Specifications. IBM 
calculates the expiration of the warranty period from the Machine’s Date of 
Installation. The date on your receipt is the Date of Installation, unless IBM or 
your re-seller informs you otherwise.

During the warranty period, IBM or your re-seller will provide warranty 
service under the type of service designated for the Machine and will 
manage and install engineering changes that apply to the Machine. IBM or 
your re-seller will specify the type of service. 

For a feature, conversion, or upgrade, IBM or your re-seller may require that 
the Machine on which it is Statement of Limited Warranty 1 installed be 1) the 
designated, serial-numbered Machine and 2) at an engineering-change level 
compatible with the feature, conversion, or upgrade. Some of these 
transactions (called “Net-Priced” transactions) may include additional parts 
and associated replacement parts that are provided on an exchange basis. 
All removed parts become the property of IBM and must be returned to IBM.

Replacement parts assume the remaining warranty of the parts they replace.

If a Machine does not function as warranted during the warranty period, IBM 
or your re-seller will repair or replace it without charge. If IBM or your re-seller 
is unable to do so, you may return it to your place of purchase and your 
money will be refunded. 

Machine: IBM Network Color Printer

Warranty Period*: 12 months

* Contact your place of purchase for warranty service information
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If you transfer a Machine to another user, warranty service is available to that 
user for the remainder of the warranty period. You should give your proof of 
purchase and this Statement to that user. 

Warranty Service 

To obtain warranty service for the Machine, you should contact your re-seller 
or call IBM. In the United States or Canada, call your point of purchase or 
IBM customer technical support at 1-800-358-6661. You may be required to 
present proof of purchase. 

Depending on the Machine, the service may be 1) mail-in repair at IBM’s 
Depot location (called Depot Mail-in Repair), 2) a “Repair” service at your 
location (called “On-site”), 3) a “Repair” service at one of IBM’s or a re-
seller’s service locations (called “Carry-in”), or 4) “Exchange” service, either 
On-site or Carry-in. 

When a type of service involves the exchange of a Machine or part, the item 
IBM or your re-seller replaces becomes its property and the replacement 
becomes yours. The replacement may not be new, but will be in good 
working order.

It is your responsibility to: 

1. Obtain authorization from the owner (for example, your lessor) to have 
IBM or your re-seller service a Machine that you do not own; 

2. Where applicable, before service is provided: 

a. Follow the problem determination, problem analysis, and service 
request procedures that IBM or your re-seller provide, 

b. Secure all programs, data, and funds contained in a Machine, 

c. Inform IBM or your re-seller of changes in a Machine’s location, and 

d. For a Machine with exchange service, remove all features, parts, 
options, alterations, and attachments not under warranty service. 
Also, the Machine must be free of any legal obligations or restrictions 
that prevent its exchange; and 

3. If the machine is not shipped in an IBM box, be responsible for loss of, or 
damage to, a Machine in transit when you are responsible for the 
transportation charges.

4. Be responsible for any damage resulting from improper packing of a 
Machine sent to IBM for “Depot Mail-in Repair” or “Exchange.” 
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Extent of Warranty

IBM does not warrant uninterrupted or error-free operation of a Machine.

Misuse, accident, modification, unsuitable physical or operating environment, 
improper maintenance by you, or failure caused by a product for which IBM 
is not responsible may void the warranties. 

THESE WARRANTIES REPLACE ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WAR- 
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. HOWEVER, SOME LAWS DO NOT ALLOW THE EXCLUSION 
OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL 
EXPRESS AND IMPLIED WARRANTIES ARE LIMITED IN DURATION TO 
THE WARRANTY PERIOD. NO WARRANTIES APPLY AFTER THAT 
PERIOD.

In Canada, warranties include both warranties and conditions. 

Some jurisdictions do not allow limitations on how long an implied warranty 
lasts, so the above limitation may not apply to you. 

Limitation of Warranty 

Circumstances may arise where, because of a default on IBM’s part 
(including fundamental breach) or other liability (including negligence and 
misrepresentation), you are entitled to recover damages from IBM. In each 
such instance, regardless of the basis on which you are entitled to claim 
damages, IBM is liable only for: 

1. Bodily injury (including death), and damage to real property and tangible 
personal property; and

2. The amount of any other actual loss or damage, up to the greater of 
$100,000 or the charge for the Machine that is the subject of the claim.

Under no circumstances is IBM liable for any of the following: 

1. Third-party claims against you for losses or damages (other than those 
under the first item listed above);

2. Loss of, or damage to, your records or data; or

3. Economic consequential damages (including lost profits or savings) or 
incidental damages, even if IBM is informed of their possibility. 

Some jurisdictions do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply 
to you. 

This warranty gives you specific legal rights and you may also have other 
rights which vary from jurisdiction to jurisdiction.
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Notices

References in this publication to IBM products, programs or services do not 
imply that IBM intends to make these available in all countries in which IBM 
operates. Any reference to an IBM licensed product, program, or service is 
not intended to state or imply that only IBM’s product, program, or service 
may be used. Any functionally equivalent product, program, or service that 
does not infringe any of IBM’s intellectual property rights may be used 
instead of the IBM product. Evaluation and verification of operation in 
conjunction with other products, except those expressly designated by IBM, 
is the user’s responsibility.

Any performance data contained in this document was obtained in a 
controlled environment based on the use of specific data. The results that 
may be obtained in other operating environments may vary significantly. 
Users of this document should verify the applicable data in their specific 
environment. Therefore, such data does not constitute a performance 
guarantee or warranty.

IBM may have patents or pending patent applications covering subject 
matter in this document. The furnishing of this document does not give you 
any license to these patents. You can send license inquiries, in writing, to the 
IBM Corporation, IBM Director of Licensing, 208 Harbor Drive, Stamford, 
Connecticut, United States, 06904.

Trademarks
The following terms are trademarks of the IBM Corporation in the United 
States or other countries or both:

AIX

AIX/6000

IBM

OS/2

Personal System/2

PS/2

RISC System/6000

WIN-OS/2

The following terms are trademarks or registered trademarks of other 
companies:

Acrobat Adobe Systems, Inc.
Acrobat Reader Adobe Systems, Inc.
Adobe Adobe Systems, Inc.
Adobe Illustrator Adobe Systems, Inc.
Adobe logo Adobe Systems, Inc.
Adobe Persuasion Adobe Systems, Inc.
Adobe Photoshop Adobe Systems, Inc.
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Adobe Separator Adobe Systems, Inc.
Adobe Type Manager Adobe Systems, Inc.
Aldus Adobe Systems, Inc.
Apple Apple Computer, Inc.
Apple LaserWriter Apple Computer, Inc.
Apple logo Apple Computer, Inc.
AppleTalk Apple Computer, Inc.
Agfa Agfa Division, Miles, Inc.
AXIS AXIS Communication, Inc.
ColorSync Apple Computer, Inc.
CorelDRAW Corel Corporation
EPS (Encapsulated PostScript) Altsys Corporation
Ethernet Xerox Corporation
EtherTalk Applice Computer, Inc.
Excel Microsoft Corporation
Fiery Electronics for Imaging, Inc.
Fiery Driven Electronics for Imaging, Inc.
Fiery XJ Electronics for Imaging, Inc.
Fiery logo Electronics for Imaging, Inc.
IPX (Internetwork Packet 
Exchange)

Novell, Inc.

ITC Advant Garde Gothic International Typeface Corp.
ITC Bookman International Typeface Corp.
ITC Zapf Chancery International Typeface Corp.
ITC Zapf Dingbat International Typeface Corp.
Macintosh Apple Computer, Inc.
Macromedia Freehand Altsys Corporation
Microsoft Microsoft Corporation
Microsoft PowerPoint Microsoft Corporation
Microsoft Word Microsoft Corporation
MS-DOS Microsoft Corporation
NetWare Novell Inc.
Novell Novell Inc.
Pagemaker Adobe Systems, Inc.
PANTONE Pantone, Inc.
PostScript Adobe Systems, Inc.
PowerBook Apple Computer, Inc.
QuarkXPress Quark, Inc.
QuickDraw Apple Computer, Inc.
TrueType Apple Computer, Inc.
Univers Linotype AG and Subsidiaries
UNIX X/Open Company, Ltd.
Windows Microsoft Corporation
WordPerfect WordPerfect Corporation
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Communications Statements for Class B Devices

Federal Communication Notices Commission (FCC) Statement

NOTE: This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver 
is connected.

• Consult an IBM authorized dealer or service representative for help.

Properly shielded and grounded cables and connectors (IBM partnumber 68X3949 or its 
equivalent for PC parallel) must be used in order to meet FCC emission limits. Proper cables 
and connectors are available from IBM authorized dealers. IBM is not responsible for any radio 
or television interference caused by using other than recommended cables and connectors or 
by unauthorized changes or modifications to this equipment. Unauthorized changes or 
modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation.

European Union (EU) Electromagnetic Conformity Statement:

This product is in conformity with the protection requirements of EU Council Directive 89/336/
EEC on the approximation of the laws of the Member States relating to electromagnetic 
compatibility. IBM cannot accept responsibility for any failure to satisfy the protection 
requirements resulting from a non-recommended modification of the product, including the 
fitting of non-IBM option cards.

EU Conformity Statement: This product has been tested and found to comply with the limits for 
Class B Information Technology Equipment according to CISPR 22/European standard EN 
55022. The limits for Class B equipment were derived for typical environments to provide 
reasonable protection against interference with licensed communication devices.

German Conformity Statement: Dieses Gerät erfüllt die Bedingungen der EN 55022 Klasse B.

Industry Canada Compliance Statement: This Class B digital apparatus meets the requirements 
of the Canadian Interference-causing equipment regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le 
matèriel brouiller du Canada.
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Japanese VCCI Class 2 ITE Statement.

Safety Notices
There are three levels of safety notices:

DANGER calls attention to a situation that is potentially or extremely 
hazardous to people.

CAUTION calls attention to a situation that is potentially hazardous to people.

Attention calls attention to the possibility of damage to a program, device, 
system, or data.   Attention notices are located throughout this publication, 
but are not listed here.

Translations of the safety notices used in this library are found in IBM 
Network Color Printer: Safety Information. This manual is shipped with the 
printer and is provided with the maintenance documentation.

Safety Precautions

Electrical Safety

This printer is inspected and listed by recognized national testing 
laboratories, such as Underwriters Laboratories, Inc. (UL) in the U.S.A. and 
Canadian Standards Association (CSA) in Canada. Listing of a product by a 
national testing laboratory indicates that the product is designed and 
manufactured in accordance with national requirements intended to minimize 
safety hazards. IBM equipment meets a very high standard of safety in 
design and manufacture. Remember, however, that this product operates 
under conditions of high electrical potentials and heat generation, both of 
which are functionally necessary.

Because the paper and toner used in the printer can burn, you should take 
normal precautions to prevent fire. These precautions include common-
sense measures, such as keeping potentially combustible materials (for 
example, curtains and chemicals) away from the printer, providing adequate 
ventilation and cooling, limiting unattended operation, and having trained 
personnel available and assigned to the printer.

Laser Safety

This printer complies with the performance standards set the by U.S. Food 
and Drug Administration for a Class 1 Laser Product. This means that the 
printer belongs to a class of laser products that does not produce hazardous 
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laser radiation in a customer access area. This classification was 
accomplished by providing the necessary protective housing and scanning 
safeguards to ensure that laser radiation is inaccessible or within Class 1 
limits. 

There are various tool-operated machine covers that should be moved, 
removed, or replaced only by trained service personnel. There are no 
operator controls or adjustments associated with the laser.

No operator maintenance is required to keep the product in compliance as a 
Class 1 Laser Product. No adjustments that affect laser operation or power 
are accessible to the operator.

Note: See IBM Network Color Printer: Safety Information for national 
language translations regarding laser safety.

Disposal of Materials

This printer may contain materials, either as components or supplies that are 
regulated by government agencies for disposal. Dispose of all such items in 
accordance with your governmental agencies regulations.

Preface

This publication describes how to install printer drivers and end-user 
software and how to print using the IBM Network Color Printer.

Audience
This publication is intended for an end user who prints to the IBM Network 
Color Printer. 

Organization and Contents of This Guide 

This publication describes how to install the end-user software that comes 
with the IBM Network Color Printer and how to set up and print on the printer 
from Macintosh and PC-compatible computers. 

For information on installing the printer on TCP/IP, IPX (Novell), or Windows 
NT networks, see the IBM Network Color Printer:  Administrator’s Guide. For 
general information on using your computer, your application software, or 
your network, see the manuals that accompany those products.

Chapter 1, “Introducing Your IBM Network Color Printer” introduces the IBM 
Network Color Printer, the different configuration versions supported, and the 
performance and functionality of each printer configuration version.

Chapter 2, “Configuring Your Macintosh to Use the IBM Network Color 
Printer” guides you through the steps for configuring a Macintosh computer 
to use the IBM Network Color Printer. This chapter includes information on 
installing printer drivers, printer description files, and utilities. It also explains 
how to set up to print from the Macintosh.
viii User’s Guide



Chapter 3, “Getting the Best Results from Your Macintosh Applications” 
provides tips on printing to the IBM Network Color Printer using various 
Macintosh applications. Specific applications are discussed, such as Adobe 
Photoshop or Macromedia FreeHand.

Chapter 4, “Configuring Windows 3.1x to Use the Network Color Printer” 
guides you through the steps for configuring a computer running Windows 
3.1x to use the IBM Network Color Printer. The chapter includes information 
on installing printer drivers, printer description files, and utilities. It also 
explains how to set up to print from the Windows 3.1x PC.

Chapter 5, “Configuring Windows NT to Use the IBM Network Color Printer” 
guides you through the steps for configuring a computer running Windows 
NT to use the IBM Network Color Printer. The chapter includes information 
on installing printer drivers, printer description files, and utilities. It also 
explains how to set up to print from the Windows NT PC.

Chapter 6, “Configuring Windows 95 to Use the Network Color Printer” 
guides you through the steps for configuring a computer running Windows 95 
to use the IBM Network Color Printer. The chapter includes information on 
installing printer drivers, printer description files, and utilities. It also explains 
how to set up to print from the Windows 95 PC.

Chapter 7, “Getting the Best Results from Your Windows Applications” 
provides tips on printing to the IBM Network Color Printer using various 
Windows applications. Specific applications are discussed, such as 
CorelDRAW and Microsoft PowerPoint.

Chapter 8, “Using the Utilities” guides you through using the IBM Network 
Color Printer Spooler and Downloader utilities. Information on managing print 
jobs, downloading files and fonts, and utilities functionality is included.

Appendix A, “Using the Fiery Calibrator” tells you how to install and use the 
Fiery Calibrator to enhance the color consistency of your IBM Network Color 
Printer across time.

This publication also contains a glossary, including abbreviations, and an 
index.
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Related Publications
The following publications are included with this printer:

• IBM Network Color Printer: Installation and Relocation Guide, G544-5362

• IBM Network Color Printer:  Operator’s Guide, S544-5361

• IBM  Network Color Printer: User’s Guide, S544-5363

• IBM  Network Color Printer: Administrator’s Guide, S544-5364

• IBM Network Color Printer: Safety Information, G544-5352

Note: The above publications are available in Adobe Acrobat Reader format 
on the CD-ROM shipped with this printer. You can view these 
publications or print them using Adobe Acrobat Reader.

If you wish to purchase additional copies of the publications, please contact 
your point of purchase or your IBM Marketing Representative.
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Chapter 1.  Introducing Your IBM Network Color Printer
Congratulations on purchasing your new IBM Network Color Printer.   The 
Network Color Printer is a color laser printer with a number of advanced 
features.   It can produce single-sided monochrome prints at rate of 12 
impressions per minute (IPM) and full-color prints at a rate of 3 IPM.  The 
printer has a cyan-magenta-yellow-black (CMYK), full-color laser engine that 
prints 16 gray levels per color.  It prints PostScript jobs in Windows, 
Macintosh, and UNIX environments. 

The IBM Network Color Printer comes in three memory configurations:

• The 16-megabyte (MB) configuration provides advanced network 
connectivity and high quality color laser printing.  This is the default 
configuration.

• The 32-MB configuration provides on-printer queuing and spooling, 
expanded network connectivity, and faster printing.

• The 48-MB configuration provides all of the functionality described above, 
as well as increased printing speed and higher print quality on especially 
complex color print jobs.

Each of the three printer configurations provides a high level of print quality.  
However, these configuration options allow you to balance cost, 
performance, and printer features in a way that is right for your organization. 

The 16-MB Printer Configuration
The 16-MB configuration provides high quality color printing at a very 
competitive price and is a good choice for home offices and other small-scale 
business applications.

Performance
The 16-MB configuration is best suited for print jobs where the color areas 
are predominantly presentation graphics and color text.  These types of jobs 
will print at up to three pages per minute (3ppm) with the highest quality.  As 
applications include more images, they may print at less than 3ppm.  They 
will still print with very high quality. 

Features
The 16-MB configuration offers several features for high-quality printing.

Network Connectivity: The 16-MB configuration provides network 
connectivity.  It can receive jobs at the same time from TCP/IP users, Novell 
NetWare servers, Windows NT servers and workstations, and Macintosh and 
other AppleTalk users.
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Rendering Styles: The 16-MB configuration enables you to choose between 
four rendering styles.  They are:

• Photographic style - used for bitmap images
• Presentation style - used for presentations graphics
• Monitor style - used to emulate monitor screen appearance
• Solid Color style - used for spot-color graphics, such as logos.

The 32- and 48-MB Printer Configurations
The 32- and 48-MB configurations provide high-speed, high-quality color 
printing.  They provide sophisticated print server functionality, including on-
printer queuing, spooling, and job storage.  They also provide easy-to-use 
client software for managing stored jobs.  Both configurations are capable of 
handling a heavy load of graphics-intensive jobs.

Queuing, Spooling, Job Storage, and Security
In the 32- and 48-MB configurations, the Network Color Printer behaves like 
a print server in that it provides server-like job storage and management 
functionality.  It provides this functionality through the Print queue, Printed 
queue, Hold queue, and Direct queue.  Each queue can be enabled and 
configured according to your system needs.

The Print Queue

The Print queue is a job storage, queuing, and spooling area.  When you 
submit a job to the print queue, the printer receives the job and stores it on 
the printer’s hard disk.  This frees your workstation, PC, or Macintosh to do 
other things rather than remaining busy with the job.

Jobs in the Print queue print in the order in which the printer receives them.  
When jobs are in the print queue, you can use the Spooler utility to change 
their attributes, such as Copies and Rendering Style, and to move them to 
the Hold queue or to discard them.  Instructions on using the Spooler utility 
are in “Using the Spooler Utility” on page 8–8.  After printing, jobs in the Print 
queue move automatically to the Printed queue if it is enabled at the printer. 

The Printed Queue

When a job from the Print queue finishes printing, the job moves into the 
Printed queue for temporary storage.  (If the Printed queue is not enabled at 
the printer, jobs that have been printed are discarded from the printer hard 
disk.) After a job is in the Printed queue, you can use the Spooler utility to 
change its attributes, such as Copies and Rendering Style, or to move it to 
the Print queue or the Hold queue or to discard it.  Instructions on using the 
Spooler utility are in “Using the Spooler Utility” on page 8–8. 
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The size of the Printed queue is determined by a setting configured at the 
printer that limits the number of jobs held from 1 to 99.  (The default is 10).  
Configuring the Printed queue sets the maximum number of jobs that the 
Printed queue can keep at any one time.  When the Printed queue is full, the 
oldest job is discarded.

The Hold Queue

The Hold queue is a job storage area.  When you submit or move a job to the 
Hold queue, the printer receives the job immediately and stores the job on 
the printer’s hard disk.  Jobs in the Hold queue do not print or clear from the 
printer until someone uses the Spooler utility to move them to the Print queue 
or to discard them from the printer hard disk.

The Direct Queue

The Direct queue provides a direct connection to the Network Color Printer, 
bypassing the printer hard disk.  When you submit a job to the Direct queue, 
the printer accepts the job when it is ready to print the job.  The Direct queue 
does not store jobs on the printer hard disk and so does not provide job 
spooling.  This provides a measure of security for sensitive documents, such 
as personnel or payroll documents.

Jobs submitted to the Direct queue stay on the submitting server, 
workstation, PC, or Macintosh and keep it busy spooling the job until the 
printer is between Print queue jobs.  Then the printer pauses the Print queue 
to process one Direct job. 

Note: Printing to the Direct queue can take a long time if the job the printer is 
currently processing takes a long time or if there are many jobs going 
to the Direct queue.

Performance
This section discusses the performance of the 32- and 48-MB printer 
configurations with different kinds of print jobs.

• The 32-MB printer configuration is best suited for print jobs with medium-to-
large size color image areas.  Medium image areas cover less than one-
fourth of a page; large image areas cover one-fourth to one-half of a page.  
With the 32-MB printer configuration, most print jobs with medium-sized 
image areas will print at 3ppm.  Some complex print jobs with large image 
areas may print at less than 3ppm, but all will print with the highest quality. 

• The 48-MB printer configuration is best for print jobs with large sized to full-
page sized image areas.  With the 48-BM configuration, most print jobs will 
print at 3ppm, and all will print with the highest quality.  
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The IBM Network Color Printer Utilities
Three utilities are provided with the IBM Network Color Printer.  This section 
provides an overview of each one.

IBM Color Downloader

The IBM Color Downloader utility provides the ability to print PostScript and 
Encapsulated PostScript files directly to your Network Color Printer without  
using the application with which the files were created.  The Downloader 
utility also allows you to download PostScript fonts to the Network Color 
Printer hard disk and to delete PostScript fonts from the printer hard disk.  
Only fonts that are not part of the permanently-installed set can be deleted.  

The Downloader utility is supported for the 32- and 48-MB printer 
configurations.  It runs on the Windows NT, Windows 95, and Macintosh 
operating systems.  It is shipped with the printer on diskettes and on the 
Customer CD-ROM.

IBM Color Spooler

The IBM Color Spooler utility is designed for managing print jobs on the 
printer hard disk.  It enables you to look at the order of print jobs in the Print 
queue, change job-option settings, delete jobs, and move jobs between the 
printer queues (except the Direct queue).  Using the Spooler utility you can 
also access the Job Log.  This is a record of the jobs that have been printed.  
Using the Spooler utility you can view it, print it, and save it to a file. 

The Spooler utility is supported for the 32- and 48-MB Network Color Printer 
configurations.  It runs on the Windows NT, Windows 95, and Macintosh 
operating systems.  It is shipped with the printer on diskettes and on the 
Customer CD-ROM.

Fiery Calibrator

The Fiery Calibrator utility allows you to calibrate your IBM Network Color 
Printer.  This enables you to keep your printer’s colors at a consistent 
performance level across time.

The Calibrator utility is supported for all three of the Network Color Printer 
configurations.  It runs on the Macintosh operating system only.  It is shipped 
with the printer on diskettes and on the Customer CD-ROM.
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Chapter 2.  Configuring Your Macintosh to Use the IBM 
Network Color Printer

The general steps for installing the user software and setting up printing are:

• Install the PostScript Level 2 Printer Driver.

• Install the User Software and Color Reference Pages.

• Install the documentation files.

Accessing the Customer CD-ROM from Your Macintosh
The following sections discuss accessing the Customer CD-ROM over the 
network and from a CD-ROM drive on your Macintosh. If you are installing 
from diskette, skip to “Installing the PostScript Level 2 Printer Driver on Your 
Macintosh” on page 2–3.

Accessing the Customer CD-ROM from a Drive on Your Macintosh
1. If you are using an external CD-ROM drive, connect it to your Macintosh.

2. Insert the Customer CD-ROM.

3. The Customer CD-ROM icon appears on your desktop. It is open, and the 
window displays the language folders.

4. Double-click the folder that corresponds to your language.

5. Double-click on the MAC folder to open it.  The Software Installer and the 
DRIVERS and UTILS folders are displayed.

Now you have access to the Customer CD-ROM.  See “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3 for 
instructions on installing the printer driver.

Accessing the Customer CD-ROM across the Network
This section describes how to access the Customer CD-ROM if another 
Macintosh or a server on the network is sharing it. 

Before you begin:    

1. Make sure the Macintosh or server is sharing the CD-ROM.

2. Find out the name by which it is being shared on the network.

3. Make sure that you have a login and password to access the shared 
Customer CD-ROM if necessary.

(For instructions on configuring a Macintosh or server to share the Customer 
CD-ROM, see the IBM Network Color Printer: Administrator’s Guide.)
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To access the Customer CD-ROM over the network:    

1. On your Macintosh, select Chooser from the Apple menu.

2. In the Chooser window, click the AppleShare icon.

If your network has zones, select the zone in which the AppleShare 
server resides.  This displays a list of AppleShare servers in that zone.

3. From the list of AppleShare servers, double-click on the one that is 
sharing the Customer CD-ROM.

The Connect window appears.

Select Guest or Registered User.  

• If you do not need a login and password, select Guest, click on the OK 
button and go on to step 4.

• If you need a login and password, select Registered User and click on 
the OK button. Enter the login and password, click on the OK button, 
and go on to step 4.

4. The Select window appears.

Select the Customer CD-ROM by single-clicking on it.  Do not check the 
box at the right. 

Click on the OK button.  This causes the Customer CD-ROM icon to be 
displayed on your desktop.

You now have access to the Customer CD-ROM.  Continue with “Installing 
the PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.
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Installing the PostScript Level 2 Printer Driver on Your 
Macintosh

This section explains how to install the PostScript Level 2 Printer Driver and 
IBM Network Color Printer printer page description (PPD) file.  Installing this 
driver and PPD enables you to take advantage of PostScript level 2 features 
such as CMYK color and printer-specific features such as Rendering Style.

The PostScript Level 2 Printer Driver is available on the Customer CD-ROM 
or on diskette. 

• If you are installing from diskette, go to “Installing the Printer Driver from 
Diskette.”

• If you are installing from the Customer CD-ROM make sure that you have 
access to it. Refer to “Accessing the Customer CD-ROM from Your 
Macintosh” on page 2–1 for instructions. Then see “Installing the Printer 
Driver from CD-ROM” on page 2–4.

Installing the Printer Driver from Diskette
Use this section to install the PostScript Level 2 Printer Driver from the 
Macintosh Driver diskette.

To install the PostScript Level 2 Printer Driver from diskette:    

1. Insert the Macintosh Printer Driver diskette.

2. Click on the diskette icon to open it.  

3. Double-click the icon for the Adobe PSPrinter Installer to run it. Follow the 
instructions on the screen.

4. When the installer has finished:

• If you use QuarkXpress see “Installing the QuarkXPress Printer 
Description File” on page 2–5.

• Otherwise, see “Installing the User Software on Your Macintosh” on 
page 2–6.
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Installing the Printer Driver from CD-ROM
Use this section to install the PostScript Level 2 Printer Driver from the 
Customer CD-ROM.

Note: Make sure you have already accessed the Customer CD-ROM over 
the network or by inserting it into your CD-ROM drive. Instructions for 
accessing it over the network are in “Accessing the Customer 
CD-ROM across the Network” on page 2–1. The Customer CD-ROM 
icon should be on your desktop.

Since the Adobe PSPrinter installer does not work from within a subdirectory, 
you can install the driver manually from the CD-ROM or copy files from the 
CD-ROM to a diskette and install automatically from the diskette.

• To copy the driver files to diskette, see “To copy the printer driver files to 
diskette” on page 2–5.

• To install the printer driver and printer description files manually from the 
CD-ROM, see the section that follows, “To install the PostScript Level 2 
Printer Driver from CD-ROM.”

To install the PostScript Level 2 Printer Driver from CD-ROM:    

1. Double-click on the Customer CD-ROM to open it.

2. Click on the folder for the language you wish to select.

The language folder displays a DOC folder and a folder for each 
operating system. 

3. Double-click on the MAC folder to open it.  The DRIVERS folder and the 
UTILS folder are displayed.

4. Double-click on the DRIVERS folder to open it.  This displays the:
PSPrinter icon
IBM Network Color Printer file
QuarkXPress (PDF) folder
PSPrinter Diskette icon

5. In your System folder, double-click on the Extensions folder to open it.

6. Click and drag the PSPrinter icon from the DRIVERS folder into the 
Extensions folder. 

7. In the open Extensions folder, find the Printer Descriptions folder.

8. Click and drag the IBM Network Color Printer file from the DRIVERS folder 
into the Printer Descriptions folder.

9. Close the folders you have opened and:

• If you use QuarkXpress see the following section, “Installing the 
QuarkXPress Printer Description File.”

• Otherwise, see “Installing the User Software on Your Macintosh” on 
page 2–6.
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To copy the printer driver files to diskette:    

1. Double-click on the Customer CD-ROM to open it.

2. Double-click on the folder for the language you wish to select.

The language folder displays a DOC folder and a folder for each 
operating system. 

3. Double-click on the MAC folder to open it.  The DRIVERS folder and the 
UTILS folder are displayed.

4. Double-click on the DRIVERS folder to open it.  This displays the:
PSPrinter icon
IBM Network Color Printer file
QuarkXPress (PDF) folder
PSPrinter Diskette image 

(You may need to scroll or enlarge the window to see all the files and 
folders.)

Note: You can use a diskette-duplicator application to create diskettes 
from the PSPrinter Diskette image. To do so, follow the 
instructions that came with the application. This section gives 
instructions for copying the files manually.

5. Double-click to open the PSPrinter Diskette icon.

6. Insert a blank diskette into your diskette drive.

7. Shift-click to select all the contents of the PSPrinter Diskette. Drag them 
into the empty diskette. A status bar displays as the files are copied into 
the diskette.

8. To install from the diskette you just created, see “Installing the Printer 
Driver from Diskette” on page 2–3.

Installing the QuarkXPress Printer Description File

Use this section if you have QuarkXPress on your system.  Quark requires 
an additional printer description file. 

1. Open the QuarkXPress (PDF) folder. This displays the file: 
IBM Network Color Printer.PDF.PDF 

2. Install the file in one of these locations:

QuarkXPress 3.2 Put the file in the folder where QuarkXPress is 
located.

QuarkXPress 3.3 Put the file in the PDF folder inside the folder where 
QuarkXPress is located.
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Installing the User Software on Your Macintosh
This section contains instructions for installing the user software from the 
Customer CD-ROM and from diskettes onto your Macintosh computer. 

To install the software from diskettes, see “Installing the User Software from 
Diskette” on page 2–8.

To install the software from the Customer CD-ROM, proceed to the following 
section, “Installing the User Software from the Customer CD-ROM.”

Installing the User Software from the Customer CD-ROM
The following user software is included on the Customer CD-ROM:

To install software from the CD-ROM:    

1. Double-click on the Customer CD-ROM icon to open it. 

2. Double-click on the folder that corresponds to the language you wish to 
select.

3. Double-click on the MAC folder to open it. This displays the FONTS, 
UTILS, and DRIVERS folders. If necessary, install the screen fonts from 
the FONTS folder.

4. Double-click on the UTILS folder to open it. This displays the Spooler and 
Downloader icons, and the Color Reference folder.

IBM Color 
Downloader 

Utility

This utility enables you to print PostScript and Encapsulated 
PostScript files directly to the printer without using the 
application in which the files were created.  Printing with the 
Downloader is faster than printing from within applications.  
The Downloader also enables you to manage the fonts 
installed on the printer.

IBM Color 
Spooler Utility

This utility enables you to view the order and priority of print 
jobs, to customize printer settings for jobs, and to delete jobs 
and move jobs between queues.  You can also use it to see 
what jobs the printer has completed.

Fiery Calibrator 
Utility

This utility enables you to keep your printer’s colors at a 
consistent performance level across time. For instructions, 
see “Using the Fiery Calibrator” on page A–1.

Screen Fonts This is a file of screen fonts for the 39 PostScript fonts 
installed on the printer.  Install the screen fonts only if they are 
not already installed on your Macintosh. 

Color Reference
Files

The Color Reference pages are PostScript files that you can 
print using the Downloader utility, thus enabling you to view 
the range of CMYK and Pantone colors available on your 
printer. 
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5. Click on the items you want to install, and drag them to the location on 
your hard drive in which you want to keep them.  

• You might want to keep the utilities in a folder with your other utilities 
or create a new folder for them.

• Put the Color Reference folder anywhere you like.  It contains these 
color reference pages:

CMYK_REF.PS
PANTONEC.PS
PANTONEU.PS

After you are done installing the utilities, you can use the Downloader to print 
the color reference pages. Use the color reference pages to see how specific 
CMYK and PANTONE colors print on your IBM Network Color Printer. For 
instructions on using the Downloader and Spooler utilities, see “Using the 
Utilities” on page 8–1.

Installing Screen Fonts on Your System

To use screen fonts, you must install them on your system. If they are 
already installed on your system, you do not need to install them again. 

Note: If Adobe Type Manager is installed on your Macintosh, you do not 
need to install these screen fonts.

If you use a font management utility such as Suitcase II or Font Juggler, 
follow the instructions included with the utility.  If you do not use a font 
management utility, install the screen fonts as described in your Macintosh 
documentation (by dragging the files to your System Folder).

For every PostScript font you want to use in a document, you must install at 
least one point size of the screen font on your Macintosh.  The more sizes 
and styles you install, the greater the variety of type your Macintosh can 
display clearly.  Each point size and style occupies between 3K and 12K of 
disk space.  It is usually a good idea to install at least the 10- and 12-point 
sizes of each font in the regular, bold, italic, and bold italic versions.
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Installing the User Software from Diskette
The user software available on diskettes is:

To install software from the Network Color Printer diskettes:    

1. Insert the Spooler Utility diskette in your diskette drive. 

2. Double-click on the diskette icon to open the diskette.  The icon for the 
Spooler utility is displayed.

3. Double-click on the hard disk icon to open your hard disk.

4. If you wish to, create a new folder on your hard disk in which to keep the 
IBM Network Color Printer utilities.

5. Click and drag the Spooler icon from the open diskette to your open hard 
disk. 

6. By clicking and dragging it, move the new Spooler icon on your hard disk 
to the location at which you want to keep the network printer utilities.

7. Eject the Spooler Diskette by clicking and dragging it into the Trash icon.

8. Insert the Downloader Utility diskette into your diskette drive. 

9. Double-click on the diskette icon to open the diskette.  The icon for the 
Downloader utility is displayed.

10. Double-click on the hard disk icon to open your hard disk.

11. Click and drag the Downloader icon from the open diskette to your open 
hard disk. 

12. By clicking and dragging it, move the new Downloader icon on your hard 
disk to the location at which you keep the network printer utilities.

13. Eject the Downloader diskette by clicking and dragging it into the Trash 
icon.

For instructions on using the Downloader and Spooler utilities, see “Using 
the Utilities” on page 8–1.

IBM Color 
Downloader 

Utility

This utility enables you to print PostScript and Encapsulated 
PostScript files directly to the printer without using the 
application in which the files were created.  Printing with the 
Downloader is faster than printing from within applications.  
The Downloader also enables you to manage the printer fonts 
installed on the printer.

IBM Color 
Spooler Utility

This utility enables you to view the order and priority of print 
jobs, customize printer settings for jobs, delete jobs, and 
move jobs between queues.  You can also use it to see what 
jobs the printer has completed.

Fiery Calibrator This utility enables you to keep your printer’s colors at a 
consistent performance level across time. For instructions, 
see “Using the Fiery Calibrator” on page A–1.
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Installing the Documentation and Adobe Acrobat Reader
The documentation files and Adobe Acrobat Reader are available on the 
Customer CD-ROM.  Installing the documentation files and Adobe Acrobat 
Reader allows you to view and print the documentation files at any time.

To install the documentation and Acrobat Reader:    

1. In the open Customer CD-ROM, double-click to open the folder that 
corresponds with your language.  This displays the DOC folder and the 
folders that correspond with the different operating systems. 

2. Double-click on the DOCS folder to open it.  This displays the icons of the 
books and the ACROBAT folder. Open the MAC folder to see the Adobe 
Acrobat Reader 2.0 Installer.

3. Double-click on the Acrobat Reader Installer icon to install Reader.

4. At this point, you are guided by instructions displayed on the screen of 
your computer.  Follow these instructions.

5. Click and drag the documentation files from the open DOC folder to the 
location on your hard disk in which you want to store the books. 

After you have installed Acrobat Reader and the documentation files, you 
can view and print any of the books by double-clicking the Acrobat Reader 
icon, and then opening the book from within Reader.

Setting up for Printing to the IBM Network Color Printer 

After you install the printer driver files and printer description files, you need 
to set them up to take full advantage of the printer features.  Use the Chooser 
desktop utility to associate the printer with the correct printer description file. 

The set-up process is different if you will submit jobs directly to the printer 
than if you will submit jobs to a network server queue that is connected to the 
printer.  If you will submit jobs to a network server queue that is connected to 
the printer, see “To set up for printing to a server that is connected to the 
printer” on page 2–11.  If you will submit jobs directly to the printer, continue 
with the following section.

To set up for printing to the printer:    

1. Select the Chooser desktop utility from the Apple menu.

2. Locate the PSPrinter icon.  You may have to scroll down to see it.  When 
you have located it, click on it.
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3. If your network has zones, click the zone in which the printer resides.  This 
displays a list of printer devices in that zone. In this list, the printer 
appears once for each printer queue that is enabled.  For example, 
assume:

• Your printer is named “IBMnetcolor”

• The Print queue, Hold queue, and Direct queue on your printer are all 
enabled. 

Your printer appears in the list like this:

4. Click on one of the printer queues and click on the Setup button. 

The PostScript Level 2 Printer Driver automatically selects the IBM 
Network Color Printer printer description file, and sets up the printer 
queue.  The printer queue now has a color icon next to it.

5. Repeat step 4 for each of the printer queues you will use.

6. Decide which queue to use first and select that queue.  Base your 
decision on the following information about the three queues:

Print queue:

When you submit a job to the Print queue, the printer receives the job, 
storing it on the printer hard disk.  This frees your Macintosh to do other 
things, rather than waiting for the printer to become available and the job 
to print. 

• Jobs in the Print queue print in the order in which the printer receives 
them.  However if a job has not yet begun printing, you can use the 
Spooler utility to move it from the Print queue to the Hold queue or to 
the trash.  After printing, jobs in the Print queue move automatically to 
a job storage area on the printer hard disk, the Printed queue.  (This 
happens only if the Printed queue is enabled.) 

• You cannot put jobs directly into the Printed queue, which is why this 
queue does not appear in the Chooser.  When a job is in the Printed 
queue, you can use the Spooler utility to change its attributes, move it 
into the Print queue or Hold queue, or discard it.  See “Using the 
Spooler Utility” on page 8–8 for instructions on using the Spooler 
utility. When the Printed queue contains its maximum allowable 
number of jobs, it discards its oldest job.  This number is configurable 
by the printer administrator. 
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Hold queue:

When you submit a job to the Hold queue, the printer receives the job, 
storing it on the printer hard disk. 

A job in the Hold queue remains there until someone uses the Spooler 
utility to move it to the Print queue or to discard it.

Direct queue:

When you submit a job to the Direct queue, the printer does not begin to 
receive the job until it is ready to print the job.  The Direct queue does not 
store jobs on the printer hard disk.  This may be useful to you if you are 
printing a sensitive document, such as a personnel document.

Jobs you submit to the Direct queue stay on your Macintosh and keep 
your Macintosh busy until the printer is between jobs from the Print 
queue.  Then the printer pauses the Print queue to process one Direct job.  
Note that printing to the Direct queue can take a long time if the job the 
printer is currently processing takes a long time or if there are other jobs 
before yours going to the Direct queue.

Jobs that print through the Direct queue do not go into the Printed queue 
after printing.

7. Close the Chooser.

8. Go to “Printing from Your Macintosh” on page 2–12“.

The printer queue that you chose in the preceding steps is selected as your 
printer.  It will stay selected until the next time you use the Chooser to select 
a different printer queue or a different printer. Go on to “Printing from Your 
Macintosh” on page 2–12.

To set up for printing to a server that is connected to the printer:    

1. Select the Chooser desktop utility from the Apple menu.

2. Locate the PSPrinter icon.  You may have to scroll down to see it.  When 
you see it, click on it.

3. If your network has zones, click on the zone in which the server resides.  
A list of devices in that zone is displayed. 

4. The server queue that is connected to the printer appears in this list.  Your 
administrator can tell you the name that represents the server queue. 

5. Click on the server queue to select it and click on the Setup button.

6. A progress box displays as your Macintosh tries to set up the queue 
automatically.  Then the Select a PostScript Printer Description File 
dialog box is displayed. 
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7. Click on IBM Network Color Printer and click on the Select button.  The 
Setup dialog box appears; it tells you which printer description file you just 
selected. Make sure it is the IBM Network Color Printer.

8. Click on the OK button.  The Chooser shows the queue with a color icon 
next to it. Jobs that you submit to the server queue will be correctly 
formatted for the IBM Network Color Printer. Close the Chooser.

The printer queue that you chose in the preceding steps is selected as your 
printer.  It will stay selected until the next time you use the Chooser to select 
a different printer queue or a different printer. Go on to “Printing from Your 
Macintosh” on page 2–12.

Printing from Your Macintosh

After the PostScript Level 2 Printer Driver is installed and you are set up for 
printing, use the printer as you would any other printer.  First, use the 
Chooser desktop accessory to select a printer queue as your current printer.  
Then print the file from within your application. 

Selecting the Network Color Printer
If you have not already done so, use the Chooser desk accessory to select 
one of the printer queues.  If you have already done this, see “Submitting a 
Print Job from within an Application” on page 2–13.

The printer queue that you choose in these steps is selected as your printer.  
It will stay selected until the next time you use the Chooser to select a 
different printer queue or a different printer.
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To select the printer as the current printer:    

1. Select the Chooser desktop utility from the Apple menu.

2. Click on the PSPrinter icon.  You may have to scroll down to see it.

3. If your network has zones, click the zone in which the network color 
printer resides.  This displays a list of printer devices in that zone. In this 
list, the printer appears once for each printer queue that is enabled. For 
example, assume:

• your printer is named “IBMnetcolor”

• on your printer, the Print queue, Hold queue, and Direct queue are all 
enabled. 

Your printer appears in the list as:

Note: If your administrator disables one of these three printer queues, 
the disabled queue does not appear in this list.

4. Choose from the three printer queues, the Print, Direct, and Hold queue.  
The Print queue is recommended.  See “Queuing, Spooling, Job Storage, 
and Security” on page 1–2 for a complete description of the printer 
queues.

5. For the Print and Hold queues, set Background Printing to Off. For the 
Direct queue and for 16 MB printers, set this option according to your 
preference.

Submitting a Print Job from within an Application

Once you have selected one of the printer queues in the Chooser, you can 
print to the printer.

This section gives general instructions on printing from any Macintosh 
application.  For information about achieving the best printing results from 
specific applications, see “Getting the Best Results from Your Macintosh 
Applications” on page 3–1.

Note: If you use QuarkXPress, install the PDF file before printing from it.  
See “Installing the QuarkXPress Printer Description File” on page 2–5.
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To print from a Macintosh application:    

1. From within your application, open the file that you want to print.

2. From the File menu, choose Page Setup.

The Page Setup dialog box is displayed.  Select the printing options you 
want and click on the OK button.

3. From the File menu, choose Print.  The PSPrinter dialog box is displayed. 

4. In the Paper Source box, choose from which trays the printer should feed 
paper.  For example: 

• To have the job print from either Tray 1 or Tray 2, whichever has the 
correct paper loaded, choose All: Auto Select.

Note: This is often the best selection, as it maximizes the chances 
that there will be paper to print your job.

• To print all pages in the job onto transparencies, choose 
All: Auxiliary Tray, and make sure that transparencies are in the 
fold-out Auxiliary Tray. See the IBM Network Color Printer: Operator’s 
Guide for instructions on loading transparencies. 

• To print all the pages in the job onto paper from Tray 1, choose 
All: Tray 1.

• To print the first page of your job on media from one tray, and the 
remaining on media from a different tray, choose

First from: trayA
Remaining from: trayB

where trayA is the tray containing media on which you want the first 
page printed and trayB is the tray containing media on which you want 
the remaining pages printed.

5. In the Destination box, make sure that Printer is selected.
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6. Click on the Options button to set additional information for the print job.

The options in this dialog box are specific to the Network Color Printer.  
Note that you must scroll to see all the options. 

If you select the Printer’s Default setting for any of these options, your job 
will print using the default values with which the printer is configured. 

The options you can specify are:

Print:

Color Mode:

Paper Type:

Black and White Choose this if your job has only black text and 
graphics.

Color/Grayscale Choose this if your job has black or color text 
and grayscale graphics.

Calibrated Color Choose this if your job has color graphics.  
Choosing this option makes rendering style 
options available.

CMYK Choose this option to print in color.

Grayscale Choose this option to print all the colors in your 
job as shades of gray.

Plain Paper Choose this option if you will be printing on 
paper.

Transparency Choose this option if you will be printing on 
transparencies from the Auxiliary Tray.  This 
option is active only if you selected Auxiliary 
Tray as one of your paper sources.
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Rendering Style:

Note: If you print a document that is already in CMYK the printer 
ignores your rendering-style choice.  This is because your ren-
dering style choice determines how the printer converts RGB 
color to CMYK color.  If you send CMYK data, your Macintosh 
has already done the conversion before the printer gets the file.  
For this reason, either work in RGB mode or switch to RGB 
mode before printing.

Finish:

Photographic Choose this rendering style to get the best 
results for photographic or bitmap images.

Presentation Choose this rendering style to get the best 
results for business presentations and other 
documents with pure, saturated colors.  
Choose this option for printing to 
transparencies.

Monitor Choose this rendering style to simulate the 
appearance of the image on a monitor. Overall 
color saturation is reduced so that bright, 
high-contrast images on the monitor will have a 
similar appearance on the paper.

Solid Color Choose this rendering style to get the best 
results for documents with spot colors, such as 
those found in company logos.

Normal Choose this option to get a printout that has a 
medium gloss.

Matte Choose this option to get a printout that has 
less gloss.  This does not work well for heavier 
paper. 

Note:  Your print will take longer, as the printer 
must wait to cool down before it can print your 
job.

Glossy Choose this option to get a printout that has 
more gloss.  Also use this option for heavier 
paper.

Note:  Your print will take longer, as the printer 
must wait to heat up before it can print your 
job.
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Brightness:

If you want, click on the Save button to make these your default Print 
Options choices for this printer queue. 

7. Click on the OK button to close the Print Options window.

8. Click on the Print button to send the job to the IBM Network Color Printer 
queue.

85%-115% In most cases, choose 100%.  If you want a 
lighter or darker printout, experiment with 
different settings until you find the one you like.  
85% is lighter, 115% is darker.
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Batch Printing, Printing Already-created PostScript Files
Use this section if you repeatedly print the same finished documents. 

Batch printing on the IBM Network Color Printer is available with the 
Downloader utility.  Make sure that the Downloader utility is installed on your 
Macintosh.  For instructions on installing the Downloader utility, see 
“Installing the User Software on Your Macintosh” on page 2–6. 

The general steps for batch printing are:

1. From each one of your documents, create a PostScript file.  See 
“Creating PostScript Files from Your Documents.” 

2. Use the Downloader utility to download the PostScript files to the printer.  
You can download as many files as you want in each batch.  Make sure 
that the Downloader utility is installed on your Macintosh. 

For instructions on downloading the PostScript files to the printer, 
see“Using the Downloader Utility” on page 8–1.

Creating PostScript Files from Your Documents
Use this section to create PostScript files that are suitable for printing using 
the IBM Color Downloader utility.  For fast repeat and batch printing, keep 
finished documents in PostScript form.

Before you begin, make sure that you have done these things:

• Installed the Downloader utility, the PostScript Level 2 Printer Driver, and 
any necessary printer description files and screen fonts.  See “Installing the 
User Software on Your Macintosh” on page 2–6 for instructions.

• Used the Chooser desktop accessory to set up the enabled printer queues.  
See “Setting up for Printing to the IBM Network Color Printer” on page 2–9.

• Used the Chooser desktop utility to choose one of the printer queues as 
your printer.  See “Selecting the Network Color Printer” on page 2–12.

Even though you are not sending the job to the printer now, choosing the 
Network Color Printer makes its special print options available.  When you 
create the PostScript file, your choices of these options become part of the 
file.  When you later download the file to the printer, your choices for these 
options determine how the printer processes the job. 

The general steps for creating a PostScript file from your document are 
similar to those for printing your document directly to the printer. 

To print to a PostScript file:    

1. From within your application, open the document from which you want to 
create a PostScript file.

2. Choose Page Setup from the File menu of your application.  The Page 
Setup dialog box is displayed.

3. Select the page setup options you want and click on the OK button to 
close the Page Setup dialog box.
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4. Choose Print from the application’s File menu.  The PSPrinter dialog box 
is displayed.  

Note: Make sure that Destination: File is selected.

5. Click on the Options button. For these options, use the settings 
specified in steps 4 through 7 of “To print from a Macintosh application:” 
on page 2–14. 

6. Click on the Save button. The Create File dialog box is displayed. 

7. Choose the location to which you would like the PostScript file saved.  Do 
this by clicking on the pop-up box at the top and selecting the location in 
which you want to be.  To go into a volume or folder listed below the 
pop-up box, double-click on the volume or folder.

If you wish, you can create a new folder in which to save the PostScript 
file.  To do so, go to the location at which you want to create the new folder 
and click on the New button.  The Name of new folder dialog box is 
displayed.  Enter the name of the folder you wish to create and click on 
the Create button.  This places you inside the newly-created folder.

8. Choose ASCII. 

9. Choose PostScript level 2 only. 
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10. For the Font Inclusion option, in most cases choose All But Fonts in PPD 
file.  However, if you are using fonts that the printer did not come with but 
that have already been downloaded to the printer with the Downloader 
utility, choose None.

11. Click on the Save button to save the job as a PostScript file.

Once you have a PostScript file, use the Downloader utility to download the 
file.  See “Using the Downloader Utility” on page 8–1.

Working with Your Jobs in the Network Color Printer Queues 
When your jobs are in the printer queues, you can view them, change some 
of the print settings, and print additional copies.  Use the Spooler utility to do 
these tasks. 

First make sure that the utilities are installed on your Macintosh.  For 
instructions on installing the utilities, see “Installing the User Software on 
Your Macintosh” on page 2–6. 

Once the utilities are installed, for instructions on using the Spooler utility, 
see “Using the Spooler Utility” on page 8–8.
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Chapter 3.  Getting the Best Results from Your 
Macintosh Applications

This chapter provides application notes that explain which options to choose 
when printing from a particular Macintosh application.  They also list 
accompanying software or printer files that you may need. 

This chapter contains notes for the following applications:

• “Adobe Illustrator 5.0 and 5.5” (discussed on page 3–1)

• “Adobe PageMaker 5.0” (discussed on page 3–4)

• “Adobe Persuasion 3.0” (discussed on page 3–8)

• “Adobe Photoshop 2.5 and 3.0” (discussed on page 3–10)

• “Macromedia FreeHand 5” (discussed on page 3–11)

• “Microsoft PowerPoint 4.0” (discussed on page 3–14)

• “Other QuickDraw Applications” (discussed on page 3–18)

These application notes give condensed instructions only for printing directly 
to a Network Color Printer.  For instructions on using the Spooler and 
Downloader utilities, see “Using the Utilities” on page 8–1.

Adobe Illustrator 5.0 and 5.5
Use the Adobe PostScript printer driver with Illustrator.  

Before you begin:    

1. Select the PSPrinter icon from the Chooser and then select the printer 
queue you want to se. 

2. Look to see if there is a color icon next to the queue.

• If there is a color icon next to the queue name, go to “Choosing Fill and 
Line Colors” on page 3–2.

• If there is no color icon next to the name of the printer, click on the 
Setup button.  The driver automatically selects the IBM Network Color 
Printer printer page description (PPD) file.  When this is done, a color 
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icon displays next to the printer name.  This setup enables the driver 
to present you with correct print options when you submit a job. 

The PostScript Level 2 Printer Driver is included on the Customer CD-ROM.  
For instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.  

Choosing Fill and Line Colors
You can create fill and line colors using the process color model (entering a 
percentage for cyan, magenta, yellow, and black) or choose a named color 
using one of the four color matching systems supplied.  For consistent color, 
use the CMYK and PANTONE Color Reference pages supplied on the 
Customer CD-ROM. 

Calibrating Your Monitor 
To calibrate your monitor to more closely resemble Network Color Printer 
output, follow the instructions in the Adobe Illustrator User’s Guide.  You will 
need to create a progressive color bar like the one found in the guide and 
print it on the printer.

Working With Imported Files
IBM recommends using EPS files for all raster artwork that will be placed in 
Illustrator documents. For best results, use RGB images saved from Adobe 
Photoshop. Photoshop includes PostScript information in RGB EPS files that 
activates the printer Rendering Styles (color rendering dictionaries).  When 
you use this type of image file, the image prints from Illustrator as it does 
from Photoshop. 

Note: Using a different file format compromises the printed output of RGB 
bitmaps since no color rendering dictionary (CRD) is activated. 

If you use a pixel-editing application other than Photoshop, we recommend 
separating the image to CMYK before importing it.  CMYK raster images 
from high-end scanners are typically separated for offset printing and may 
need some color correction to print properly on your Network Color Printer.
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Selecting Options When Printing
Illustrator files can be printed directly to the Network Color Printer without 
using Adobe Separator. No Print Options settings are required for Adobe 
illustrator documents, unless:

• the document contains EPS images saved out of Photoshop from RGB 
source images

• you want to choose printer-specific options such as Paper Type

Refer to the following illustrations for examples:

In the Print Options dialog box, choose Calibrated color. For Rendering 
Style, choose the setting that is appropriate for the graphics in the document. 

Click to display the 
Print Options 

Choose 
Calibrated Color

Choose a Rendering 
Style, and any other 
printer-specific features
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Adobe PageMaker 5.0

IBM recommends using the Adobe PostScript printer driver with PageMaker, 
although LaserWriter 8.0 and 7.1 are also supported. 

Before you start:    

1. From the Chooser, select the PSPrinter icon.

2. Select the printer queue you want to use. If the driver is set up to work 
with your printer, an icon appears next to the queue name.

The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.

Page Setup
Choose options in the Page Setup dialog box when you begin creating the 
PageMaker document.  Enter 600 dpi for “Target printer resolution.” 

Enter 600 here

Choose Page Setup 
from the File menu
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Choosing Fill and Line Colors
You can create fill and line colors using the process (CMYK), RGB, or HSB 
color model or choose a named color using one of the four color matching 
systems supplied.  Note that displayed versions of colors you choose will not 
match printer output exactly. 

For accurate and consistent color specification, use the CMYK and 
PANTONE Color Reference pages supplied on the Customer CD-ROM.

Working with Imported Files
IBM recommends using EPS files for all artwork that will be placed in 
PageMaker documents unless you are using the option-print feature. For 
best results, use RGB images saved from Adobe Photoshop. Photoshop 
includes PostScript information in RGB EPS files that activates the printer 
Rendering Styles (color rendering dictionaries).  When you use this type of 
image file, the image prints from Illustrator as it does from Photoshop. 

Note: Using a different file format compromises the printed output of RGB 
bitmaps since no color rendering dictionary (CRD) is activated. 

If you use a pixel-editing application other than Photoshop, we recommend 
separating the image to CMYK before importing it.  CMYK raster images 
from high-end scanners are typically separated for offset printing and may 
need some color correction to print properly on the IBM Network Color 
Printer.

Note: EPS files do not print correctly when you use the option-print feature 
described in the following section.  If you plan to use the option-print 
features, use CMYK TIFF files instead of EPS files.

Selecting Options When Printing
There two different ways to print in PageMaker.  You can print by choosing 
Print from the File menu (standard with other applications).  Or you can use 
the option-print feature to get access to printer-specific features, such as 
Paper Type, that are normally available with PostScript level-2 printer 
drivers. 

Note: When you use option-print, EPS files print at the low resolution used 
for their screen previews.  Therefore, using option-print is only 
recommended when you need to choose a printer-specific feature. 
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The following illustrations show how to choose options when printing. Any 
options that are not discussed may be set to your preference. 

Choose IBM Network 
Color Printer

Click these 
buttons to 
access more 
print options

Choose a paper size

Choose a paper tray

Click Optimized
Click Faster (binary)

Click Composite

Click Color
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Using Option-Print
To use the option-print feature, hold down the option key while selecting Print 
from the File menu.  In the Print document dialog box that is displayed, the 
Paper button is replaced by the Setup button. Use the Setup button to 
access printer features.

Click Setup to 
access printer 
features (a Page 
Setup dialog box is 
displayed initially)

Click on OK 
(a Printer dialog 
box is displayed)

Choose a paper size

Click to display 
the Print Options 
dialog box

Click to return to 
the Print dialog 
box

Choose a paper tray

Choose printer 
features 

Choose 
Calibrated Color
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Adobe Persuasion 3.0
Presentations created in Persuasion can be printed to the printer on plain 
paper or on transparencies.  For the best results IBM recommends using the 
printer’s built-in CRDs, as explained in the following sections.  Note that you 
will need to use a PostScript level-2 printer driver such as the Adobe 
PostScript printer driver supplied with the printer.

Before you start:    
1. From the Chooser, select the PSPrinter icon.

2. Select the printer queue you want to use.  If the driver is set up to work 
with your printer, an icon appears next to the printer-queue name.

The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3. 

Working with Imported Files
You can import graphics in EPS, PICT, Windows Metafile, and Photo CD 
formats into Persuasion.  EPS files are recommended for printing to the IBM 
Network Color Printer.  However, if you plan to show the presentation on a 
monitor as well as in hardcopy form, you may want to use a PICT file, which 
displays with better quality.  Note that RGB EPS and PICT files may print 
differently.

All RGB EPS files imported into Persuasion are affected by your choice of 
Rendering Style in the Print Options dialog box. Typically these are raster 
images, such as scans, that work best with the Photographic Rendering 
Style. This Rendering Style may not be appropriate for the presentation’s 
other picture elements, which will probably work best with the Presentation 
Rendering Style. In this case, you have a choice. You can:

• experiment with the different Rendering Styles to see which best suits the 
overall document. 

• before importing the RGB image, use a pixel-editing application such as 
Adobe Photoshop to separate it and save it as a CMYK EPS file. CMYK 
files are not affected by the Rendering Styles. In this way the imported 
images bypass the CRD altogether, and can choose a 
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CRD that is best for the other images in the document. 

Selecting Options When Printing

Refer to this section to select options in the Print and Print Options dialog 
boxes.  To use the Rendering Style when printing from Persuasion, you must 
choose Calibrated Color in the Print Options dialog box.  IBM recommends 
choosing Presentation or Solid Color for Rendering Style.

Note: To print your presentation on transparencies, choose a Paper Type of 
Transparencies. 

Click to display 
the Print Options 
dialog boxChoose a paper source. 

To print on 
transparencies, you 
must choose
Auxiliary Tray.

IMPORTANT: Choose 
Calibrated Color

Choose Presentation 
or Solid Color for 
Rendering Style, and 
any other printer-
specific features
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Adobe Photoshop 2.5 and 3.0
This section explains printing from Photoshop using the built-in CRDs. 

IBM recommends using the Adobe PostScript printer driver with Photoshop, 
although LaserWriter 8.0 and 7.1 are also compatible.  Because Photoshop 
is a PostScript level-2 application, RGB image data is processed using the 
CRDs regardless of the printer driver used.

Before you start:    
1. If you use Photoshop 2.5, make sure the plug-in called “Don't Tag RGB 

PostScript” is not placed in the Photoshop Plug-ins folder.

2. From the Chooser, select the PSPrinter icon and then select the name of 
your IBM Network Color Printer. If the driver is set up to work with your 
printer, an icon appears next to the printer name. 

The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.

Selecting Options When Printing
Refer to this section to select options in the Print and Print Options dialog 
boxes.  Note that you must select the Print in RGB option in the Print dialog 
box to use the printer CRDs. The CRDs are called Rendering Style in the 
Print Options dialog box. Since Photographic is the printer’s default CRD, 
you only need to select it in the Print Options dialog box if you previously 
chose a rendering style other than Photographic for your saved set of print 
options.

Click to display 
the Print Options 

IMPORTANT: Click 
Print in RGB to use 
the CRDs

Click Binary
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Use these choices:

Exporting Image Files to Other Applications

For importing into other applications, such as QuarkXPress, IBM 
recommends using EPS format files.  Photoshop puts PostScript information 
in RGB EPS files that activates the printer CRDs. 

Rotating, cropping, and resizing the image in Photoshop before importing it 
into the other application speeds printing. 

Macromedia FreeHand 5
IBM recommends using the Adobe PostScript Level 2 printer driver with 
FreeHand, although LaserWriter 8.0 and 7.1 are also compatible. 

Before you start:    
1. From the Chooser, select the PSPrinter icon.

2. Select the printer queue you want to use.  If the driver is set up to work 
with your printer, an icon appears next to the printer-queue name.

The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.

IMPORTANT: Choose 
Calibrated Color

Choose Photographic 
for Rendering Style, and 
any other printer-
specific features 
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Choosing Fill and Line Colors
You can create fill and line colors using the CMYK, RGB or HSL color 
models, or use one of the colors supplied with the application. 

To accurately specify colors, use the CMYK or Pantone colors in the color 
reference pages. For instructions on installing the color reference pages, see 
“Installing the User Software on Your Macintosh” on page 2–6.

Working with Imported Files
IBM recommends using EPS files for all raster artwork that will be placed in 
FreeHand documents. 

If the image is RGB, it should be saved from Adobe Photoshop since 
Photoshop includes PostScript information in RGB EPS files that activates 
the CRDs.  Using this type of image file, the image prints from Illustrator as it 
does from Photoshop. 

Note: Using a different file format compromises the printed output of RGB 
bitmaps, since no CRD is activated. 

If you use a pixel-editing application other than Photoshop, IBM recommends 
separating the image to CMYK before importing it.  CMYK raster images 
from high-end scanners are typically separated for offset printing and may 
need some color correction to print properly on your printer. 

Note: EPS separations should be saved without the DCS option selected.  
DCS files placed in FreeHand documents print at the low resolution 
used for the screen viewing.

Selecting Options When Printing
Refer to the following illustrations to choose options when printing. 

Click to set printer-
specific Print 
Options 

Click to set 
FreeHand Print 
Options 

Click to set 
Output Options 

Click Composite 
proof
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It is only necessary to set printer-specific Print Options (by clicking Options in 
the Print dialog box) if the FreeHand document you are printing includes a 
placed photographic image saved from Photoshop as an RGB EPS file.

For detailed instructions on setting Print Options, see “Submitting a Print Job 
from within an Application” on page 2–13. 

Leave these 
fields blank

Click Binary data

Don’t check Split 
complex paths

Click Use PPD 
Information

Your printer 
model appears 
here, provided 
it is your 
selected printer 
in the Chooser

Choose 100 lpi / 400

Choose Unadjusted

Choose Calibrated Color

Choose Photographic 
for Rendering Style, and 
any other printer-
specific features 
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Microsoft PowerPoint 4.0
Presentations created in PowerPoint can be printed to the IBM Network 
Color Printer on plain paper or on transparencies.  For the best results, IBM 
recommends using the built-in CRDs, as explained in the following 
application notes.  You will need to use a PostScript level-2 printer driver 
such as the printer driver supplied with the printer.

Before you start:    
1. From the Chooser, select the PSPrinter icon.

2. Select the printer queue you want to use.  If the driver is set up to work 
with your printer, an icon appears next to the printer-queue name.

The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.

Working with Imported Files
Attention:TIFF and PICT files imported into Power Point may cause printing 

problems. Their use is strongly discouraged.

IBM recommends using EPS format files for all raster images you want to 
import into PowerPoint.  They print at their full resolution (rather than the low 
resolution used for the screen preview). 

All RGB EPS files imported into PowerPoint are affected by your choice of 
Rendering Style in the Print Options dialog box. The Rendering Styles 
activate corresponding CRDs in the printer. Typically, EPS files are raster 
images, such as scans, that work best with the Photographic Rendering 
Style. Photographic may not be appropriate for the presentation’s other 
picture elements, which will probably work best with the Presentation or Solid 
Color. If this is the case with your document, you have a choice. You can 
either:

• Experiment with the different Rendering Styles to see which best suits the 
overall document. 

• Before importing the RGB image, use a pixel-editing application such as 
Adobe Photoshop to separate it and save it as a CMYK EPS file.
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CMYK files are not affected by the printer CRDs. The imported CMYK 
image is not affected by the CRD, and you can choose a Rendering Style 
that is best for the other images in the document. 

Selecting Options When Printing
Refer to this section to select options in the Print and Print Options dialog 
boxes. For detailed instructions on setting print options, see “Submitting a 
Print Job from within an Application” on page 2–13.  

To activate CRDs when printing, you must choose Calibrated Color in the 
Print Options dialog box.  The printer’s default CRD is Photographic, so for 
Rendering Style you will probably want to choose the Presentation or Solid 
Color.

Note: To print your presentation on transparencies, make sure that you 
choose a Paper Type of Transparencies and that transparencies are 
loaded into the Auxiliary Tray.  For instructions, see the IBM 
Network Color Printer: Operator’s Guide. 

Click to display 
the Print Options 
dialog box

Choose a Paper Source. 
To print on transparencies, 
choose Auxiliary Tray.

Choose Presentation or Solid 
Color for Rendering Style. 
Choose a Paper Type, and any 
other printer-specific features

Choose Calibrated Color
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QuarkXPress 3.2 and 3.3
This section gives instructions for using QuarkXPress 3.2 and 3.3.

Before you start:    
1. From the Chooser, select the PSPrinter icon.

2. Select the printer queue you want to use.  If the driver is set up to work 
with your printer, an icon appears next to the printer-queue name.

The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.

3. Make sure that you have installed the file:
IBM Net Color Printer.PDF.PDF 

in the correct location:

QuarkXPress 3.2 Put the file in the folder where QuarkXPress is 
located.

QuarkXPress 3.3 Put the file in the PDF folder inside the folder where 
QuarkXPress is located.
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Optimizing QuarkXpress for the IBM Network Color Printer
To get the best results when printing from QuarkXPress, be sure to select the 
IBM Network Printer PDF file from the QuarkXPress Page Setup dialog box. 

To set up for the IBM Network Color Printer:    

1. Choose Page Setup from the File menu. The PSPrinter Page Setup 
dialog box is displayed.

2. For Printer Type, choose IBM Net Color.PDF. 

Note: Do not choose IBM Network Color Printer. Choosing the PDF file 
gives better results.

3. For EFIColor Profile, choose None. For the other items, choose settings 
that are appropriate for the print job. 

Setting Options When Printing
When you select Print, the Print dialog box displays. For a detailed 
explanation of the selections, see “Submitting a Print Job from within an 
Application” on page 2–13. 

Click to display 
the Print Options 
dialog box

Make sure Separation 
is Off.
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To make selections in the Print Options dialog box, click on the Options 
button in the Print dialog box. The Print Options dialog box is displayed. 

The options you choose here depend on what types of document you are 
creating. For a detailed explanation of the options, see “Submitting a Print 
Job from within an Application” on page 2–13.

Other QuickDraw Applications
This application note gives guidelines for printing from QuickDraw 
applications that are not covered on an individual basis in this chapter.  
(Almost all word processors, spreadsheets, and presentation packages are 
QuickDraw applications; they rely on QuickDraw rather than the PostScript 
language to send words and pictures to printers.  Examples include Microsoft 
Word, Excel, and PowerPoint, and Aldus Persuasion.) 

Since most QuickDraw applications function similarly for printing, the 
instructions found here are applicable to many printing scenarios.  Note that 
you will need to use a PostScript level-2 printer driver such as the Adobe 
PostScript printer driver supplied with the printer.

Be sure to read the your application’s user guide and the ReadMe file, if one 
is included, for additional information about printing. 

Before you start:    
1. From the Chooser, select the PSPrinter icon.

2. Select the printer queue you want to use.  If the driver is set up to work 
with your printer, an icon appears next to the printer-queue name.

IMPORTANT: choose 
Calibrated Color
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The Adobe PSPrinter driver is included on the Customer CD-ROM.  For 
instructions on installing and setting up this driver, see “Installing the 
PostScript Level 2 Printer Driver on Your Macintosh” on page 2–3.

Working with Imported Files
Although your application may allow you to import a variety of file formats, we 
recommend using EPS format files for all raster images you want to import.  
Some applications have printing problems with file formats such as TIFF and 
PICT. 

If the image is RGB, it should be saved from Adobe Photoshop, because 
Photoshop includes PostScript information in RGB EPS files that activates 
the printer CRDs.  If you use this type of image file, the image will print from 
your application as it does from Photoshop. 

Note: All RGB EPS files imported into your document are affected by your 
choice of Rendering Style in the Print Options dialog box.

Because the rendering style that is best suited to other picture elements in 
you document or presentation may not be appropriate for imported raster 
images, you may want to have these images bypass the CRD altogether.  To 
do this, before importing the image, use a pixel-editing application such as 
Adobe Photoshop to separate the image and save it as a CMYK EPS file. 

IBM recommends separating the image to CMYK before importing it if you 
use a pixel-editing application other than Photoshop. CMYK bitmaps from 
high-end scanners are typically separated for offset printing and may need 
some color correction to print properly on your printer. 

Selecting Options When Printing
Refer to this section to select options in the Print and Print Options dialog 
boxes.  To use a CRD when printing from your application, it is necessary to 
choose “Calibrated Color” in the Print Options dialog box. 

Click to display 
the Print Options 
dialog box

IMPORTANT: Choose 
Calibrated Color

Choose a Rendering 
Style, and any other 
printer-specific features 
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Chapter 4.  Configuring Windows 3.1x to Use the 
Network Color Printer

This chapter describes how to install the user software and set up printing on 
your Windows 3.1x PC.  The general steps are:

• Install and configure the PostScript Level 2 Printer Driver.

• Set your default printer.

• Set print options.

• Install CMYK and Pantone Color Reference pages.

• If printable versions of the documentation are desired, install the 
documentation files and Adobe Acrobat Reader.

The software for the IBM Network Color Printer is provided on the Customer 
CD-ROM that shipped with the printer.  Except for the color reference pages 
and the documentation, all of this is also available on the diskettes that 
shipped with the printer. 

Installing the PostScript Level 2 Printer Driver
To set up the Network Color Printer as a PostScript printer, you need to 
install the PostScript Level 2 Printer Driver included on the Customer CD-
ROM or diskettes.  This allows you to take advantage of PostScript Level 2 
features such as CMYK color.  

Note: If the PostScript Level 2 Printer Driver is already installed on your PC, 
do not install it again.  Go to “Setting Up the Printer Driver for the IBM 
Network Color Printer” on page 4–5.

To install the PostScript Level 2 Printer Driver:    

1. From the Program Manager window, click on the File menu. 
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2. Click on the Run...  menu item.  The Run window is displayed.

3. Your next step depends on whether you are installing from CD-ROM or 
diskette:

• If you are installing from the Windows Drivers diskette, insert the 
diskette.  In the Command Line text field, enter the drive in which the 
diskette is inserted, (for example, A:) followed by \SETUP.

Go to step 4.

• If you are installing from the CD-ROM, in the Command Line text field 
enter the drive in which the Customer CD-ROM is located (for 
example, D:).  Follow this with the directory path.

To enter the directory path, type the name of the language in which 
you wish to work (refer to the Customer CD-ROM booklet for a list of 
the language directories), then the operating system subdirectory, 
drivers subdirectory and then SETUP. 

The example below shows a path in which the code is being installed 
from the A drive and the English directory is being accessed.

Or, if you had the CD-ROM in the D drive and wanted to use Spanish, 
the directory path would be:

D:\ESPAÑOL\DRIVERS\SETUP

4. When you have entered the directory and SETUP command, click on the 
OK button. 

5. The Initializing Setup status window appears first, then the Adobe 
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PostScript Printer Driver Setup window appears.

6. Follow the instructions in the window, then click on the Continue button. 

 A status menu is displayed while your PC gets ready; then the PC copies 
the PostScript Level 2 Printer Driver.  When the file copy has completed, 
the Restart window is displayed.

7. The next step is different depending on whether you installed from 
CD-ROM or diskette:

• If you installed from CD-ROM, click on the Restart button.  Windows 
restarts. 

• If you installed from diskette, remove the diskette from the diskette 
drive.  Then click on the Restart button.  Windows restarts.  Insert the 
diskette into the drive.
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You have successfully installed the PostScript Level 2 Printer Driver.  Next, 
install the IBM Network Color Printer printer description file.  See the 
following section, “Installing the Printer Description File.”

Installing the Printer Description File
1. From the Main window, double-click on the Control Panel icon.

The Control Panel window is displayed.

2. Double-click on the Adobe PostScript Printers icon. 

The Install PostScript Printer from PPD window appears, which asks you 
to locate and select a PostScript printer description file.  
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3. Click on the arrow at the right of the Drives box to display the available 
drives.  What you do next depends on whether you are installing from 
CD-ROM or diskette:

• If you are installing from diskette, click and select the drive in which the 
diskette resides.  Go to step 4.

• If you are installing from CD-ROM, click on the CD-ROM drive in which 
the Customer CD-ROM resides.  In the Directories box, open the 
directory for your language and then the DRIVERS directory.  
Go to step 4.

4. Click on the Install button.  After a moment, an information window tells 
you that installation was successful.

You have successfully installed the IBM Network Color Printer PPD.  Now go 
on to set up the printer driver for printing to the IBM Network Color Printer.  
See “Setting Up the Printer Driver for the IBM Network Color Printer.”

Setting Up the Printer Driver for the IBM Network Color Printer
Use this section to set up the PostScript Level 2 Printer Driver now that you 
have installed it.  This section contains information connecting to the printer 
in various ways and on setting your default print options.  Topics discussed in 
this section are:

• Connecting to a network server queue, in “Connecting to a Network Server” 
on page 4–5

• Connecting to the printer using AppleTalk, in  “Using AppleTalk to Connect 
to the Printer” on page 4–6

• Connecting to the printer using TCP/IP, in “Using TCP/IP to Connect to the 
Printer” on page 4–7 

• Connecting to the printer using Parallel, in “Connecting to a Parallel-
attached Network Color Printer” on page 4–8

• Setting print options, in “Setting the Default Print Options” on page 4–10

• Setting the IBM Network Color Printer as your default printer, in “Setting 
Your Default Printer” on page 4–13

Connecting to a Network Server
Your network may have a server that provides network print services to the 
Network Color Printer.  Such a server might be running Windows NT, Novell 
NetWare, AIX, or another operating system.  If a network server is providing 
print services to the Network Color Printer, see your network administrator 
for instructions on connecting to the server. 
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Using AppleTalk to Connect to the Printer 

If you are using COPSTalk or Farralon PhoneNET to provide an AppleTalk 
connection to the printer, see the documentation that came with the product 
for instructions on setting the port. 

When you are using a product that provides an AppleTalk connection to the 
Network Color Printer, the printer appears as multiple devices on your 
network.  This is because there are three printer queues built into the 
Network Color Printer: the Direct queue, the Print queue, and Hold queue.  
Each of these that is enabled appears as a separate printer device on the 
AppleTalk network.  For example, assume:

• your Network Color Printer is named “IBMnetcolor”

• on your printer, the Print queue, Hold queue, and Direct queue are all 
enabled. 

In this case, the Network Color Printer appears on the AppleTalk network as 
three printers:

IBMnetcolor_Direct
IBMnetcolor_Hold
IBMnetcolor_Print

Select the printer queue you want to use.  (IBM recommends the Print queue 
for most uses.)  Once connected, see “Setting the Default Print Options” on 
page 4–10.
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Using TCP/IP to Connect to the Printer
There are two ways you might print to the IBM Network Color Printer using 
TCP/IP:

• The printer may act as a stand-alone TCP/IP server with three connected 
printers (Print, Hold, and Direct). This is the simplest TCP/IP configuration.

• Your administrator may configure a TCP/IP server on your network to 
provide queuing and other print services to the Network Color Printer.  
When you submit a job to the queue on this server, the server redirects it to 
the printer.  (This allows an administrator more control over the print jobs.)

To configure your PC for TCP/IP printing, you need the printer’s TCP/IP 
address.  Ask your administrator for the correct TCP/IP address. The 
permanent TCP/IP queue names are as follows:

ibmcolor_print
ibmcolor_direct
ibmcolor_hold

Important: The TCP/IP queue names are not configurable and do not 
change when you change the printer name (Unlike the AppleTalk queue 
names.)  

Notes:

1. IBM recommends that you use ibmcolor_print, as this will place your 
jobs in the Print queue on the printer.  This reduces the amount of 
time your PC spends spooling the job.  If for security reasons your 
jobs should not be stored even temporarily on the printer’s hard disk, 
choose ibmcolor_direct.  The Hold queue is not recommended as 
jobs in the Hold queue do not print until moved to the Print queue 
with the Spooler utility.

2. These instructions also apply if you are connecting to a print queue 
on a server.  However, in this case your administrator must give you 
both the server TCP/IP address and the queue (printer) name.

To select a printer port:    

1. From the Main window, double-click on the Control Panel icon.

2. The Control panel window is displayed.  In the Control Panel window, 
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double-click on the Printers icon.  The Printers window is displayed.

3. In the Printers window, select the IBM Network Color Printer in the 
Installed Printers list box.  Click on the Connect button.

The Connect window is displayed.

4. Click on the arrow at the right of the Ports text box.  Scroll down through 
the list and select LPR Port.  Click on the OK button.

A window appears asking you to enter the printer TCP/IP address and 
name.  

5. Enter the TCP/IP address and the name of the queue you want to use and 
click on the OK button.

6. The Printers window appears again, with the selected port next to the 
highlighted printer name in the Installed Printers list box. 

The printer driver is installed and connected.  See “Setting the Default Print 
Options” on page 4–10 to set the default print options for this printer.

Connecting to a Parallel-attached Network Color Printer 
Use this section if the Network Color Printer is parallel-attached to your PC. 

When you install a printer, Windows assigns it to a default printer port.  
Depending on which parallel port you have used to attach the printer to your 
PC, this may or may not be correct.  Go through the following steps to make 
sure that you are using the correct port.

Select Fast Printing 
if you are using the 
Print queue.

If you are using the 
Direct queue, do 
not select Fast 
Printing.
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To select a printer port:    

1. From the Main window, double-click on the Control Panel icon. The 
Control panel window is displayed.  

2. In the Control Panel window, double-click on the Printers icon.  The 
Printers window is displayed.

3. In the Printers window, select the IBM Network Color Printer in the 
Installed Printers list box.  Click on the Connect button.

The Connect window is displayed.    

4. Select the LPT port that identifies the parallel port to which you attached 
the Network Color Printer. 

5. Click on the OK button.  The Printers window appears again, with the 
selected port next to the highlighted printer name in the Installed Printers 
list box.  The printer driver is installed and connected.

See the next section “Setting the Default Print Options.”

Select Fast Printing
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Setting the Default Print Options
Use this sections to set the default print options that your jobs will use when 
going to the IBM Network Color Printer.

To set the default print options:    
1. Click on the Setup button.  The IBM Network Color Printer window is 

displayed, with the Paper setup page at the front. 

2. Select values for the settings on the setup page. 

Note: The settings you choose here will be your default job settings.  
However, many applications allow you to override these settings 
when you print. 

Select these values for the settings:

• For Output Format, choose PostScript.

• For Paper Source, choose Auto Select to automatically switch 
between Tray 1 and Tray 2.

• For the other options, choose the settings that are right for the majority 
of your jobs.
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3. Click on the Features tab to set printing options.  The Features page is 
displayed.

4. For the Features options, use these settings:

• Leave the Brightness option set to Printer’s Default.

• Set the Color Mode option to CMYK.

• For the Rendering Style option, choose between these settings:

Photographic - choose this setting if you mostly print bitmap imag-
es, such as screen captures, scanned photographs, and images 
created with paint applications.

Presentation - choose this setting if you mostly print presentations 
and other documents containing highly saturated color fills.

Monitor - choose this setting to get a print that approximates the 
way the document appears on a monitor screen.

Solid Color - choose this setting if you mostly print images with 
spot colors, such as company logos.

• For the Finish option, choose Standard.  If you are using heavier paper 
and you notice that the toner is not fusing well, choose the Glossy 
setting.

Note: Choosing Glossy affects printer speed. The fuser must heat up 
for each Glossy job and then cool back down for each Standard 
job.

• For the Paper Type option, choose the media you print with most 
frequently.  The choices are Plain Paper and Transparency.
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5. Click on the PostScript tab.  The PostScript page appears.

• Under Performance Options, select Use PostScript Level 2 Features.

• Under Color Options, select Send Full Color Data and Match Color 
Across Printers.

• Under PostScript Performance, select Optimize for Speed.

• Leave the other options at the default settings.

6. Click on the Fonts tab.  The Fonts page appears.
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7. On the Fonts page make your selection based on the following 
information:

• If your jobs typically use PostScript fonts and it is important to you that 
when you do use True Type fonts they print exactly, select Send 
TrueType Fonts as Type 1.  Do not select Substitute PostScript Fonts.

Note: When a TrueType font is downloaded, the amount of time it 
takes to print increases.

• If your jobs use many True Type fonts, select Substitute PostScript 
Fonts for TrueType Fonts.  Instead of printing the TrueType fonts in 
your documents, the printer uses similar Post Script fonts stored on 
the printer hard disk.  This greatly decreases the amount of time it 
takes to transfer your jobs to the printer. 

8. Click on the OK button to exit the setup pages.

To make the IBM Network Color Printer your default printer, see the next 
section “Setting Your Default Printer.”

Setting Your Default Printer
You can specify the Network Color Printer as the default printer.  It is 
important to set a default printer, because from many Windows applications 
the default printer is the only one you can use.

To set the default printer:    

1. From the Main window, double-click on the Control Panel icon. The 
Control Panel window is displayed.

2. In the Control Panel window, double-click on the Printers icon. 
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 The Printers window appears.

3. In the Printers window, select the IBM Network Color Printer in the 
Installed Printers list box.

4. Click on the Set As Default Printer button.

The IBM Network Color Printer appears in the Default Printer area of the 
Printers window.
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Installing Additional Printer Description Files
The Customer CD-ROM contains printer description files for popular 
Windows applications.  QuarkXPress and PageMaker do not support 
automatic installation of printer description files from the Printers Control 
Panel.  To make the printer available in the Print and Page Setup dialog 
boxes of these applications, copy printer description files to the appropriate 
location as shown in the table in this section.

To install additional printer description files:    

1. In the Windows File Manager, double-click on the icon for the CD-ROM 
drive to display the contents of the Customer CD-ROM.

2. Open the directory:
language\WINDOWS\DRIVERS

where language is the language you use.

3. If you use PageMaker, double-click on the PSLEV2 directory; if you are 
using QuarkXPress, double-click on the APPS directory. 

4. Copy the printer description files to the appropriate locations.

If you use: Copy this file: To this location:

PageMaker 5.x  
(PageMaker 6.x 
Does not need 
any special 
treatment.)

IBM 43031.PPD \ALDUS\USENGLSH\PPD4

QuarkXPress 3.1 IBM 4303.PDF The QuarkXPress home directory,
 usually \XPRESS

QuarkXPress 3.3 
or later

IBM 4303.PDF The PDF folder, usually \XPRESS\PDF
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Installing and Printing the Color Reference Pages
Use this section to install and print the color reference pages that came with 
your printer.  The following table shows the items that are included on the 
Customer CD-ROM. 

Note: Exit all your Windows programs before you begin the installation 
process.

To install the color reference pages:    

1. In the Main window, open the File Manager.

2. Optional: create a directory in which to keep the files.  By default the 
installer creates a directory called IBMcolor, or you can use an already-
existing directory.  If you would like to create a  directory:

a. Click on the button for the hard disk on your PC in which you want to 
store the files.

b. From the File menu, choose the Create Directory command.

c. Enter a name for the directory.

d. Click on the OK button.

3. Click on the button for the CD-ROM drive.  The contents of the Customer 
CD-ROM are displayed.

4. Open the folder that corresponds with your language.  The UTILS and 
DRIVERS directories are displayed.

Color Reference
Files

The Color Reference files are PostScript files that you can 
print using the lpr or COPY command.  Printing these files 
enables you to view the range of colors available on your 
printer.  
•  From the CMYK pages you can choose CMYK color 

percentages and use them to define colors in the files that 
you create.  

•  From the PANTONE pages you can choose named 
PANTONE colors and specify them in your documents.  The 
colors will print in your documents the same as they print on 
the color reference pages.

IBM Color 
Downloader 

Utility

This utility is not supported for Windows 3.1x.

IBM Color 
Spooler Utility

This utility is not supported for Windows 3.1x.

Fiery Calibrator 
Utility

This utility is not supported for Windows 3.1x (Macintosh 
only.)
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5. Open the UTILS directory to display its contents.  

6. Double-click on the SETUP.EXE file to run it.  A status bar displays as the 
SETUP program begins.  Then the SETUP program Welcome window is 
displayed. 

7. Click on the Next button.  The next window is displayed.    

8. If you do not want the installer to create and use a directory called 
IBMcolor, click on the Browse button and browse to the location of the 
directory you created in step 2. 

Select Color Reference to install the color reference pages, and click on 
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the Next button to go on to the Start Copying Files window.  

9. Review the choices you made.

Do one of the following:

• If everything looks correct, click on the Next button and go on to the 
next step.  A status bar is displayed.

• If you want to make changes, click on the Back button to return to 
previous screens. 

You have finished installing the Color Reference files.  You will find the files 
in the IBMcolor directory or in the directory that you specified.  The files are 
as follows:

• CMYK_REF.PS shows color patches and tells you the percentages of 
cyan, magenta, yellow and black toner used to generate each patch.

• PANTONEC.PS has named PANTONE Coated color patches. It shows 
how these colors print on the IBM Network Color Printer.  

• PANTONEU.PS has named PANTONE Uncoated color patches. It shows 
how these colors print on the IBM Network Color Printer.

To print the Color Reference Pages:    

You can print the PostScript files using the  lpr or copy commands.

• If your PC is parallel-attached to the printer, use the copy command.  For 
example, use the command:

copy Filename Port

where Filename is the name of the PostScript Color Reference file and 
Port is the port on your PC to which the printer is connected. 

• If your PC and the printer are TCP/IP-connected, use the lpr command.  For 
example, use the command:

lpr -Sserveraddress -Pibmcolor_print Filename

where serveraddress is the TCP/IP address of the printer, and Filename is 
the name of the PostScript Color Reference file.  Notice that this example 
specifies ibmcolor_print, the TCP/IP name of the Print queue.
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Installing the Documentation Files and Acrobat Reader
This section explains how to copy the Network Color Printer documentation 
files and install Adobe Acrobat Reader from the Customer CD-ROM to your 
hard disk.

You can install the files and reader using either of two methods: using File 
Manager menus or using the Windows icons.  This section describes the 
method that uses the File Manager menus.  Refer to your Windows 
documentation for instructions on installation using Windows icons.

Note: The Network Color Printer documentation is provided in softcopy on 
the Customer CD-ROM only; softcopy versions of the documentation 
are not included on the diskettes.

To install Acrobat Reader:    

1. From the Program Manager window, click on the File menu. 

2. Click on the Run...  menu item.  The Run window is displayed.  This 
window contains an empty Command Line box.

3. Click on the Browse button.  The Browse window is displayed. 

4. In the Drives box of the Browse window, select your CD-ROM drive.The 
contents of the CD-ROM are displayed in the Directories box.

5. Select the directory for the language in which you wish to work.  The 
contents of the language directory are displayed in the box.

6. Select DOCS\ACROBAT\WINDOWS\DISK1.  The contents of this 
directory are displayed in the box.

7. Select the file SETUP.EXE, and click on the OK button.  You are returned 
to the Run window.  In this window, the directory path showing all of the 
selections you just made is displayed.

8. Click on the OK button.  The Acrobat Reader Installer window appears.  
This window contains license agreement text for Acrobat Reader. 

9. Click on the Accept button to agree to the terms and continue installation 
of the reader.Once you have accepted the license agreement, the 
Acrobat Reader Installer window shows information about available 
space on your hard disk and asks you to specify the target directory for 
Acrobat Reader files.  If you do not specify otherwise, the default value is 
C:\ACROREAD.

10. Specify the target directory for the reader files, then click on the INSTALL 
button.  A second Acrobat Installer window appears which asks you to 
personalize your copy of the reader by providing user information.

11. Enter your user information into the text boxes provided, and click on the 
OK button.  The Acrobat Reader code is installed on your hard disk.  A 
progress bar is displayed during installation.

You have completed installation of Adobe Acrobat Reader.
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To install the documentation:    

1. Open the Windows File Manager.

2. Click on the button for the CD-ROM drive to display the contents of the 
Customer CD-ROM.

3. Open the directory for the language in which you wish to work.  The 
contents of the language directory are displayed.

4. Open the DOCS directory.  The contents of this directory are displayed, 
including the documentation files.

5. From the Window menu, choose New Window.  Click on the button for the 
drive on which you installed Adobe Acrobat Reader.

6. You now have two windows open in the File Manager:  one shows the 
contents of the DOCS directory on the CD-ROM and the other shows the 
contents of the drive on which Acrobat Reader is installed.  

7. Decide where on the hard disk you want to keep the documentation files.  
Click on the documentation files that you want to install.  Shift-click to 
select multiple files. Click and drag the selected documentation files from 
the CD-ROM window to your chosen location on the hard disk.  

8. A message displays asking if you want to copy the selected files to the 
new location.  Click on the Yes To All button.  A status message displays 
as the files are copied.

You have installed the documentation files. See “Accessing the 
Documentation Files using Acrobat Reader” for instructions on using Acrobat 
Reader to view the documentation files.

Accessing the Documentation Files using Acrobat Reader
This section explains how to open your softcopy documentation files using 
Acrobat Reader.  For information on how to navigate within the files, refer to 
the help file provided with the reader.

To view the documentation using  Acrobat Reader:    

1. From the Program Manager window, double-click on the Adobe Acrobat 
group icon.  The Adobe Acrobat (Common) window is displayed.

2. Double-click on the Acrobat Reader icon.  The File Open window is 
displayed.  

3. Browse to select the book you wish to open, then click on OK.  The 
softcopy book is opened and displayed on your screen.  

4. To view a hyperlinked list of headings, choose Bookmarks and Page from 
the View menu.  

5. To go to the page that a heading is on, click on the heading in the list of 
bookmarks.  

6. To go to the page that a cross reference refers to, click on the cross 
reference. 

7. To print the book, choose Print from the File menu.
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Chapter 5.  Configuring Windows NT to Use the IBM 
Network Color Printer

This chapter describes how to install the user software and set up printing on 
your Windows NT workstation.  The general steps are:

• Install and configure the printer driver and printer description files.

• Set your default printer.

• Set default print options.

• Install the utilities and color reference pages.

• Configure your PC to run the utilities.

• Install the documentation files and Adobe Acrobat Reader.

The software for the IBM Network Color Printer is provided on the Customer 
CD-ROM that shipped with the printer.  Except for the color reference pages 
and the documentation, all of this is also available on the diskettes that 
shipped with the printer. 

Installing the Printer Driver

To set up the Network Color Printer as a PostScript printer, you need to 
install the PostScript Level 2 Printer Driver included on the Customer CD-
ROM.  This allows you to take advantage of PostScript Level 2 features such 
as CMYK color. 

To install the Printer Driver:    

1. In Program Manager, click on the Main group icon.  The Main window is 
displayed.

2. In the Main window, double-click on the Print Manager icon.  The Print 
Manager window is displayed.
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3. Click on the Printer pull-down menu, then click on the Create Printer...  
menu item.  The Create Printer window is displayed.

4. Enter a name for the printer in the Printer Name text box.  Click on the 
arrow at the right of the Driver box.  A scrollable list of drivers appears. 

5. Scroll to the end of the list and select Other...  by clicking on it.  Then click 
on the OK button.  The Install Driver window is displayed.

6. Insert either the Customer CD-ROM or the driver diskette into a drive, or 
type in the network drive or local drive in which the CD or diskette resides. 

7. Enter the full directory path to the directory that contains the driver: 

• If you are installing from diskette, insert the IBM Network Color Printer 
Windows Drivers diskette and enter the name of the drive containing 
the diskette.  For example, if the diskette is in your A drive, enter A:\

• If you are installing from the Customer CD-ROM, enter the CD-ROM 
drive, your language, your operating system, DRIVERS and your PC 
type.

For example, if the Customer CD-ROM is in drive D, you use English 
and have an Intel 386 processor, this is the directory path:

D:\ENGLISH\WINNT\DRIVERS\I386

If the CD is in drive M, you use Spanish and have a Power PC, this is 
the directory path:

M:\ESPAÑOL\WINNT\DRIVERS\PPC
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8. After you have specified the directory path, click on the OK button. The 
Create Printer window is displayed again.  In the Driver box, the IBM 
Network Color Printer printer driver is selected. 

You have installed the IBM Network Color Printer printer driver.  For 
instructions on setting up the driver, continue to the next section.
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Setting Up the Printer Driver
Use this section to set up the IBM Network Color Printer printer driver now 
that you have installed it.  This section contains information on connecting to 
the printer, setting the printer as your default, and choosing print options.

• To connect if the printer is parallel-attached, see the next section, 
“Connecting to a Parallel-attached IBM Network Color Printer.”

• To connect if the printer is on the network, see “Connecting to the Printer if 
It is Network-attached” on page 5–6.

• When you are connected to the printer, see “Connecting to the Printer if It 
is Network-attached” on page 5–6.

Connecting to a Parallel-attached IBM Network Color Printer
Use this section if the printer is parallel-attached to your NT workstation.  If 
the printer is network-attached, skip this section and go on to “Connecting to 
the Printer if It is Network-attached” on page 5–6.

When you install a printer, Windows assigns it to a default printer port.  
Depending on which parallel port you have used to attach the printer to your 
PC, this may or may not be correct.  Go through the following steps to make 
sure that this is the correct port for your parallel-attached printer.

To select a printer port:    

1. From the Main window, double-click on the Control Panel icon.  The 
Control Panel window is displayed.  
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2. In the Control Panel window, double-click on the Printers icon.  The 
Printers window is displayed.

3. In the Printers window, select the Network Color Printer in the Installed 
Printers list box.  Click on the Connect button.  The Connect window is 
displayed.

4. Select the LPT port that identifies the parallel port to which you attached 
the IBM Network Color Printer. 

5. Click on the OK button. The Printers window appears again, with the 
selected port next to the highlighted printer name in the Installed Printers 
list box. 

The printer driver is installed and connected.  See the next section “Choosing 
Print Options” on page 5–9.
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Connecting to the Printer if It is Network-attached
If the printer is network-attached, you can connect to it directly using either 
the TCP/IP or AppleTalk communication protocol.  However, your network 
administrator may have created a queue for the printer on a network server.  
Before you continue with this section, ask your network administrator how he 
or she would prefer you to connect to the printer—directly or using a network 
server queue.  If your administrator wants you to connect to a network server 
queue, get instructions from him or her.

The following procedures contain information on attaching directly to the 
printer either using TCP/IP or using AppleTalk.  These protocols come with 
the Windows NT operating system and must be installed before you can use 
them.  See the documentation that came with your operating system for 
instructions.

To connect to the printer using AppleTalk, see the following section.  To 
connect to the printer using TCP/IP, see “To connect to the printer using 
TCP/IP” on page 5–7.

To connect to the printer using AppleTalk:    

If the Create Printer window that you used to install the IBM Network Color 
Printer driver is still displayed on your screen, skip the first two steps and go 
to step 3.
1. In the Main window, double-click on the Print Manager icon.  The Print 

Manager window opens and displays the icon for the IBM Network Color 
printer.

2. Click on the printer to select it, and click on the Properties button.

3. In the Print to text box, click on the arrow at the right of the box.  A 
scrollable list of ports is displayed.   

4. Scroll to the end of the list and click once to select Other....  The Print 
Destinations window is displayed.      

5. Click on the OK button to select the default, AppleTalk Printing Devices.
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The Available AppleTalk Printing Devices window is displayed.

• If your network has zones, the window contains a list of the zones.  
Double-click to open the zone in which the printer is attached.  A list of 
the AppleTalk devices in that zone is displayed.

• If your network does not have zones, the window contains a list of the 
AppleTalk devices on your network.

6. Click on the printer, then click on the OK button.  The Capture dialog box 
is displayed.The Capture dialog box asks if you want to capture the 
device.

7. Click on the NO button.

Note: Do not capture the printer.  If you do, the printer will be hidden 
from the other network users. 

You have completed the steps for connecting to the Network Color Printer 
using AppleTalk.

To connect to the printer using TCP/IP:    

If the Create Printer window that you used to install the IBM Network Color 
Printer driver is still displayed on your screen, skip the first two steps and go 
to step 3.
1. In the Main window, double-click on the Print Manager icon.  The Print 

Manager window opens, and displays the icon for the IBM Network Color 
printer.

2. Click on the printer to select it, and click on the Properties button.

3. In the Print to text box, click on the arrow at the right of the box. 
Chapter 5. Configuring Windows NT to Use the IBM Network Color Printer 5-7



 A scrollable list of ports is displayed.    

Scroll to the end of the list and click once to select Other....  The Print 
Destinations window is displayed.  

4. Click once to select LPR Port, then click on the OK button.  The Add LPR 
compatible printer window is displayed.

5. In the first text field, enter the name or the TCP/IP address that your 
network administrator provided.  In the second field, enter one of the 
TCP/IP queues.  They are:

ibmcolor_print
ibmcolor_direct
ibmcolor_hold

Important: These are the permanent TCP/IP queue names.  They are 
not configurable and unlike the AppleTalk queue names they do not 
change when the printer name is changed.

Notes:

1. IBM recommends that you use ibmcolor_print as this will place your 
jobs in the Print queue on the printer.  This reduces the amount of 
time your PC spends spooling the job.  If for security reasons your 
jobs should not be stored even temporarily on the printer hard disk, 
choose ibmcolor_direct.  The Hold queue is not recommended, as 
jobs in the Hold queue do not print until moved to the Print queue 
with the Spooler utility.

2. These instructions also apply if you are connecting to a printer driver 
installed on a server.  However, in this case, your administrator must 
give you both the both the server address and the queue name.
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Setting Your Default Printer
Use this section to set the IBM Network Color Printer as your default.

To set the default printer:    

1. In the Program Manager, click on the Main group icon.  The Main program 
group window is displayed.

2. In the Main program group window, double-click on the Print Manager 
icon.  The Print Manager window is displayed.

3. In the Default text box at the top of the window, click on the down arrow 
to display the choices.  Select IBM Network Color Printer to make it your 
default.  

You are finished setting the default printer.

Choosing Print Options
Use this section to set the default options your jobs will use when sent to the 
IBM Network Color Printer.

To set the default print options:    

1. In Program Manger, double-click on the Main group icon.  The Main 
program group window is displayed.

2. In the Main program group, double-click on the Print Manager icon.  The 
Print Manager window appears.

3. Click on the IBM Network Color Printer to select it. 

4. From the Printer menu, choose Properties.  The Printer Properties 
window is displayed.
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5. Click on the Details button.  The Printer Details window for the IBM 
Network Color Printer is displayed.

6. Click on the Job Defaults button.  The Document Properties window is 
displayed.

7. Select the paper size on which you typically print.  Be sure that this is a 
paper that is kept loaded in the printer.  If you submit a job that requests 
a paper size that is not loaded, the printer attention light will flash and the 
printer will request that the paper needed for your job be loaded.

8. Select the orientation that your jobs typically use.

9. Click on the Options button to set additional print options.  The Advanced 
Document Properties window is displayed.
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10. Under True Type Font Substitution, make your selection based on the 
following information:

• If your jobs typically use PostScript fonts and it is important to you that 
when you do use True Type fonts they print exactly, select Download 
TrueType fonts as Softfont.  

Note: When a True Type font is downloaded, the amount of time it 
takes to print increases.

• If your jobs use many True Type fonts, select Substitute Device Font 
for True Type Font.  Instead of printing the True Type fonts in your 
documents, the printer uses similar Post Script fonts stored on the 
printer’s hard disk.  This greatly decreases the amount of time it takes 
to transfer your jobs to the printer. 

11. Leave the other settings at the default values and click on the OK button. 

12. To finish and save changes, click on the OK button in each window. 

You have completed the procedure for choosing print options.
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Installing the User Software on Windows NT
Use this section to install the user software and color reference pages that 
came with your printer.  This section covers three procedures:

• Using the installer to install the utilities.

• Editing the NET_WSCK.INI file.  (This procedure is not necessary if your 
administrator provides you with an already-customized file.)

• Editing the...\ETC\HOSTS file to add the TCP/IP address of the printer.

Before you begin, do these things:

• Get the printer’s TCP/IP address from your administrator.

• If your administrator is providing it to you, get the customized 
NET_WSCK.INI file.

The following table shows the software that is included on the Customer CD-
ROM.  All of this software except for the CMYK and PANTONE Color 
Reference pages is also on diskette. 

Use different procedures for installing software depending on whether you 
are installing from CD-ROM or diskette:

• If you are installing from diskette, see “Installing the User Software from 
Diskette” on page 5–17.

• If you are installing from the Customer CD-ROM, see the following section, 
“Installing the User Software from the Customer CD-ROM”. 

IBM Color 
Downloader 

Utility

This utility enables you to print PostScript and Encapsulated 
PostScript files directly to the printer without using the 
application in which the files were created.  The Downloader 
also enables you to manage the printer fonts installed on the 
printer.

IBM Color 
Spooler Utility

This utility enables you to view the order of print jobs, 
customize printer settings for jobs, delete jobs, and move jobs 
between queues.  You can also use it to see what jobs the 
printer has completed.

Fiery Calibrator 
Utility

Not supported for Windows; Macintosh only.

Color Reference
pages

These are PostScript files that you can print using the 
Downloader utility or the lpr or COPY commands.  Printing 
these files enables you to view the range of colors available 
on your printer.  From the CMYK pages you can choose 
CMYK color percentages and use them to define colors in the 
files that you create.  From the PANTONE pages you can 
choose named PANTONE colors and specify them in your 
documents.  The colors will print in your documents the same 
as they print in the Color Reference pages.
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Installing the User Software from the Customer CD-ROM
Use this section to install the user software on your Windows NT PC from the 
Customer CD-ROM.

Before you begin...

• Exit all your Windows programs. 
• Make sure that TCP/IP is installed and working.

Follow the procedure below to install the software.

To install the utilities and color reference page from CD-ROM:    

1. In the Program Manager, double-click on the Main group icon.  The Main 
window is displayed.

2. In the Main window,  open the File Manager.  The File Manager appears.

3. Click on the button for the hard disk on which you want to store the files.

4. Create a directory in which to keep the files.  This step is optional.  You 
can also allow the installer to create a directory for you called IBMcolor or 
use a different, already-existing directory.  If you would like to create a  
directory:

a.  From the File menu choose the Create Directory command.

b. Enter a name for the directory.

c. Click on the OK button.

5. Click on the button for the CD-ROM drive.  The contents of the Customer 
CD-ROM are displayed.

6. Open the directory that corresponds with your language.  Open the 
directory that corresponds with your operating system.  Open the UTILS 
directory to display its contents. 
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7. Double-click on the SETUP.EXE file to run it.  A status bar displays as the 
SETUP program begins.  Then the SETUP program Welcome window is 
displayed. 

8. Click on the Next button.  The next window is displayed.   

9. If the default directory shown is not the directory in which you want the 
files to be stored, click on the Browse button and browse to the correct 
directory location.  

Select Utilities and Color Reference to install the IBM Color Downloader 
utility, the IBM Color Spooler utility, and the color reference pages. 
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Click on the Next button to go on to the next window. 

10. Do one of these things:

• Accept the default program-group name of IBM Network Color Printer.

• Enter a different name.

• Select one of your existing program groups.  This will place the utilities 
icons in that group.

Click on the Next button.  The next installer screen is displayed. 

11. Select TCP/IP.  Click on the Next button.
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The next installer screen is displayed. 

12. Review the choices you made.  Do one of the following things:

• If everything looks correct, click on the Next button and go on to the 
next step.  A status bar is displayed.

• If you want to make changes, click on the Back button and return to 
previous screens. 

13. After the status bar finishes, the next screen is displayed.  This screen 
discusses the NET_WSC.INI file.  

14. Do one of these things:

• Click on the Browse button and browse to the location of the 
customized NET_WSCK.INI file your administrator gave you.  

• Click on the Next button to install the default file.  In this case, you must 
customize this file before you can use the utilities.  Instructions for 
customizing the file follow this section, in “To customize the 
NET_WSCK.INI file” on page 5–21.
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15. After you have either located and selected a customized file or decided to 
use the default file, click on the Next button.  A status bar is displayed as 
the  SETUP program creates the Program Group and the utilities icons. 

You have completed this segment of the installation process.  What you do 
next depends on whether you installed a customized file or the default file in 
step 14:

• If you installed a customized NET_WSCK.INI file provided by your 
administrator, your next step is to edit the ...\ETC\HOSTS file and add the 
printer’s TCP/IP address.  After you have done this, you will be finished with 
the installation process.  To edit the ...\ETC\HOSTS file, see “Editing the 
...\ETC\HOSTS File” on page 5–23.

• If you installed the default NET_WSCK.INI file, you must customize the file 
before you can use the utilities.  See “Customizing the NET_WSCK.INI file 
for Your Windows NT PC” on page 5–21.  After doing this, you will edit the 
...\ETC\HOSTS file and add the printer’s TCP/IP address.

Installing the User Software from Diskette
Use this section to install the user software on your Windows NT PC from 
diskette.  The Color Reference pages are on the Customer CD-ROM only.

Before you begin...

• Exit all your Windows programs.
• Make sure that TCP/IP is installed and working.

To install the utilities from diskette:    

1. In Program Manager, double-click on the Main group icon to open it.  The 
Main window is displayed.

1. In the Main window, open the File Manager.  The File Manager appears.

2. Click on the button for the hard disk on which you want to store the files.

3. Create a directory in which to keep the files.  This step is optional.  You 
can also allow the installer to create a directory for you called IBMcolor, 
or use a different, already-existing directory.  If you would like to create a  
directory:

a.  From the File menu choose the Create Directory command.

b. Enter a name for the directory.

c. Click on the OK button.
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4. Insert the IBM Color Downloader diskette into your diskette drive and click 
on the button for that drive.  The contents of the diskette are displayed.

5. Double-click on the SETUP.EXE file to run it.  A status bar displays as the 
SETUP program begins.  Then the SETUP program welcome window is 
displayed.

Note: Later in the installation process, the installer will ask you for the 
Spooler diskette.  When this occurs, eject the Downloader 
diskette and insert the Spooler Diskette.

6. Click on the Next button.  The next window is displayed.   

7. If the directory shown is not the directory in which you want the files to be 
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stored, click on the Browse button and browse to the location of the 
directory you created in step 4. 

Select Utilities to install the IBM Color Downloader utility and the IBM 
Color Spooler utility. 

Click on the Next button to go on to the next window.   

8. Do one of the following:

• Accept the default program-group name of IBM Network Color Printer.

• Enter a different name.

• Select one of your existing program groups.  This will place the utilities 
icons in that group.

9. Click on the Next button.  The next installer screen is displayed. 

10. Select TCP/IP.  Click on the Next button.
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The next installer screen is displayed.   

11. Review the choices you made.

Do one of the following:

• If everything looks correct, click on the Next button and go on to the 
next step.  A status bar is displayed.

• If you want to make changes, click on the Back button and return to 
previous screens. 

12. After the status bar finishes, the next screen is displayed.  This screen 
discusses the NET_WSC.INI file. 
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13. Do one of the following:

• Click on the Browse button and browse to the location of the 
customized NET_WSCK.INI file your administrator gave you. 

• Click on the Next button to install the default file.  In this case, you must 
customize this file before you can use the utilities.  Instructions for 
customizing the file follow this section, in “To customize the 
NET_WSCK.INI file” on page 5–21.

After you have either located and selected a customized file or decided to 
use the default file, click on the Next button.  The SETUP program 
displays a status bar as it creates the Program Group and the utilities 
icons. 

You have completed this segment of the installation process.  What you do 
next depends on whether you installed a customized file or the default file in 
step 14:

• If you installed a customized NET_WSCK.INI file provided by your 
administrator, your next step is to edit the ...\ETC\HOSTS file and add the 
printer’s TCP/IP address.  After you have done this, you will be finished with 
the installation process.  To edit the ...\ETC\HOSTS file, see “Editing the 
...\ETC\HOSTS File” on page 5–23.

• If you installed the default NET_WSCK.INI file, you must customize the file 
before you can use the utilities.  See “Customizing the NET_WSCK.INI file 
for Your Windows NT PC” on page 5–21.  After doing this you will edit the 
...\ETC\HOSTS file and add the printer’s TCP/IP address.

Customizing the NET_WSCK.INI file for Your Windows NT PC
Follow the instructions in this section if you did not install an 
already-customized file when you installed the utilities.

To customize the NET_WSCK.INI file:    

1. Open the File Manager.

2. Click on the button of the drive on which the Windows NT operating 
system is installed. 

3. Open the root Windows directory.  Depending on how your Windows NT 
operating system was installed, the root Windows directory may be called 
different things.  It may be WINDOWS, WINNT, or WINNT35.

The icon for the root Windows directory is a hand holding a folder.  
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This is in contrast to the other directory icons, which are just folders.

4. Find the NET_WSCK.INI file and double-click on it to open it with the 
Notepad application.

The top lines in the file are as follows:

5. Edit the file so that Server1= is followed by the name of the printer.  For 
example, when it is shipped, the name of the printer is “IBMnetcolor”.  If 
this is still the printer name, edit the line so that it reads:

Server1=IBMnetcolor

6. If you will use the utilities with more than one IBM Network Color Printer, 
add more lines following the Server1 line.  These should list the servers 
in order and include the unique name of each additional printer. 

For example:

Server2=SecondPrinterName

Server3=ThirdPrinterName

Server4=FourthPrinterName

where SecondPrinterName, ThirdPrinterName, and 
FourthPrinterName are all unique names of different IBM Network 
Color printers on your network. 

7. Save changes and exit the file.

You have completed the customizing the NET_WSCK.INI file.  Next, you 
must edit the ...\ETC\HOSTS file to add the printer’s TCP/IP address.  Then 
you will be done installing the utilities. 

;IBM Windows ‘95 IPX/SPX Utilities and Windows NT TCP/IP Utilities

;The NET_WSCK.INI file is used to obtain network information pertaining
;to your printer, necessary for operating the SPX Utilities or TCP/IP
;Utilities.  Please print a Config Page from the printer’s LCD and read 
all
;of the following notes before editing this file.  For more information 
;please refer to the README.TXT file.

[ConfigServers]
Server1=
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To edit the ...\ETC\HOSTS file to add the printer’s TCP/IP address, see the 
following section, “Editing the ...\ETC\HOSTS File.”

Editing the ...\ETC\HOSTS File
Use this section to add the TCP/IP address of the printer to your 
...\ETC\HOSTS file.  This enables the utilities to connect to the printer.

To edit the ...\ETC\HOSTS file:    

1. From the Main window, open the Accessories program group.

2. Double-click on the icon for the Notepad application.

3. From the File menu, select Open.

4. In the List Files of Type text box, select All Files.

5. Open the root Windows directory.  Depending on how your Windows NT 
operating system was installed, the root Windows directory is called 
either WINDOWS, WINNT, or WINNT35.

6. Once you have opened the Windows root directory, open these 
directories:  system32, drivers, etc.

7. Select the HOSTS file and click on OK.  The file looks similar to this:

# Copyright (c) 1993-1995 Microsoft Corp.
#
# This is a sample HOSTS file used by Microsoft TCP/IP for Windows NT.
#
# This file contains the mappings of IP addresses to host names.  Each
# entry should be kept on an individual line.  The IP address should
# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.
#
# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a ‘#’ symbol.
#
# For example:
#
#      102.54.94.97     rhino.acme.com          # source server
#       38.25.63.10     x.acme.com              # x client host

127.0.0.1       localhost
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8. In the file, create a new line for each of the IBM Network Color Printers 
with which you want the utilities to communicate. 

On each line you create, put the TCP/IP address of a printer followed by 
the name of the printer.  For example, if the TCP/IP address of the printer 
is 9.99.43.139 and the name of the printer is still the default name 
IBMnetcolor, the line should read as follows:

9.99.43.139     IBMnetcolor

9. Add as many lines as there are IBM Network Color Printers with which 
you want the utilities to communicate.  These names must correspond 
with the names in the customized NET_WSCK.INI file.

10. Save changes and exit the file.

You have finished installing the utilities.  To learn how to use the utilities, see 
“Using the Utilities” on page 8–1.

Installing the Documentation Files and Acrobat Reader
This section explains how to copy the Network Color Printer documentation 
files and install Adobe Acrobat Reader from the Customer CD-ROM to your 
hard disk.

You can install the files and reader using either of two methods: using File 
Manager menus or using the Windows icons.  This section describes the 
method that uses the File Manager menus.  Refer to your Windows 
documentation for instructions on installation using Windows icons.

Note: The Network Color Printer documentation is provided in softcopy on 
the Customer CD-ROM only; softcopy versions of the documentation 
are not included on the diskettes.

To install Acrobat Reader:    

1. From the Program Manager window, click on the File menu. 

2. Click on the Run...  menu item.  The Run window is displayed.  This 
window contains an empty Command Line box.

3. Click on the Browse button.  The Browse window is displayed. 

4. In the Drives box of the Browse window, select your CD-ROM drive.The 
contents of the CD-ROM are displayed in the Directories box.

5. Select the directory for the language in which you wish to work.  The 
contents of the language directory are displayed in the box.

6. Select DOCS\ACROBAT\WINDOWS\DISK1.  The contents of this 
directory are displayed in the box.

7. Select the file SETUP.EXE, and click on the OK button.  You are returned 
to the Run window.  In this window, the directory path showing all of the 
selections you just made is displayed.

8. Click on the OK button.  The Acrobat Reader Installer window appears.  
This window contains license agreement text for Acrobat Reader. 
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9. Click on the Accept button to agree to the terms and continue installation 
of the reader.  Once you have accepted the license agreement, the 
Acrobat Reader Installer window shows information about available 
space on your hard disk and asks you to specify the target directory for 
Acrobat Reader files.  If you do not specify otherwise, the default value is 
C:\ACROREAD.

10. Specify the target directory for the reader files, then click on the INSTALL 
button.  A second Acrobat Installer window appears which asks you to 
personalize your copy of the reader by providing user information.

11. Enter your user information into the text boxes provided, and click on the 
OK button.  The Acrobat Reader code is installed on your hard disk.  A 
progress bar is displayed during installation.

You have completed installation of Adobe Acrobat Reader.

To install the documentation:    

1. Open the Windows File Manager.

2. Click on the button for the CD-ROM drive to display the contents of the 
Customer CD-ROM.

3. Open the directory for the language in which you wish to work.  The 
contents of the language directory are displayed.

4. Open the DOCS directory.  The contents of this directory are displayed, 
including the documentation files.

5. From the Window menu, choose New Window.  Click on the button for the 
drive on which you installed Adobe Acrobat Reader.

6. You now have two windows open in the File Manager: one shows the 
contents of the DOCS directory on the Customer CD-ROM and the other 
shows the contents of the drive on which Acrobat Reader is installed.  

7. Decide where on the hard disk you want to keep the documentation files.  
Click on the documentation files that you want to install.  Shift-click to 
select multiple files. Click and drag the selected documentation files from 
the CD-ROM window to your chosen location on the hard disk.  

8. A message displays asking if you want to copy the selected files to the 
new location.  Click on the Yes To All button.  A status message displays 
as the files are copied.

You have installed the documentation files. See “Accessing the 
Documentation Files using Acrobat Reader” for instructions on using Acrobat 
Reader to view the documentation files.
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Accessing the Documentation Files using Acrobat Reader
This section explains how to open, view and print your softcopy 
documentation files using Acrobat Reader.  

To view the documentation using  Acrobat Reader:    

1. From the Program Manager window, double-click on the Adobe Acrobat 
group icon.  The Adobe Acrobat (Common) window is displayed.

2. Double-click on the Acrobat Reader icon.  The File Open window is 
displayed.  

3. Browse to select the book you wish to open, then click on OK.  The 
softcopy book is opened and displayed on your screen.  

4. To view a hyperlinked list of headings, choose Bookmarks and Page from 
the View menu.  

5. To go to the page that a heading is on, click on the heading in the list of 
bookmarks.  

6. To go to the page that a cross reference refers to, click on the cross 
reference. 

7. To print the book, choose Print from the File menu.
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Chapter 6.  Configuring Windows 95 to Use the Network 
Color Printer

This chapter describes how to install the IBM Network Color Printer software 
on your Windows 95 workstation.  The general steps are:

• Install and configure the PostScript Level 2 Printer Driver and printer 
description files.

• Set your default printer.

• Set print options.

• Use the installer to install user software such as the Spooler and 
Downloader utilities and the Color Reference pages.

• If softcopy printable versions of the documentation are desired, install the 
documentation files and Adobe Acrobat Reader.

The software for the IBM Network Color Printer is provided on the Customer 
CD-ROM that shipped with the printer.  Except for the color reference pages 
and the documentation, all of this is also available on the diskettes that 
shipped with the printer. 

• If you will install from diskettes, see “Installing the Printer Driver on 
Windows 95” on page 6–4.

• If you will install from the Customer CD-ROM, first see the following section 
“Accessing the Customer CD-ROM.”

Accessing the Customer CD-ROM

The following sections discuss accessing the Customer CD-ROM across the 
network and from a CD-ROM drive on your PC.  

• If you are installing from a CD-ROM drive attached to your PC, see the 
following section “Accessing the Customer CD-ROM from a CD-ROM drive 
on your PC.”

• If you are installing from a CD-ROM drive attached to a network server and 
network-connected to your PC, see “Accessing the Customer CD-ROM 
across the Network.”

• If you are installing from diskette, skip to “Installing the Printer Driver on 
Windows 95” on page 6–4.

Accessing the Customer CD-ROM from a CD-ROM drive on your PC
Use these instructions if you plan to install directly from a CD-ROM drive 
attached to your PC-compatible computer:
1. If you are using an external CD-ROM drive, connect it to your computer.

2. Turn on the CD-ROM drive (if it is not already on) and insert the Customer 
CD-ROM.  The CD-ROM drive icon appears in the Windows File 
Manager.
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3. In the Windows File Manager, double-click on the CD-ROM drive icon.  
The contents of the CD-ROM are displayed.

Now when you open the My Computer window, you will see the Customer 
CD-ROM.

Accessing the Customer CD-ROM across the Network
This section discusses how to access a CD-ROM that is being shared on the 
network by a network server.

To access a CD-ROM that is being shared by a network server:    

1. In the lower left corner of your desktop, click on the Start button.  Select 
Programs and Windows Explorer.  The series of selections looks like this:

When you select Windows Explorer, the Exploring window is displayed.

2. Your next step depends on whether or not the server that is sharing the 
Customer CD-ROM is in the same domain as your PC. 

• If it is, scroll through the All Folders list on the left until you find the 
server.  Then see step 3 on page 6–3.

• If the server is in a different domain, perform these steps:

A) Click on the plus sign next to the Network Neighborhood icon. A 
list of icons following the Network Neighborhood icon is displayed.  
The first item in the list is Entire Network. 
6-2 User’s Guide



B) Click on the plus sign next to the Entire Network icon.  A list of all 
the domains on the network (and possibly some servers) is 
displayed.

C) Click on the plus sign next to the domain that contains the server 
that is sharing the Customer CD-ROM.  A list of all the servers in 
that domain is displayed.

3. Click on the plus sign next to the server that is sharing the CD-ROM.  A 
list of shared items on the server is displayed.

4. Locate the icon that represents the CD-ROM drive that the server is 
sharing and that has the Customer CD-ROM in it.  (How this drive 
appears depends on what the server administrator specified as the drive 
Share Name.  In this example, the shared CD-ROM drive is called CD.)

5. With your right mouse button, click on the CD-ROM drive.  Select Map 
Network Drive from the pop-up menu that appears. 

The Map Network Drive window is displayed.
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6. This window lets you pick the name under which the server’s CD-ROM 
drive appears on your PC.  Only drive designations that are not already 
in use on your PC will be displayed. 

Click on the down arrow at the right of the Drive field and choose a drive 
designation from the pop-up list.  Then click on the OK button.

7. Close the Explorer window. 

Now when you open the My Computer window, the CD-ROM drive on the 
server shows up as one of the drives on your PC.  To see the contents of this 
drive, double-click on it to open it.  If the Customer CD-ROM is in the server 
CD-ROM drive, opening the drive on your PC displays the Customer CD-
ROM. 

Installing the Printer Driver on Windows 95

This section discusses installing the IBM Network Color Printer PostScript 
printer driver on your Windows 95 PC.  Installing the printer driver allows you 
to take advantage of printer features, such as CMYK color.  You can set up 
the printer driver to connect to a networked or parallel-attached printer:

• To install the IBM Network Color Printer printer driver and connect to a 
networked printer, see the following section.

• To install the IBM Network Color Printer printer driver for a parallel-attached 
printer, see “Parallel-Attaching the Printer on Windows 95” on page 6–9.

Installing as a Network-Connected Printer on Windows 95
Use this section to install the IBM Network Color Printer printer driver on your 
Windows 95 PC and connect to a networked printer. 

To install the driver for a network-connected printer:    
1. Double-click on the My Computer icon to open it.  The My Computer 

window is displayed.
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2. Double-click on the Printers icon.  The Add Printer Wizard window is 
displayed.

3. Click on the Next button.  A window appears that asks you to choose 
between installing a network or a local printer.

4. Select Network printer.  Click on the Next button. 

A window asking for the location of the network printer appears.
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5. Your administrator can tell you the network location of the Windows NT 
server or workstation that is sharing the printer. 

Either enter the network path your administrator gives you or click on the 
Browse button to browse the network. 

• If you enter a network path, click on the Next button and skip to step 6. 

• If you click on the Browse button, the Browse for Printer window 
appears.

Double-click to follow a path through the network until you reach the 
Windows NT server or workstation that is sharing the printer with the 
network. Double-click on the Windows NT server or workstation to dis-
play the printer icon.

When you find the printer, select it and click on the OK button.

6. A window displays asking if you want to accept the default name for the 
printer or enter another name.

7. Leave the default name or enter another, descriptive name. 
Click on the Next button. 
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A window appears that asks if you want to print a test page.

8. Select Yes and insert the Windows 95 CD-ROM or diskette into your CD-
ROM drive. The Windows 95 CD-ROM is where the PostScript printer 
driver is located. Click on the Finish button. 

As Windows 95 copies the printer driver, the Copying Files status 
message is displayed.

Then a window displays telling you that the printer page description file 
could not be found. The window asks you to insert the Windows 95 CD-
ROM. 

Do not do so. Click on the Browse button and go on to the next step.

9. The Open window is displayed. You can install the PPD file from diskette 
or from the Customer CD-ROM.

• If you are installing from diskette, insert the IBM Network Color Printer 
Windows Drivers diskette into your diskette drive.  In the Open 
window, select the diskette drive. Double-click on the diskette icon to 
open it.  Click on the OK button.  Go to step 10.

• If you are installing from the Customer CD-ROM and the CD-ROM is 
being shared by a network server, you have already mapped the CD-
ROM to a drive on your PC.  Instructions for doing this are in 
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“Accessing the Customer CD-ROM across the Network” on page 6–2.  
In the browser, select the drive to which you mapped the Customer 
CD-ROM.

1) Open the Customer CD-ROM. 

2) Open the folder that corresponds with your language.

3) Open the WIN95 folder.

4) Open the DRIVERS folder.  Click on the OK button and go to 
step 10.

• If you are installing from the Customer CD-ROM locally, eject the 
Windows 95 CD-ROM and insert the Customer CD-ROM into your 
CD-ROM drive.  Select the drive in which you inserted the CD-ROM. 

1) Open the Customer CD-ROM. 

2) Open the folder that corresponds with your language.

3) Open the WIN95 folder.

4) Open the DRIVERS folder.  Click on the OK button and go to
step 10.

10. The oemprint.inf file displays in the File name text field of the Open 
window.

11. Click on the OK button.  The next two windows that appear tell you that 
the test page has printed and show you the icon for the newly-created 
network printer.

The IBM Network Color Printer is now your default printer.  To set your 
default print options, go to “Choosing Print Options” on page 6–13.
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Parallel-Attaching the Printer on Windows 95 
This section describes how to install the printer driver to work with a Parallel-
attached IBM Network Color Printer.

To install the printer driver for a parallel-attached printer:    
1. Double-click on the My Computer icon to open it.  The My Computer 

window is displayed.

2. Double-click on the Printers icon.  The Add Printer Wizard window is 
displayed.

3. Click on the Next button.  A window appears that asks you to choose 
between installing a network or a local printer.

4. Select Local printer.  Click on the Next button.  A window appears that 
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asks you to select the manufacturer and model of the printer.

• If you are installing from a diskette, insert the Windows Drivers diskette 
into your diskette drive, then go to step 5.

• If you are installing from a Customer CD-ROM that you have, eject the 
Windows 95 CD-ROM and insert the Customer CD-ROM into your 
CD-ROM drive.  Go to step 5.

• If you are installing from a Customer CD-ROM that a server is sharing 
on the network, you have already accessed the Customer CD-ROM 
using the steps in “Accessing the Customer CD-ROM across the 
Network” on page 6–2.  Go to step 5.

5. Click on the Have Disk button.  The Install From Disk window is displayed.

6. Enter the drive and directory path to the Network Color Printer driver, as 
follows:

• If you are installing from diskette, specify the diskette drive in which 
you placed the diskette.  The file is located in the root directory of the 
diskette.  For example, if the diskette drive is drive A, enter:

A:\

• If you are installing locally from the Customer CD-ROM, specify the 
drive that the Customer CD-ROM is in and the full directory path to the 
DRIVERS folder.  For example, if your CD-ROM drive is the C drive 
and your language is English, use this directory path:

C:\ENGLISH\WIN95\DRIVERS

If your language is Spanish, use this directory path:

C:\ESPAÑOL\WIN95\DRIVERS

• If you are installing code remotely from the Customer CD-ROM, 
specify the network drive to which you earlier mapped the Customer 
CD-ROM.  Specify the full directory path to the DRIVERS folder. 
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For example, if your CD-ROM drive is the C drive and your language 
is English, use this directory path:

C:\ENGLISH\WIN95\DRIVERS

If your language is Spanish, use this directory path:

C:\ESPANOL\WIN95\DRIVERS

7. Click on the OK button.  This displays a window in which you select the 
printer model.

8. Select the IBM Network Color Printer and click on the Next button.  This 
displays a window in which you select a port.  
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9. Select the port to which the Network Color Printer is attached.  Click on 
the Next button.  This displays a window in which you can choose the 
printer name.  

10. Either use the default name or enter a new, descriptive name.  Click on 
the Next button.  This displays a window in which you can choose to print 
a test page.

11. Select Yes if you wish to print a test page.  Click on the Finish button.  A 
window is displayed that asks you to insert the Windows 95 CD-ROM or 
one of the Windows 95 diskettes, depending on which you originally used 
to install Windows 95. 

12. Insert the requested media and click on the OK button.  A status message 
displays telling you that the files are copying.  Then the Printers window 
appears, showing you your newly installed Network Color Printer.

You have successfully installed the printer. In a moment the test page is 
printed. 
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Choosing Print Options
Use this section to set the default options your jobs will use when sent to the 
IBM Network Color Printer. 

To set options:    

1. Double-click on the My Computer icon to open the window.

2. Double-click on the icon for the IBM Network Color Printer to open its 
window. 

3. From the Printer menu, choose Properties. In the various printer 
properties sheets, do the following tasks:

• For Output Format, choose PostScript.

• For Paper Source, choose Auto Select.

• For the other options, choose the settings that are right for the majority 
of your jobs.

• Leave the Brightness option set to Printer’s Default.

• Set the Color Mode option to CMYK.

• For the Rendering Style option, choose between these settings:

Photographic - choose this setting if you mostly print bitmap imag-
es, such as screen captures, scanned photographs, and images 
created with paint applications.

Presentation - choose this setting if you mostly print presentations 
and other documents containing highly saturated color fills.

Monitor - choose this setting to get a print that approximates the 
way the document appears on a monitor screen.

Solid Color - choose this setting if you mostly print images with 
spot colors, such as company logos.

• For the Finish option choose Standard.  If you are using heavier paper 
and you notice that the toner is not fusing well, choose the Glossy 
setting.

Note: Choosing Glossy affects printer speed. The fuser must heat up 
for each Glossy job, and then cool back down for each Stand-
ard job.

• For the Paper Type option, choose either Plain Paper or 
Transparency, depending on which you print with most frequently. 

• Under Performance Options, select Use PostScript Level 2 Features.

• Under Color Options, select Send Full Color Data and Match Color 
Across Printers.

• Under PostScript Performance, select Optimize for Speed.
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4. For fonts make your selection based on the following information:

• If your jobs typically use PostScript fonts and it is important to you that 
when you do use True Type fonts they print exactly, then set your PC 
to download TrueType fonts as Type 1.

Note: When a True Type font is downloaded, the amount of time it 
takes to print increases.

• If your jobs use many True Type fonts, set to substitute printer 
PostScript fonts for True Type Font.  Instead of printing the True Type 
fonts in your documents, the printer uses similar Post Script fonts 
stored on the printer’s hard disk.  This greatly decreases the amount 
of time it takes to transfer your jobs to the printer. 

Installing the User Software on Windows 95
Use this section to install the user software and Color Reference files that 
came with your printer. 

This section covers two procedures:

• Using the installer to install the utilities and Color Reference files,

• Editing the NET_WSCK.INI file.  (This procedure is not necessary if your 
administrator provides you with an already-customized file.)

Before you begin:    

• Make sure that the IPX/SPX communication protocol is installed and 
configured on your Windows 95 PC.  This is necessary because the utilities 
use SPX/IPX to communicate with the printer. For instructions on installing 
and configuring SPX/IPX, see the documentation that came with the 
Windows 95 operating system.

• Make sure that there is a working Novell NetWare server on your network. 
The server provides the Windows 95 client PC with information about the 
location of the printer on the network.

• Make sure that your PC has the correct IPX/SPX Frame Type set. 

• Set the Frame Type so that Auto-Detect is OFF and the Frame Type is the 
same as the Frame Type of the NetWare server on your network.
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1. From the Start menu at the bottom left of the Windows 95 desktop, 
choose Settings and Control Panel. 

2. From the Control Panel, choose Network.

3. Double-click on IPX/SPX Compatible Protocol.

4. Click on the Advanced tab.

5. In the Property list box, click on Frame Type.

6. Click on the arrow in the Value list box to display the choices.

7. Click on the correct Frame Type for your network. This should be the 
Frame Type that the Novell NetWare server uses. 

8. Click on the OK button.

• Get the customized NET_WSCK.INI file, if your administrator is providing it 
to you.

• Exit all your Windows programs. 

The following table shows the items that are included on the Customer CD-
ROM.  All of these except for the CMYK Color Reference files are also on 
diskette. 

IBM Color 
Downloader 

Utility

This utility enables you to print PostScript and Encapsulated 
PostScript files directly to the printer without using the 
application in which the files were created.  Printing with the 
Downloader is faster than printing from within applications.  
The Downloader also enables you to manage the printer fonts 
installed on the printer.

IBM Color 
Spooler Utility

This utility enables you to view the order and priority of print 
jobs, customize printer settings for jobs, delete jobs, and 
move jobs between queues.  You can also use it to see what 
jobs the printer has completed.
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Note: Use different procedures depending on whether you are installing from 
CD-ROM or diskette:

• If you are installing from diskette, see “Installing the User Software 
from Diskette” on page 6–21.

• If you are installing from the Customer CD-ROM, see the following 
section, “Installing the User Software from the Customer CD-ROM.”

Installing the User Software from the Customer CD-ROM
Use this section to install the user software on your Windows 95 PC from the 
Customer CD-ROM.

To install the utilities and color reference page from CD-ROM:    

1. Make sure that you have access to the Customer CD-ROM.  If you need 
instructions, see one of these sections:

• “Accessing the Customer CD-ROM from a CD-ROM drive on your PC” 
on page 6–1

• “Accessing the Customer CD-ROM across the Network” on page 6–2

2. Open the My Computer window and double-click on the icon for the hard 
disk on which you want to store the files.

3. Create a directory in which to keep the files.  This step is optional.  You 
can also allow the installer to create a directory for you called IBMcolor or 
use a different, already-existing directory.  If you would like to create a  
directory:

a.  From the File menu choose the Create Directory command.

b. Enter a name for the directory.

c. Click on the OK button.

4. Double-click on the icon for the CD-ROM drive.The contents of the 

Fiery Calibrator 
Utility

Not supported for Windows; Macintosh only.

Color Reference
Files

The Color Reference pages are PostScript files that you can 
print using the lpr or COPY command with the option to 
specify PostScript.  Printing these files enables you to view 
the range of colors available on your printer.  From the CMYK 
pages you can choose CMYK color percentages and use 
them to define colors in the files that you create.  From the 
Pantone pages you can choose named Pantone colors and 
specify them in your documents.  The colors will print in your 
documents the same as they print on the color reference 
pages.
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Customer CD-ROM are displayed.

5. Open the directory that corresponds with the language you wish to use. 

6. Open the WINDOWS directory. Open the UTILS directory. 

7. Double-click on the SETUP.EXE file to run it.  A status bar displays as the 
SETUP program begins.  Then the SETUP program welcome window is 
displayed. 
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8. Click on the Next button.  The next window is displayed. 

9. If the directory shown is not the directory in which you want the files to be 
stored, click on the Browse button and browse to the location of the 
correct directory. 

Select Utilities and Color Reference to install the IBM Color Downloader 
utility, the IBM Color Spooler utility, and the Color Reference pages. 

Click on the Next button to go on to the Select Program Group window.  
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10. Do one of the following:

• Accept the default program-group name of IBM Network Color Printer.

• Enter a different name.

• Select one of your existing program groups.  This will place the utilities 
icons in that group.

Click on the Next button.  The Network screen is displayed. 

11. Select IPX/SPX.  Click on the Next button.

The Start Copying Files screen is displayed, which allows you to review 
the choices you made in the previous screens.  

12. Review the choices you made.

Do one of the following:

• If you want to make changes, click on the Back button and return to 
previous screens. 

• If everything looks correct, click on the Next button and
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go on to the next step.  A status bar is displayed.

13. After the status bar finishes, the next screen is displayed.  This screen 
discusses the NET_WSC.INI file. 

14. Do one of the following:

• Click on the Browse button and browse to the location of the 
customized NET_WSCK.INI file your administrator gave you. 

• Click on the Next button to install the default file.  In this case, you must 
customize this file before you can use the utilities.  Instructions for 
customizing the file follow this section, in “Customizing the 
NET_WSCK.INI File for Your Windows 95 PC” on page 6–26.

After you have either located and selected a customized file or decided to 
use the default file, click on the Next button.  The SETUP program 
displays a status bar as it creates the Program Group and the utilities 
icons. 
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You have completed this segment of the installation process.  What you do 
next depends on whether you installed a customized file or the default file in 
step 14:

• If you installed a customized NET_WSCK.INI file provided by your 
administrator, you are done.  To learn how to use the utilities, see “Using 
the Utilities” on page 8–1.

• If you installed the default NET_WSCK.INI file, you must customize the file 
before you can use the utilities.  See “Customizing the NET_WSCK.INI File 
for Your Windows 95 PC” on page 6–26. 

Installing the User Software from Diskette
Use this section to install the user software on your Windows 95 PC from 
diskette. 

Note: The Color Reference pages are supplied on the Customer CD-ROM 
only.

Before you begin...

• Exit all your Windows programs. 

• Make sure that IPX/SPX is installed and working. 

To install the utilities from diskette:    

1. Open the My Computer window and double-click on the icon for the hard 
disk on which you want to store the files.

2. Create a directory in which to keep the files.  This step is optional.  You 
can also allow the installer to create a directory for you called IBMcolor, 
or use a different, already-existing directory.  If you would like to create a  
directory:

a.  From the File menu choose the Create Directory command.

b. Enter a name for the directory.

c. Click on the OK button.

3. Insert the IBM Color Downloader diskette into your diskette drive, and 
click on the button for that drive.  This displays the contents of the 
diskette.

4. Double-click on the SETUP.EXE file to run it.  A status bar displays as the 
SETUP program begins.  Then the SETUP program Welcome window is 
displayed.
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Note: Later in the installation process, the installer will ask you for the 
diskette 2.  When this occurs, eject the Downloader diskette and 
insert the Spooler Diskette.

5. Click on the Next button.  The Software window is displayed. 

6. If the directory shown is not the directory in which you want the files to be 
stored, click on the Browse button and browse to the location of the 
correct directory. 

Select Utilities to install the IBM Color Downloader utility and the IBM 
Color Spooler utility. 
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Click on the Next button to go on to the next window. 

7. Do one of the following:

• Accept the default program-group name of IBM Network Color Printer.

• Enter a different name.

• Select one of your existing program groups.  This will place the utilities 
icons in that group.

Click on the Next button.  The Network screen is displayed. 

8. Select IPX/SPX.  Click on the Next button.

The Start Copying Files screen is displayed, which allows you to review 
Chapter 6. Configuring Windows 95 to Use the Network Color Printer 6-23



the choices you made in the previous screens. 

9. Review the choices you made and do one of the following:

• If you want to make changes, click on the Back button and return to 
previous screens.  

• If everything looks correct, click on the Next button and go on to the 
next step.  A status bar is displayed.

10. After the status bar finishes, the Select Directory screen is displayed.  
This screen discusses the NET_WSC.INI file. 

11. Do one of the following:

• Click on the Browse button and browse to the location of the 
customized NET_WSCK.INI file your administrator gave you. 

• Click on the Next button to install the default file. 
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In this case, you must customize this file before you can use the 
utilities.  Instructions for customizing the file follow this section, in 
“Customizing the NET_WSCK.INI File for Your Windows 95 PC” on 
page 6–26.

12. After you have either located and selected a customized file or decided to 
use the default file, click on the Next button.  The SETUP program 
displays a status bar as it creates the Program Group and the utilities 
icons. 

You have completed this segment of the installation process.  What you do 
next depends on whether you installed a customized file or the default file in 
step 11:

• If you installed a customized NET_WSCK.INI file provided by your 
administrator, you are finished.  To learn how to use the utilities, see “Using 
the Utilities” on page 8–1.

• If you installed the default NET_WSCK.INI file, you must customize the file 
before you can use the utilities.  See “Customizing the NET_WSCK.INI File 
for Your Windows 95 PC” on page 6–26. 
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Customizing the NET_WSCK.INI File for Your Windows 95 PC
Use this section if you did not install an already-customized file when you 
installed the utilities.

Note: Before you begin, go to the printer and print out a configuration sheet, 
or get a current printer configuration sheet from your administrator. 
You will need the configuration sheet to tell you the IPX/SPX address 
of the printer.

To customize the NET_WSCK.INI file:    

1. Open the My Computer window.

2. Open the drive on which the Windows 95 operating system is installed. 

3. Open the root Windows directory.  Depending on how your Windows 95 
operating system was installed, the root Windows directory may be called 
different things. It may be WINDOWS, WINNT, or WINNT35.

The icon for the root Windows directory is a hand holding a folder.  This 
is in contrast to the other directory icons, which are just folders.
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4. Find the NET_WSCK.INI file and double-click it to open it with the 
Notepad application.

The top lines in the file are as follows:

;IBM Windows ’95 IPX/SPX Utilities and Windows NT TCP/IP Utilities

;The NET_WSCK.INI file is used to obtain network information pertaining

;to your printer, necessary for operating the SPX Utilities or TCP/IP

;Utilities.  Please print a Config Page from the printer’s LCD and read all

;of the following notes before editing this file.  For more information 

;please refer to the README.TXT file.

[ConfigServers]

Server1=

     

[]                  

;IPXAddr=00 00 00 00 00 00 00 00 00 00

Device1=4303

 ;(1) Enter server name as shown under Server:xxxxx on the Config Page header

 ;    directly after Server1=  

 ;(2) Enter the server name a second time, between the brackets []

 ;(3) SPX Utilities for Windows ’95:

 ;       Remove the semicolon in front of the IPXAddr= line

 ;       Enter the network number (first eight digits) and the printer’s 

 ;       hardware address (last twelve digits) directly after IPXAddr= 

 ;       This number should appear on the Config Page as the first item 

 ;       following the Network Setup header

 ;    TCP/IP Utilities for Windows NT:

 ;       The IPXAddr= line does not apply.  Make sure that a semicolon

 ;       is before the line ;IPXAddr=00 00 00 00 00 00 00 00 00 00

 ;(4) Please do not alter the line, Device1=4303
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5. Edit the file so that Server1= is followed by the name of the printer.  Find 
this name on the second line of the of the configuration page. For 
example, when the printer is shipped its name is “IBMnetcolor.” If this is 
still the printer name, edit the line so that it reads:

Server1=IBMnetcolor

6. Enter that same name between the brackets just above the IPX address 
line.

7. Remove the semicolon from in front of the IPX address line.  

8. Edit the IPX address line so that the address is the same as the IPX 
address printed on the configuration sheet.

9. Optional: To use the utilities with more than one IBM Network Color 
Printer:

a. Add more Server lines following the Server1 line. For example, to 
allow the utilities to connect to two additional printers, enter the lines:

Server2=SecondPrinterName
Server3=ThirdPrinterName

where SecondPrinterName and ThirdPrinterName are unique 
names of different IBM Network Color printers on your network. 

b. Below the Device1 line, add three more lines for each additional 
printer.  For example, enter these lines:

[SecondPrinterName]                  
IPXAddr=00 00 00 00 00 00 00 00 00 00
Device1=4303

[ThirdPrinterName]                  
IPXAddr=00 00 00 00 00 00 00 00 00 00
Device1=4303

where:

– SecondPrinterName and ThirdPrinterName are the unique 
printer names you entered on the Server lines.

– After IPXAddr=, you have entered the IPX addresses of the 
printers.  Get the addresses from the configuration pages of the 
printers.

Note: The line reading Device1=4303 is the same for each entry.

10. Save changes and exit the file.

You have completed the customizing the NET_WSCK.INI file. You have 
finished installing the utilities.  To learn how to use the utilities, see “Using the 
Utilities” on page 8–1. 
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Installing the Documentation Files and Acrobat Reader
This section explains how to copy the Network Color Printer documentation 
files and install Adobe Acrobat Reader from the Customer CD-ROM to your 
hard disk.

Note: The Network Color Printer documentation is provided in softcopy on 
the Customer CD-ROM only; softcopy versions of the documentation 
are not included on the diskettes.

To install Acrobat Reader:    

1. In the My Computer window, open the your CD-ROM drive.The contents 
of the CD-ROM are displayed in the Directories box.

2. Open ENGLISH\DOCS\ACROBAT\WINDOWS\DISK1.  The contents of 
this directory are displayed.

3. Double-click the file SETUP.EXE. The Acrobat Reader Installer window 
appears.  This window contains license agreement text for Acrobat 
Reader. 

4. Click on the Accept button to agree to the terms and continue installation 
of the reader. Once you have accepted the license agreement, the 
Acrobat Reader Installer window shows information about available 
space on your hard disk and asks you to specify the target directory 
(folder) for Acrobat Reader files.  If you do not specify otherwise, the 
default value is C:\ACROREAD.

5. Specify the target directory for the reader files, then click on the INSTALL 
button.  A second Acrobat Installer window appears which asks you to 
personalize your copy of the reader by providing user information.

6. Enter your user information into the text boxes provided, and click on the 
OK button.  The Acrobat Reader code is installed on your hard disk.  A 
progress bar is displayed during installation.

You have completed installation of Adobe Acrobat Reader.

To install the documentation:    

1. Open the My Computer window.

2. Open the CD-ROM drive, to display the contents of the Customer CD-
ROM.

3. Open the directory ENGLISH\DOCS.  The contents of the directory are 
displayed, including the documentation files.

4. Open the drive on which you installed Adobe Acrobat Reader.

5. You now have two windows open: one shows the contents of the DOCS 
directory on the CD-ROM, and the other shows the contents of the drive 
on which Acrobat Reader is installed.  
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6. Decide where on the hard driver you want to keep the documentation 
files.  Click on the documentation files that you want to install.  Shift-click 
to select multiple files. Click and drag the selected documentation files 
from the CD-ROM window to your chosen location on the hard disk.  

7. A message displays asking if you want to copy the selected files to the 
new location.  Click on the Yes To All button. The files are copied.

You have installed the documentation files. See “Using the Documentation 
Files” for instructions on using Acrobat Reader to view the documentation 
files.

Using the Documentation Files
This section explains how to open, view and print your softcopy 
documentation files using Acrobat Reader. 

To view the documentation using  Acrobat Reader:    

1. Double-click on the Acrobat Reader icon.  The File Open window is 
displayed.  

2. Browse to select the book you wish to open, then click on OK.  The 
softcopy book is opened and displayed on your screen.  

3. To view a hyperlinked list of headings, choose Bookmarks and Page from 
the View menu.  

4. To go to the page that a heading is on, click on the heading in the list of 
bookmarks.  

5. To go to the page that a cross reference refers to, click on the cross 
reference. 

6. To print the book, choose Print from the File menu.
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Chapter 7.  Getting the Best Results from Your Windows 
Applications

This chapter provides application notes that explain which options to choose 
when printing from a particular Windows application. They also list 
accompanying software or printer files needed.

This chapter contains notes for the following applications: 

• “Adobe Illustrator 4.0” (discussed on page 7–1)

• “Adobe PageMaker 5.0” (discussed on page 7–3)

• “Adobe Photoshop 2.5 and 3.0” (discussed on page 7–5)

• “CorelDRAW 5.0” (discussed on page 7–8)

• “Microsoft PowerPoint 4.0” (discussed on page 7–10)

The application notes give condensed instructions for printing directly to a 
Network Color Printer. For instructions on using IBM Network Color Printer 
utilities such as the Spooler and the Downloader, see “Using the Utilities” on 
page 8–1.

Adobe Illustrator 4.0
Use this section to get the best results from Adobe Illustrator documents 
printed on the IBM Network Color Printer.

Before You Start:    

Make sure you or your system administrator has installed your IBM Network 
Color Printer printer on your PC using the IBM Network Color Printer printer 
driver. For installation instructions, see “Installing the User Software” for your 
operating system.

Choosing Fill and Line Colors
You can create fill and line colors using the process color model (entering a 
percentage for cyan, magenta, yellow, and black) or choose a named color 
using one of the four color matching systems supplied by Illustrator

Note: Displayed versions of colors you choose will not match printer 
output, because monitors use light to display color and printers use 
toner. 

To accurately specify color when printing to the IBM Network Color Printer, 
use the color reference pages provided with the Network Color Printer.

For instructions on installing the color reference pages, see the section on 
installing the printer driver in the book on your operating system. 
Copyright IBM Corp. 1996 Chapter 7. Getting the Best Results from Your Windows Applications 7-1



Working with Imported Files
IBM recommends using EPS files for all artwork that will be placed in 
Illustrator documents. If the image is RGB, it should be saved from Adobe 
Photoshop, as Photoshop includes PostScript information in RGB EPS files 
that activates the printer’s CRD. When you import this type of image file, the 
image prints from Illustrator as it does from Photoshop. 

Note: Using a different file format compromises the printed output of RGB 
bitmaps, because the print job does not activate a CRD at the printer.

If you use a pixel-editing application other than Photoshop, IBM recommends 
converting the image to CMYK before importing it. Bitmaps that you send to 
the printer in CMYK do not activate the CRD and so may need some color 
correction to print properly on your Network Color Printer. 

Setting Printer Driver Options
When printing from illustrator, choose the Photographic Rendering Style if 
you have imported RGB EPS bitmap images. If not, use Presentation, Spot, 
or Monitor. 

Change other printer driver options if you want to choose a printer-specific 
feature such as Paper Type.

You can access Adobe PostScript printer driver options in Illustrator by 
clicking on the Options button in the Print Setup dialog box. 
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Adobe PageMaker 5.0
Your PageMaker package may include a small document with the heading 
“PRINTING ALERT!” stating that only the Microsoft printer driver can be used 
with PageMaker 5.0. You may disregard this warning. IBM recommends 
printing using the printer driver supplied with the IBM Network Color Printer. 
The Microsoft Windows PostScript Printer Driver version 3.56, supplied with 
PageMaker, can also be used.

Before You Start:    
1. Make sure you have installed your printer as a PostScript printer using the 

IBM Network Color Printer printer driver. 

For installation instructions, see the section on installing the printer driver 
in the chapter on your operating system. Make sure that printing options 
are set as described in that section.

2. Copy the IBM Network Color Printer PPD file into the 
ALDUS\USENGLISH\PPD4 directory.

The PPD file is available on the Customer CD-ROM and on diskette. 

• On the Customer CD-ROM, it is:

language\WINDOWS\DRIVERS\IBM43031.PPD

where language is your language. 

• On diskette it is IBM43031.PPD in the root directory of the IBM 
Network Color Printer Windows Printer Drivers Diskette. 

Page Setup
Choose Page Setup from the File menu to set options when you begin 
creating the PageMaker document. (For later versions of PageMaker, 
choose Document Setup.)

In the Page Setup window, choose these options:

For other options choose the settings that are right for the document. 

Choosing Fill and Line Colors
You can create fill and line colors using the process (CMYK), RGB, or HSB 
color model or choose a named color using one of the four color matching 
systems supplied. Note that displayed versions of colors you choose will not 
match printer output exactly. 

To accurately specify color use the CMYK or PANTONE Color Reference 
pages included on the Customer CD-ROM. For instructions on installing the 
Color Reference pages, see the chapter on your operating system and the 
section on installing software. 

For this option: Choose this selection:

Compose to Printer: 43031.PPD
Target Printer Resolution: enter 600 and choose dpi.
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Working with Imported Files
IBM recommends that RGB raster (bitmap) images be saved from Adobe 
Photoshop as EPS files before they are placed in PageMaker documents. 
Photoshop includes PostScript information in RGB EPS files that activate the 
printer’s Photographic CRD. When you use this type of image file, the image 
prints from Illustrator as it would from Photoshop. Using a different format 
may not give as good results, since no CRD is activated. For details, see 
“Exporting Image Files to Other Applications” on page 7–7 in the section on 
Photoshop.

If you use a pixel-editing application other than Photoshop, IBM recommends 
separating the image to CMYK. Keep in mind that CMYK bitmaps are often 
separated for offset printing, and may need some adjustment to print 
properly on your IBM Network Color Printer. 

Selecting Options When Printing
Refer to this section to select options in the Print dialog box.

Note: You cannot access the IBM Network Color Printer printer driver options 
from PageMaker. Settings made for the printer driver options from the 
Windows Control Panel have no effect.

For other options in this window, use the settings that are right for the 
document. To set additional options, click on the Paper, Options, and Color 
buttons.

In the Paper window, use the selections shown in the illustration: 

For this option: Choose this selection:

Print to: IBM Network Color Printer
Type: IBM43031.PPD

Choose a paper size

Choose a paper tray
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In the Print Options window, use the selections shown in the illustration: 

In the Color window, use the selections shown in the illustration: 

Adobe Photoshop 2.5 and 3.0
This section explains how to print from Photoshop.

Before you start:    
1. Make sure you or your system administrator have installed your printer 

using the IBM Network Color Printer printer driver. For installation 
instructions, see the section on installing the printer driver in the chapter 
on your operating system. 

2. Make sure that your default printing options are set as described in that 
chapter.

Click Optimized

Click Composite

Click Color
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Selecting Options When Printing
Consult the following illustrations when selecting printing options. 

In the Print window, use the selections shown in the illustration: 

Choose Print as RGB in the Photoshop Print window. Photoshop will then 
send RGB image data to the printer, which uses its CRDs to convert the 
image to CMYK. The CRD used is the one that corresponds with the 
Rendering Style you chose when setting up the printer driver. Photographic 
works best for most raster (bitmap) images, but if your image is comprised of 
solid colors and fills, you may want to experiment with Spot Color, 
Presentation, and Monitor. 

Notes:

1. If the image is other than RGB (such as CMYK), the color rendering 
dictionaries are not activated at the printer. This is because CRDs 
are used to convert RGB data to CMYK data. 

2. If you experience printing problems in Photoshop, select ASCII 
encoding (rather than binary encoding) in the Print dialog box, and 
send the job again. Binary encoding offers faster printing but 
occasionally causes problems with some system configurations.

Click on the Setup button to access the Page Setup window, or choose Page 
Setup from the File Menu. 

Click Print as RGB to 
use the CRDs

Click Setup to choose 
printer-specific options such as 
the paper tray. 
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In the Page Setup window, use the selections shown in the illustration: 

Exporting Image Files to Other Applications
Photoshop is a PostScript Level 2 application. As such, it puts information 
that activates the printer CRDs in RGB PostScript files that it writes. For this 
reason, IBM recommends saving RGB EPS images from Photoshop when 
the image will be imported into another application and printed to an IBM 
Network Color Printer. The image will be printed using a CRD when imported 
into almost any application.

Performing any needed rotating, cropping and resizing on the image in 
Photoshop before saving it speeds printing from the application in which the 
image is placed. When saving the file:

1. Select Save As from the File menu. The Save As window is displayed.

2. In the Save File as Format Type text box, choose EPS. Click on the OK 
button. The EPS Format window is displayed.

3. In the EPS format window, choose binary encoding and do not include 
transfer functions or halftone screens, as shown in the following 
illustration.

Note: If you later experience problems printing the exported image, 
substitute an ASCII encoded version of the same image, and print the 
document again. Binary encoding occasionally causes printing 
problems with some system configurations.

Choose the printer 
as it is named on 
your PC.

Choose Auto Select. 
To print on 
transparencies, choose 
Auxiliary Tray.
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Choosing Fill and Line Colors
You can create fill and line colors using the process (CMYK), RGB, or HSB 
color model. Note that displayed versions of colors you choose will not match 
printer output exactly. 

To accurately specify color, convert the image to CMYK and use the CMYK 
Color Reference pages included on the Customer CD-ROM to specify the 
colors you want. Set the Picker to CMYK sliders, and specify the 
percentages of C, M, Y, and K that you have identified on the CMYK pages. 

For instructions on installing the Color Reference pages, see the chapter on 
your operating system and the section on installing software. 

Note: CMYK data is not affected by the printer CRDs. If you are working in a 
photographic type of image, such as a scan, it is important to keep the 
image as RGB for best results. Then, when the image reaches the 
printer, the image is converted from RGB to CMYK using the printer’s 
CRD. 

CorelDRAW 5.0
IBM recommends using the IBM Network Color Printer printer driver supplied 
on the Customer CD-ROM and diskette. 

Make sure you or your system administrator have installed your printer using 
the IBM Network Color Printer printer driver. For installation instructions, see 
the section on installing the printer driver in the chapter on your operating 
system. Make sure that your default printing options are set as described in 
that chapter.

The Color Manager
The Color Manager is a color management system that is integrated into 
CorelDRAW and other Corel applications. Because the Color Manager does 
not include a profile for the IBM Network Color Printer, this section suggests 
other ways to get predictable results when printing from CorelDRAW. These 
methods include selecting fill colors based on the CMYK and PANTONE 
Color Reference pages printed from your IBM Network Color Printer and 
importing raster images saved from Adobe Photoshop in the RGB EPS file 
format to activate the printer CRDs.

If you have considerable experience working with color and want to use the 
Color Manager, consider creating a custom printer profile for your IBM 
Network Color Printer. You will need a spectrophotometer or colorimeter for 
accurate results. For details, see section 3 of the CorelDRAW 5 User Guide, 
Volume 1. 
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Choosing Fill and Line Colors
You can create fill and line colors using the process (CMYK), RGB, or HSB 
color model or choose a named color using one of the four color matching 
systems supplied. Note that displayed versions of colors you choose will not 
match printer output exactly. 

To accurately specify color, use the CMYK or PANTONE Color Reference 
pages included on the Customer CD-ROM. For instructions on installing the 
Color Reference pages, see the chapter on your operating system and the 
section on installing software. 

Working with Imported Files
IBM recommends using EPS files for all artwork that will be placed in 
CorelDRAW documents. 

If the image is RGB, it should be saved from Adobe Photoshop, since 
Photoshop includes PostScript information in RGB EPS files that activates 
the printer CRDs. Using this type of image file, the image prints from 
Illustrator as it does from Photoshop. For details, see “Exporting Image Files 
to Other Applications” on page 7–7 in “Adobe Photoshop 2.5 and 3.0.” Note 
that using a different file format compromises the printed output of RGB 
bitmaps, since no CRD is activated. 

If you use a pixel-editing application other than Photoshop, IBM recommends 
separating the image to CMYK before importing it. CMYK bitmaps from 
high-end scanners are typically separated for offset printing and may need 
some color correction to print properly on your printer. 

Selecting Options When Printing
Refer to the following illustration to select options in the Print dialog box: 

Choose the printer as 
it is named on your PC.

To set printer options, 
choose the Setup button

To set CorelDRAW print 
options, choose the 
Options buttonNote:  Do not select this 

option unless you are 
using the Corel Color 
Manager
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Setting Printer-specific Print Options
No special settings are required for printing from CorelDRAW; the default 
settings suggested in the section on setting up the printer driver in the 
chapter on your operating system are applicable here. It is only necessary to 
change printer options if:

• Your CorelDRAW document contains a placed RGB EPS file, and you 
previously chose a rendering style other than Photographic.

• You want to choose a printer-specific feature such as Paper Type.

You can access printer-specific options in CorelDRAW by clicking the Setup 
button in the Print dialog box.

Microsoft PowerPoint 4.0
Presentations created in PowerPoint can be printed on plain paper or on 
transparencies. 

Before you start:    

Make sure you or your system administrator has installed your printer using 
the IBM Network Color Printer printer driver. For installation instructions, see 
the section on installing the printer driver in the chapter on your operating 
system. Make sure that your default printing options are set as described in 
that chapter.

Choosing a Template

PowerPoint comes with templates that determine the background for each 
slide, as well as a color scheme and placement for text. To select a template, 
choose Presentation Template from the Format menu, and double-click on a 
template name to apply it to all slides in the presentation. If none of the 
templates for color overheads suit your needs, try one of the templates for 
color slides. 

If you use one of the templates for color slides, you must change the Slide 
Setup for printing on the IBM Network Color Printer. Choose Slide Setup 
from the File menu, enter the appropriate page size, and click OK to apply 
the changes.

Working with Imported Files

In addition to the clip art included with PowerPoint, images from other 
applications in many formats can be imported. IBM recommends using EPS 
files for all raster artwork that will be placed in Illustrator documents.

If the image is RGB, it should be saved from Adobe Photoshop because 
Photoshop includes PostScript information in RGB EPS files that activates 
the printer CRDs. Using this type of image file, the image prints from 
Illustrator as it does from Photoshop. For details, see “Exporting Image Files 
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to Other Applications” on page 7–7 in the section on Photoshop. Note that 
using a different file format compromises the printed output of RGB raster 
images, since no CRD is activated. 

If you use a pixel-editing application other than Photoshop, IBM recommends 
separating the image to CMYK before importing it. CMYK bitmaps from 
high-end scanners are typically separated for offset printing and may need 
some color correction to print properly on the IBM Network Color Printer. 

Selecting Options When Printing
Refer to the following illustration to select options in the Print and Print Setup 
windows. In the Print window, choose the selections shown in the illustration:

In the Print Setup window, choose your IBM Network Color Printer by the 
name you gave it on your PC.

You have finished the Microsoft PowerPoint application notes.

Click to display the Print 
Setup dialog box, where you 
can select your IBM Network 
Color Printer if it is not already 
selected

•  To print a single 
slide on a page, 
choose Slides

•  To print several 
slides on a page, 
choose Handouts 
(2, 3, or 6 slides 
per page)

Select your IBM 
Network Color Printer
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Chapter 8.  Using the Utilities
This chapter discusses the Spooler and Downloader utilities. The Network 
Color Printer utilities enable you to perform additional functions with your 
Network Color Printer. The utilities for Macintosh and Windows users are 
fundamentally the same; differences are noted in this chapter.The following 
utilities are included on the Customer CD-ROM:
• Network Color Printer Spooler

• Network Color Printer Downloader

The Network Color Printer Downloader is a utility that enables you to print 
PostScript and Encapsulated PostScript files directly to the printer without 
using the application with which they were created. Printing with the Network 
Color Printer Downloader is faster than printing from within applications. The 
Downloader utility also enables you to manage the printer fonts on the 
Network Color Printer.

The Network Color Printer Spooler is a utility that allows you to view the order 
and priority of print jobs, delete jobs, and move jobs between queues. You 
can also use it to view job accounting information.

Note: You cannot use the Network Color Printer utilities with Windows 3.1x, 
with Token-Ring networks, or with the parallel port.

Using the Downloader Utility
The Downloader utility is included with the IBM Network Color Printer. Using 
the Downloader utility, you can: 

• Print PostScript, and encapsulated PostScript (EPS) files. 

• Check the status of the IBM Network Color Printer.

• Manage the PostScript fonts stored on the IBM Network Color Printer’s 
hard disk.
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To connect to a printer using the Downloader utility:    

1. Double-click on the Downloader utility icon or choose Network Color 
Printer Downloader from the Windows 95 Start button. 

• If there is more than one printer, the Chooser window is displayed.

When you have selected a printer and clicked OK (Windows), or selected 
a zone and a printer and clicked Connect (Macintosh), the Status window 
is displayed for the printer:

While the Downloader Status window is active, it updates every 10 
seconds or as soon as a file finishes printing, whichever action occurs 
first.

Windows: Macintosh:

Windows
8-2 User’s Guide



Icons for some menu functions display in the Toolbar at the top of the 
window. Click on the button to perform the function. You can toggle the 
display of the Toolbar by choosing Toolbar in the View menu. The icons 
are:

Within the Status window:

The Print Status area of the Status window displays the printer status 
and the user name and document name of the job currently printing.

The RIP Status area of the Status window displays the user name and 
document name of the job currently processing. 

The Download Progress bar indicates the percentage of a job that has 
been transferred to the printer when you download a job.

The Hard Disk (Printer Disk Space) area of the window displays the 
amount of available disk space on the printer.

2. You can click the Font List button or choose Font List from the File menu 
to view font information.

3. To select a different IBM Network Color Printer, click the Connect button 
or choose the Open Printer from the File menu. Select the new IBM 
Network Color Printer in the dialog box that appears, and click on the 
Connect button.

4. To close the window, choose Close from the File menu; to close the 
application select Quit (Macintosh) or Exit (Windows) from the File menu.

Printing with the Downloader Utility

When the Downloader utility is open, you can click the Download icon 
(pictured in the previous section) to download files and fonts to the printer. 

With Windows 95 and Macintosh, you can use the Network Color Printer 
Downloader’s drag-and-drop feature to automatically download a file or font 
by dragging its icon onto the Downloader utility icon. You can drag and drop 
to download a single file or font, multiple files or fonts, or an entire folder.

Connect Click on this button to connect to a different 
Network Color Printer.

Download Click on this button to download a file or font 
to the Network Color Printer.

Font List Click on this button to open the Font List 
window. 
Chapter 8. Using the Utilities 8-3



To download a file or font with the Downloader utility:    

1. Use your application to generate a PostScript file.

You can save a PostScript file by selecting the Print to File option in the 
application’s Print dialog box. With some applications, you can save EPS 
files. If you experience problems printing EPS files, use PostScript or print 
the file directly from the application.

2. Open the Downloader as described in “To connect to a printer using the 
Downloader utility:” on page 8–2.

3. Choose Download from the File menu or click on the Download button. A 
dialog box containing a list of files appears.

4. Select where to download the file or font in the pop-up menu called 
Connection Type (Windows) or Queue (Macintosh).You can select the 
Print queue, Hold queue, or Direct queue.

Note: Only the queues enabled by your system administrator during 
printer configuration will appear in this menu.

5. Select the file type to display in the Show (Files of Type) pop-up 
menu.You can leave this at the default, All known formats, or select All 
files. All known formats will list all files in formats supported by the 
Downloader utility; All files will list all files.

Note: You can download files and fonts in the same batch.

6. Select the filename and click on the Add button.

• You can use the dialog box to move to different drives and directories 
to select files to download. Click the Add All button to add all files in a 
folder.

• To select multiple sequential files, select the first file and then Shift-
click on the last job. Control-click to select multiple non-sequential 
files.

Windows: Macintosh:
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Note: Before you download PostScript or EPS files, make sure that 
all fonts specified in your file are installed in the IBM Network 
Color Printer. You can do this by downloading the necessary 
fonts. Download the fonts before you download the files that 
will use the fonts. If your file contains fonts that are not installed 
on the IBM Network Color Printer, the text in these fonts will not 
print correctly and may not print at all. With some applications, 
you can include fonts when you create PostScript files. See 
your application software for information.

• If you change your mind about a file, select the filename in the Files to 
Download list and click the Remove button. 

• Click on Remove All (Macintosh only) to remove all files from the Files 
to Download list.

7. To change attributes of a job, select it and click the Options button. This 
displays the Options dialog box.

8. Specify the following information and click on the OK button:

Copies—Specify the number of copies you want by entering the number 
in the Copies text box.

Brightness—Change the Brightness setting if a file prints too dark or too 
light. Select 85% for a substantially lighter image, 115% for a 
substantially darker image, or one of the options in between. 

Some applications, including Adobe Photoshop, provide transfer 
functions that let you specify density settings for an image. If the file you 
are printing includes transfer functions, the Downloader utility’s 
Brightness options will have no effect on your printout. For more 
information on using transfer functions, see the documentation for your 
application.

(append) ‘showpage’ —This option adds a “showpage” PostScript 
language command at the end of the print job. Some applications omit 
this necessary PostScript language command when they generate EPS 
files. In most cases, you do not need to use this option. 

Select the ‘showpage’ option only if an EPS file fails to print without it. 
Select this option when printing EPS files generated by these 
applications. If you select this option unnecessarily, extra blank pages 
may print.

9. Repeat step 6 and step 7 for any other files and fonts, as needed.

10. When you have selected all files and fonts, click the Download button.

11. To cancel downloading, press Command-Period on a Macintosh, or the 
Escape key on a PC.

12. To select a different IBM Network Color Printer, click the Connect button 
or choose Open Printer from the File menu. Select the new IBM Network 
Color Printer in the dialog box that appears and click on the Connect or 
OK button.
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Managing Printer Fonts 
Before printing a PostScript or EPS file containing fonts that are not resident 
on the IBM Network Color Printer’s hard disk, you must download the fonts to 
the printer. This section gives instructions for downloading and managing 
printer fonts.

The IBM Network Color Printer comes with 39 PostScript fonts. These 
include regular, bold, italic, and bold italic versions of Courier, Times, 
Helvetica, Helvetica Narrow, Helvetica Condensed, ITC Avant Garde, 
Palatino, ITC Bookman, and New Century Schoolbook. Also included are 
ITC Zapf Dingbats, ITC Zapf Chancery, and ITC Symbol. 

Notes:.

1. The screen fonts that correspond to the printer fonts installed on the 
Network Color Printer are not automatically installed on your system.

2. If you are using TrueType fonts in Windows, you can print them by 
using the Send to Printer as Adobe Type 1 command in the 
Advanced Options dialog box. You cannot use the Downloader utility 
to download TrueType fonts.

PostScript Fonts and Screen Fonts 

Like all PostScript fonts, the fonts included with the IBM Network Color 
Printer have equivalent screen fonts. The PostScript fonts are installed 
permanently on the IBM Network Color Printer’s hard disk. 

• The screen fonts for Macintosh are included with the IBM Network Color 
Printer. You should install any of these that are not already installed. The 
fonts are located on the Customer CD-ROM in the folder:

Language/Mac/Fonts

where Language is your language. See your Macintosh system 
documentation for instructions on installing screen fonts.

• The screen fonts for Windows are included with Adobe Type Manager. This 
product comes with many Adobe applications and is also available from 
retail software outlets. 

Occasionally, you may want to use PostScript fonts that are not included with 
the IBM Network Color Printer. If so, both the PostScript fonts and the screen 
fonts must be installed on your computer. Having the screen fonts installed 
allows you to specify the fonts in your documents. Having the PostScript 
fonts installed allows you to download the fonts to the printer. 

Downloading PostScript Fonts to the IBM Network Color Printer 

In general, each time you print from within an application, the application 
automatically downloads any fonts used in your document that are not 
already installed on the IBM Network Color Printer, as long as the fonts are 
installed on your system. These fonts remain in the IBM Network Color 
Printer only until your document has printed. If you print the same document 
again, your application must download the fonts again.
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If you use one or more fonts regularly that are not already installed in the IBM 
Network Color Printer, you can save time by downloading them to the IBM 
Network Color Printer’s hard disk with the Downloader. For instructions, see 
“To download a file or font with the Downloader utility:” on page 8–4. 

Fonts you download to the IBM Network Color Printer’s hard disk remain 
installed until you remove them using the Downloader, no matter how many 
times the IBM Network Color Printer is turned off and on. You will probably 
want to download any fonts you regularly use. 

Note: You cannot use the Downloader to download TrueType or Soft fonts.

To view font information:    

1. Connect to a printer as described in “To connect to a printer using the 
Downloader utility:” on page 8–2. Choose Font List from the File menu or 
click on the Font List button. The Font List window displays with the 
Update, Print, and Delete buttons in the titlebar. 

2. Click on the Update button to update the information in the list.

• Click on the Print Font List button to print the font list. 

• Highlight a font and click on the Delete button to delete the font. Shift-
click to select multiple fonts.

Note: The 39 printer fonts included with the IBM Network Color 
Printer (resident fonts) are locked. Locked fonts appear with a 
lock icon next to the name and cannot be deleted.

Delete
Print
Update
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Using the Spooler Utility 
The Spooler utility lets you monitor and manipulate your print jobs stored in 
the printer queues. It lets the printer administrator track and manage all 
users’ print jobs. 

Network Color Printer jobs can be in the following queues:

Jobs in the queues are stored on the IBM Network Color Printer’s hard disk. 

You can use the Spooler job log to view accounting information about jobs 
printed on the IBM Network Color Printer. The job log can be printed to the 
IBM Network Color Printer or saved as a file and viewed using other 
applications.

To start the Spooler utility and select a printer:    

1. Double-click the Spooler icon or choose Spooler from the Windows 95 
Start button.

• Select the IBM Network Color Printer you want to work with in the 
Chooser window that appears.

Print Normal print jobs sent to the IBM Network Color Printer 
appear in the Print queue. You can move and manipulate 
these jobs as described below.

Hold Jobs sent to the Hold queue remain in the Hold queue until 
they are moved to the Print queue or deleted. If you need 
to print the same document frequently, you can send it to 
the Hold queue and move a copy of the job to the Print 
queue every time you need to print it. You can also print 
large jobs to the Hold queue and then move them to the 
Print queue when other users are not printing.

Printed The jobs most recently sent to the IBM Network Color 
Printer Print queue and printed are saved in the Printed 
queue. You can drag these jobs back to the Print queue to 
print additional copies. The number of jobs saved in the 
Printed queue is set by your system administrator when he 
or she configures the printer. 

Windows: Macintosh:
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2. Click the Connect or OK button. A status message is displayed as the 
Spooler utility connects to the printer. The Spooler main window and File, 
Edit, Window, Administrator and Help menus appear. (Help is Windows 
only.)

Each job is listed with information about the:

The window is split into regions that correspond to the different steps in 
the printing process and different queues. These are:

Document the name of the file
User the user who submitted the print job
Time the time when the printer received the file
Date the date when the printer received the file
Device printer model
Size the size of the file in KB

Printing contains the job that is being printed.
Waiting contains the jobs that have been processed and are 

waiting to print.
Ripping contains the job that is being processed.
Print contains jobs in the Print queue that have not yet been 

processed.
Hold contains jobs in the Hold queue.
Printed contains jobs that have been printed through the Print 

queue and are now in the Printed queue.
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The icons provide information about the job:

Icons also appear above the scroll list. The icons are:

Printing 
area

Print icon The job that is currently printing 
appears in this list.

Waiting 
area

Wait icon Jobs that have been processed and 
are waiting to be printed appear in this 
list. You cannot manipulate these jobs.

Ripping 
area

RIP icon Jobs that have been processed but 
not printed appear in the scroll list, but 
they are dimmed because their 
settings cannot be changed and they 
cannot be moved or cancelled.

Print 
queue

Print icon Jobs that are waiting to be printed that 
have not been processed appear with 
the Print icon. This list shows jobs in 
the order they will be printed. 

Hold 
queue

Hold icon Jobs in the Hold queue appear with 
the Hold icon. You can move the job to 
the Print queue to print it.

Printed 
queue

Printed 
icon

Jobs that have been printed are saved 
in the Printed queue and appear with 
the Printed icon. Jobs are stored in the 
Printed queue until the limit set by 
your system administrator in the 
Printer Setup is reached.

Printed 
queue

Alert icon If a PostScript error occurred while a 
job was printing, it appears in the 
Printed queue with an Alert icon next 
to it. You can double-click the Alert 
icon to display the error message.

Update Click this icon to update the information in the Spooler main 
window.

Duplicate 
and Print

Drag a document onto this icon to duplicate it and put the 
duplicate in the Print queue.

Print Drag a document onto this icon to print it to the Print queue.

Hold Drag a document onto this icon to save it in the Hold 
queue.

Trash Drag a file onto this icon to delete it. You will be asked to 
verify that you want to delete the job. To turn off 
verification, choose Preferences from the Edit menu and 
click the Confirm File Deletion box once so that it is not 
checked.
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Specifying Spooler Preferences
Spooler preferences set how the Spooler is updated with fresh printer 
information and whether the Spooler should warn you before discarding a 
print job.

To specify Spooler preferences:    

1. choose Preferences from the Edit menu.

The Preferences window appears. 

Use this window to specify that the Spooler:

Update Automatically or Update Manually—These options let you 
specify whether the Spooler main window is automatically updated at 
an interval that you set or whether it is updated only when you choose 
the Update command. By default, the Spooler main window is updated 
automatically every 20 seconds.

Note: When automatic updating is on, data comes from the IBM Net-
work Color Printer across the network very frequently. This 
data adds to the network traffic, and may slow down other net-
work jobs. For optimum network performance, turn off auto-
matic updating in the Spooler Preferences dialog box. When 
you want to view updated information in the Spooler windows, 
choose Update from the Window menu or click the Update but-
ton.

Confirm file deletion—Select this if you want a confirmation dialog box 
to appear before you delete a file.

When you have finished with the Preferences window, click on the OK 
button to save changes and close the window. 

Managing the Spooler utility
Use this section to manage how the Spooler behaves.

To select a different IBM Network Color Printer:    choose Open Printer from 
the File menu or click the Open Printer icon. Choose the printer you want 
from the displayed list and click on the OK button.

To manually update the information in the Spooler window:    choose Update 
from the Window menu or click the Update button.

Windows: Macintosh:
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To display information about a different IBM Network Color Printer:    choose 
Open Printer from the File menu. Select the new printer from the window that 
appears. A status message is displayed as the Spooler utility connects to the 
printer. A second Spooler main window appears and displays information 
about the second printer.

To move between Spooler windows:    choose the printer name from the 
Window menu or click the different windows. You can move between the Job 
Log and Main windows for a server by choosing them in the menus or by 
clicking each corresponding window. 

To organize Spooler windows on your desktop:    Select Cascade in the 
Window menu.

To close the connection to the current IBM Network Color Printer:    choose 
Close from the File menu. 

To quit the Spooler application:    choose Quit (Macintosh) or Exit (Windows) 
from the File menu.

Administering the Jobs on the Printer
If you have the printer password you can use the Spooler to manage all jobs 
on the printer, otherwise, you can manage the jobs that belong to you.

To enter the administrator password:    

1. Choose Password from the Administrator menu.

This menu is active only if a password was created on the Network Color 
Printer.

2. The Administrator’s Password window is displayed. 

3. Enter the printer password in the window that appears.

This password is when the administrator configures the printer. If you 
enter the password, you can use the Spooler to move, override, and 
delete all the jobs in the printer queues.

Duplicating, Copying, Moving, and Deleting Jobs

End users can use the Spooler to move, delete, and configure their own print 
jobs. The IBM Network Color Printer administrator (or anyone with the printer 
password) can use the Spooler to move, delete, and configure jobs for all 
users. See “To enter the administrator password” on page 8–12 for 
instructions on entering the Administrator password.

You can move your jobs from the Hold queue and the Printed queue to the 
Print queue. If, for example, you frequently print the same file, you can send 
it to the Hold queue and later drag a copy of the file to the Print queue. 
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By copying rather than moving a job, you leave a copy of the job in the Hold 
queue so that you can print the job again later. You can also duplicate a job if 
you want to have multiple copies of a job in the same queue.

Duplicating jobs

You can duplicate jobs in the Print, Printed, and Hold queues. You may want 
to duplicate a job if you want to change printing parameters in the Override 
Print Settings window without losing the original settings.

When you duplicate a job, the IBM Network Color Printer creates a reference 
to the original file, so duplicate files do not require the full amount of disk 
space on the IBM Network Color Printer. 

To duplicate a job within a queue:     

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, 
Shift-click to select multiple, adjacent jobs; Command-click (Macintosh) 
or Ctrl-click (Windows) to select multiple, non-adjacent jobs in the list.

2. Choose Duplicate Job from the Edit menu. The job appears at the bottom 
of the queue. 

Copying Jobs

You can copy jobs to other queues. Copying a job to a queue leaves the 
original job in the original queue, and makes a copy of the job in the new 
queue.

To copy a job to another queue:    

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, 
Shift-click to select multiple, adjacent jobs; Command-click (Macintosh) 
or Ctrl-click (Windows) to select multiple, non-adjacent jobs in the list.

2. Hold down the Option (Macintosh) or Ctrl (Windows) key as you drag the 
job to either the Hold or Print queue icon or to the Hold or Print section of 
the job list.

A copy of the job is moved to the queue you have selected, but the 
original job still appears in the Hold or Printed queue so that you can print 
the job at another time.
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Moving Jobs

Moving a job removes it from the original queue and places it in the new 
queue.

To move jobs between queues:    

1. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, 
Shift-click to make selections of adjacent jobs in the list; Command-click 
(Macintosh) or Ctrl-click (Windows) to select multiple, non-adjacent jobs 
in the list.

2. Move the selected job to another queue by dragging it to the queue icon 
of your choice or to the Hold or Print section of the job list.

For example, move a job that is currently in the Hold queue to the Print 
queue by dragging the job to the Print queue icon. 

Deleting Jobs

Deleting a job removes it from the printer hard disk.

To delete a job from any of the queues:    

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the icon that looks like a trash can. 

You can also choose Delete from the Edit menu to delete a selected job.

You can only delete your own jobs; system administrators who enter the 
printer password can delete any job.
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Changing Print Settings for a Job
You can use the Override Print Settings window to set certain printing 
parameters for a job. The settings in this dialog box override the settings 
made in the Print Options window and the Printer Setup.

Jobs that have been processed but not printed will be dimmed. You cannot 
change printing parameters for those jobs.

You can only change print settings for your own jobs; system administrators 
who enter the Spooler password can change print settings for any job. 
(Macintosh) 

To change print settings for a job:    

1. Double-click a job or select the job and choose Override Print Settings 
from the Edit menu. The Override Print Settings window appears. 

2. In this window you can change:

• The number of copies in the job. (Some applications, such as 
Photoshop, hard-code the number of copies. This setting is ignored for 
documents generated using those applications.)

• The brightness of the images in the job.

• The Rendering Style used to convert the job’s image data from RGB 
to CMYK.

Select the new settings. If you select Default Settings, the job will use the 
settings that you selected in the Print Options window when printing. 

3. Click OK to make changes.
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Using the Job Log
With the Network Color Printer Spooler, you can view and print a log of all 
the jobs printed to the Network Color Printer. You can also save the job log 
as a text file that you can then import into a spreadsheet or word 
processing application for job accounting purposes. All jobs printed to the 
queues, scanned from the copier, and printed through the direct connection 
are listed in the job log.

To display, print, and save the job log:    

1. Choose Show Job Log from the Window menu.

2. Specify the period for the job log in the window that appears.

Click All to view all jobs since the job log was cleared; click Date if you 
want to specify a period of time for the job log.

3. Click on the OK button.

The Job Log window displays a list of all the jobs and the following 
information about them: 

status
document name
user name
date
start time
end time
process time
file size
print device
paper size
media
number of originals
number of color pages
number of black and white pages
total number of pages.

Use the scroll bar at the bottom of the window to view all the Job Log 
fields.

The text in the Status column provides information about the job:

4. To print the job log, choose Print Job Log from the File menu or click the 
Print icon at the top of the window.

The information displayed in the Job Log window prints to the current 

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You 
can double-click ERROR to display the error message. A 
dialog box displays the PostScript error. Click OK to close the 
dialog box.

CANCEL The job was cancelled before printing was completed.
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Network Color Printer. When you print the job log, totals are printed for all 
appropriate columns.

5. To save the job log as a file that you can view with a different application, 
choose Export Job Log from the File menu or click on the Export icon at 
the top of the window.

6. Enter a name for the log file, and click Save. 

The job log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. 
Items are separated by tabs.

7. The printer administrator can also print and clear the job log from the 
printer operator panel.
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Appendix A.  Using the Fiery Calibrator
The Fiery Calibrator is a Macintosh application that enables you to improve 
and maintain the color consistency of your IBM Network Color Printer.

This utility enables you to:

• Maximize the color reproduction capabilities of the printer

• Ensure consistent color quality across time

• Produce consistent output across printers of the same kind

• Linearize your printer while maintaining the currently available density 
range

• Achieve better color matches when you’re reproducing spot colors, such as 
PANTONE colors or other named color systems

• Create custom calibration targets and custom calibration curves

In addition, with the X-Rite DTP 32 auto scan densitometer, the standard 
calibration process is straightforward and quick.

How the Fiery Calibrator Works
Success in obtaining satisfactory print quality from a color laser printer 
depends on many factors, including the establishment and maintenance of 
optimal toner densities. Density is a measure of the light absorbed by a 
surface. The saturation of toner color is affected by such variables as room 
humidity and service settings, and also may drift over time. Regular 
calibration can compensate for day-to-day variations in densities.

The process of calibration is as follows: first, you measure the color output of 
your printer. The Calibrator utility then compares the measured output with 
the optimal densities in a target file you select and creates a correction that 
you can download to the printer to bring all your color output closer to the 
target. If you repeat this process on a regular basis, your printer will produce 
the same color from day to day.

The Calibrator utility offers several methods of calibrating your printer. A 
standard calibration uses a fixed target derived from an EFICOLOR profile, 
and is recommended when using EFICOLOR color management software. 
Additional calibration options are available for special situations and print 
jobs. A discussion of the different calibration options follows.

Calibrating to an EFICOLOR Profile

An EFICOLOR profile contains a target for maximum and intermediate 
density values for your particular printer. The profile is based on 
measurements which characterize the color response of your model of 
printer. Using the EFICOLOR profile as a target assures you that your 
system will be calibrated to the same density values each time.
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Calibrating to a Custom Target

The Calibrator utility allows you to customize the maximum density and 
midtone value of the target contained in the EFICOLOR profile when you 
want to create your own “aimpoints.”

Editing Calibration Curves

The Calibrator brings your printer to a specific target contained in the 
EFICOLOR profile. After calibrating your system and examining a proof, you 
may decide to fine-tune the calibration to achieve a particular result. At those 
times, you can edit the calibration curve to meet the requirements of that 
specific print job.

Calibrating to a Linearized Curve

The Calibrator utility allows you to improve the overall quality of your output 
by linearizing your printer’s response to requested densities while 
maintaining the dynamic range of your printer. With the Calibrator utility, you 
can linearize your printer system without using a specific calibration target.

Using Default Measurements

If you do not have a densitometer, the Calibrator utility includes a default set 
of measurements that you can download to your printer. Default 
measurements may be helpful if your printer behaves like an “average” 
printer of the same kind and is not in need of service.

System Requirements
To use the Fiery Calibrator, you need:

• At least 1 MB RAM for the Calibrator application, along with an additional 1 
MB RAM to run the EFICOLOR Processor

• 1.6 MB hard disk space for installation

• Status T Reflection densitometer

• Macintosh interface cable (recommended)

Note: To run the Calibrator utility, the Macintosh must have a Floating 
Point Unit (math coprocessor), which is not available on some 
Macintosh models, including a Power Macintosh running in 
emulation mode (as it does with the Calibrator utility).

A Power Macintosh and other Macintosh models without a Floating Point 
Unit can be used with the Calibrator utility if you install the SoftwareFPU, 
version 3.0, control panel. SoftwareFPU is a shareware utility that allows 
programs requiring a Floating Point Unit to work on computers without one. 
The latest version of SoftwareFPU is available from its creator, John Neil & 
Associates, P.O. Box 160699, Cupertino, CA 95016. (If you have questions, 
you can send e-mail to sales@jna.com.)
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Compatibility

The Calibrator utility works with the Network Color Printer. Any Status T 
Reflection densitometer can be used with the Calibrator utility. These models 
of densitometer support automatic entry of measurements:

• X-Rite DTP 32, X-Rite 404, and X-Rite 408

• Gretag D 186P

Note: The X-Rite DTP 32 should use EPROM version 4927. Versions 
4701, 3B24, and 3630 (no longer being shipped) are also supported, 
but versions 4812 and 4820 may not work. (The EPROM version is 
shown briefly on the densitometer display on starting up and later on 
the Macintosh screen while the densitometer is being configured.)

What is Included with the Calibrator Utility
The Calibrator utility is provided on diskettes and on the Customer CD-ROM. 
These files are included:

• Fiery Calibrator, version 1.0

• EFICOLOR Processor version 2.0

• EFICOLOR Preferences

• EFICOLOR profile for your printer

• Measurements folder

Note: Remember, the Calibrator utility is supported in a Macintosh 
environment only.

Installing the Fiery Calibrator
This section lists the steps required to install your IBM Color Calibrator utility.
1. Insert the Customer CD-ROM into the CD-ROM drive of your Macintosh.

2. Double-click on the Customer CD-ROM icon to open it.

3. Double-click on the MAC folder to open it.

4. Double-click on the UTILS folder to open it.

5. Click on the items that you wish to install and drag them to the location on 
your hard disk in which you want to keep them. You might want to keep 
the utilities in a folder with your other utilities or create a new folder for 
them.

IBM recommends that you place the Calibrator-related software as 
follows:

• EFICOLOR Processor - should go into the System folder of your 
startup disk. Do not put it in the Extensions folder.

• EFICOLOR Preferences - should go into the Preferences folder in the 
System folder of your startup disk
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• EFICOLOR Profiles - should go into the ColorSync Profiles folder in 
the Preferences folder in the System folder of your startup disk

• Measurements folder - should go in the same folder as the Calibrator 
application

Information on installing the other user software for your IBM Network Color 
Printer is described in the main body of this book. Be sure to check README 
files on the Customer CD-ROM or diskettes and any release notes for the 
latest information on all software products.

Before You Begin

Before you start to calibrate your printer, you should familiarize yourself with 
your densitometer and make sure you have the necessary cable for 
connecting it to the modem port of your Macintosh. If you need help 
calibrating and zeroing your densitometer and connecting it to your 
Macintosh, see “Setting Up and Calibrating Your Densitometer” on page A–
27.

If you do not have a densitometer, you may find a service bureau that will 
measure your printed swatches on their densitometer and create a 
calibration or supply you with the values to enter manually. Or, you may 
improve your printed output by linearizing your printer or by downloading 
default or custom calibration curves.

Standard Calibration Procedure

Calibration reflects and refers to the particular printing environment that 
encompasses options selected in Printer Setup menu (in the printer operator 
panel), Print dialog box options (in the printer driver), and other variables 
such as toner and paper type.

Calibrating your printer with a densitometer is a five-stage process:

1. First, set up a controlled print environment on the printer, by removing any 
existing calibration from the printer and making sure your printing options 
reflect the type of printing you do.

2. Next, connect and set up your reflection densitometer.

3. Set up the Calibrator preferences to the way you want to measure color 
density and print a page of calibration patches. Each patch on the page 
represents a specific requested density.

4. Measure the density of the patches with the densitometer to establish the 
relationship between the requested density and the actual density your 
printer delivered. Instructions for measuring the patches are provided for 
several models of densitometer.

5. Choose the Download To Printer command to send calibration curves to 
your printer. The calibration curves specify the settings the printer should 
use to obtain predictable color density values.
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Checking Your Printer Setup

To obtain a useful calibration, your printer should be in a known state when 
you start the process. In this state, your calibrations are being used, and print 
options reflect the way you usually print. You print and measure calibration 
patches and download the calibration to your printer under known conditions.

To check your print environment:    

1. Remove any existing calibrations from your printer.

If you have previously calibrated your printer with the Calibrator utility, 
check for an active calibration (see “Checking the Date of Last 
Calibration” on page A–20). If a calibration is loaded, remove the 
calibration as described in “Removing a Calibration from a Printer” on 
page A–20.

If you previously calibrated your printer with another calibration program, 
you must first remove this calibration from your printer.

2. In the setup menus for the printer, select these options:

• In the Queue Setup menu, set ENABLE DIRECT to YES to download 
calibrations.

• In the Printer Setup menus, select CMYK for COLOR MODE. The 
Calibrator utility only supports CMYK mode.

• In the Network Setup menus, under AppleTalk Setup, set ENABLE 
APPLETALK to YES.

For information about using and navigating through the setup menus, see 
the Administrator’s Guide. 

Setting Up the Densitometer

Configure and zero your reflection densitometer to prepare for measuring the 
printed patches. For details, consult the manual that came with your 
densitometer. “Setting Up and Calibrating Your Densitometer” on page A–27 
gives basic information about setting up four densitometer models that are 
supported by the Calibrator utility.

The data interface cable that comes with these densitometers plugs into the 
modem port of the Macintosh and supplies measurements directly to the 
Calibrator Measurements window. When you use the interface cable, you 
don’t have to type numeric values into the window. To set up an X-Rite DTP 
32 with a PowerBook, see “To connect the X-Rite DTP 32 to a PowerBook” 
on page A–28.

Printing the Calibration Patches

To print the calibration patches, start the Calibrator utility, select a profile or 
measurements file, and check your Calibrator Preferences. Within the 
Calibrator Preferences dialog box, click on the Print Patches button.
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To start the Calibrator and select a profile or measurements file:    
1. Make sure the appropriate printer is selected in the Macintosh Chooser.

2. Double-click on the Calibrator utility icon.

3. Click on the welcome screen, then choose Query Printer from the 
Calibration menu.

An information screen appears which tells you whether a calibration is 
loaded or not. If a calibration is loaded, remove the calibration before 
proceeding. To do so, choose Remove from Printer on the Calibration 
menu, click on Proceed, then click on OK.

4. Choose Page Setup from the File menu. Set the paper size to Letter or 
A4, as appropriate. Click on the OK button.

5. Choose New Measurements from the File menu.

The EFICOLOR Profiles Directory dialog box appears, containing a list of 
the EFICOLOR profiles available in your ColorSync Profiles folder. The 
last profile used is selected.

6. Click on the Network Color Printer profile and then click on Select.

The Calibrator Preferences dialog box appears on your screen.

To set Calibrator Preferences:    

1. In the Calibrator Preferences dialog box, note the name of the printer.It 
should be the name of the printer you want to calibrate. If it is another 
printer, click on the Chooser, select a zone (if your network has zones), 
select the printer, and then click on the Connect button.

2. In the Calibrator Preferences dialog box, click on either Densitometer or 
Manual to specify the input source.

Choose Densitometer if you have one of the supported densitometers 
connected to your Macintosh. Your measurements will be automatically 
entered into the Measurements window.

Choose Manual if your densitometer is not supported or if your 
densitometer is not connected to your Macintosh. you will have to type the 
measurements into the Measurements window manually.

3. If you selected Densitometer as the input source, choose your make and 
model of densitometer from the Protocol pop-up menu. Confirm that the 
communication settings match the settings on your densitometer.

Communication settings are conventions that control communications 
between your computer and your densitometer. To communicate with 
each other, your densitometer and your computer must be set to the 
same data format and transmission speed.
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When you choose your make and model of densitometer from the 
Protocol pop-up menu, the communication settings change to reflect the 
default for your densitometer, as follows:

• For the X-Rite DTP 32, the settings are: 
Baud rate - 9600
Parity - none
Data bits - 8
Stop bits - 1

IBM recommends that you use the default settings.

• For the X-Rite 404, X-Rite 408, and Gretag D 186P, the settings are:
Baud rate - 1200
Parity - none
Data bits - 8
Stop bits - 1

For additional information about supported densitometers, see “Setting 
Up and Calibrating Your Densitometer” on page A–27

4. If you are using an X-Rite DTP 32, skip to step 7.

If you are using an X-Rite 404, X-Rite 408, or a Gretag D 186P, choose 
the number of measurements per row. IBM recommends using the 
default (3 per row) to reduce the effect of local variations.

5. Click on 3 if you want to measure all three color patches per row for 
additional precision.

6. Click on 1 to measure one color patch in each row.

Note: You can switch between one and three measurements per row at 
any time. For example, you can use the setting for one 
measurement per row to measure rows of patches that look within 
range and then switch to three measurements per row to 
measure questionable patches.

7. Click on the Print Patches button. The Print dialog box appears with the 
name of the chosen printer at the top and the name of the selected profile 
at the bottom.

8. With a PostScript Level 2 driver, click on the Options button. Make sure 
all of the options are set to Printer’s Default, then click on OK.

The Adobe driver supplied with the printer lets you save print options. 
Although you may change the printer defaults for some purposes, do not 
override the Printer’s Defaults when printing patches.

9. Click on the Print button. The calibration page that corresponds to your 
densitometer model is printed.

10. If you are using an X-Rite 404 or X-Rite 408, skip to “Using Other 
Densitometers to Measure the Calibration Patches” on page A–10.

If you are using a Gretag D 186P, after you print the calibration patches, 
zero your densitometer on a white area of your printer page. Then skip to 
“Using Other Densitometers to Measure the Calibration Patches” on page 
A–10.
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11. If you are using an X-Rite DTP 32, display the Main Menu before 
configuring your densitometer. To do so, simultaneously press the two 
keys on the X-Rite DTP 32 marked MENU.

The words Main Menu are displayed on the DTP 32.

12. At your Macintosh, click on the Proceed button.

If this is the first time you have used the Calibrator utility with the X-Rite 
DTP 32, you may see a dialog box asking you to assign a number and 
name to the strip setup. If so, do this and click on the Save button.

A message box indicates that the Calibrator utility is configuring the 
densitometer. The EPROM version is displayed briefly. When 
configuration is complete, a screen is displayed that asks you to select a 
strip setup for the Calibrator

13. On the densitometer, press PAP. If necessary, press OTHER until 
“FPCStrp” or the strip name you specified is displayed on the 
densitometer.

14. At your Macintosh, in the dialog box, click on the OK button.

You have completed the procedure for setting the Calibrator preferences. 
You are now ready to measure the calibration patches, as described in the 
next section. 

Using an X-Rite DTP 32 to Measure the Calibration Patches

To measure the patches using an X-Rite DTP 32 scanning densitometer, 
insert one end of the page in the densitometer, and the entire column is 
measured automatically.

The densitometer scans the density of the first patch, automatically advances 
to the next patch, and automatically transmits the measured values to the 
Calibrator. The DTP densitometer has an adjustable strip guide to the right of 
the strip entrance. The correct strip guide setting for each column is 
displayed on the densitometer and also on your monitor in the status area at 
the top of the Measurements window.

After each column is scanned, the density measurements are automatically 
entered into the Measurements window.

In general, valid measurements for all patches fall within the range of -0.05 to 
3.05. If a measurement is out of range, the Calibrator displays an alert box. If 
this happens, check your densitometer setup before re-measuring the strip. 
The Save and Save As commands are not available when the 
Measurements window contains an out-of-range value.

To measure calibration patches with an X-Rite DTP 32:    

1. Position the pointer on the strip guide to 15.

First, you’ll measure the cyan column. Slide the paper guide to the left or 
right until the arrow points to 15.

2. With the arrow below the cyan column pointing towards the densitometer, 
align the right side of the patches page with the strip guide.
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The status line in the Measurements window tells you the correct strip 
guide setting for each pass.

3. Insert the patches page into the densitometer until it rests against the 
drive rollers and the motor is activated. There may be a slight hesitation 
before the rollers start.

4. Hold the page against the guide to prevent any skewing while the strip is 
being measured.

After the strip is measured, “Pass #1 of 4 OK!” is displayed in the 
densitometer display. “Transmitting data” also appears briefly after each 
pass.

If the measurements entered into the first row in the Measurements 
window are not within range, they are shown in bold type and you see the 
message, “Near-zero values expected for this row. Please calibrate your 
densitometer to blank paper.” When you see this message, you should 
calibrate your densitometer. In this case, use the Auto-Cal strip provided 
with the X-Rite 32. If you continue to get out-of-range measurements in 
this first row, your printer may need service.

5. Move the strip guide to 30 and measure the magenta column.

After the strip is measured, “Pass #2 of 4 OK!” is displayed in the 
densitometer display. 

6. Turn the patches page around so that the arrow above the yellow column 
is pointing towards the densitometer. Leave the strip guide set to 30.

7. Align the right side of the patches page with the strip guide and measure 
the yellow column.

After the strip is measured, “Pass #3 of 4 OK!” is displayed in the 
densitometer display. 

8. Move the page guide to 15 and measure the black column.

After the strip is measured, “Pass #4 of 4 OK!” is displayed in the 
densitometer display. Then the Calibrator displays a message when the 
Measurements window is completely filled in.

You have completed the procedure for measuring calibration patches with an 
X-Rite DTP 32.

If you wish to save the measurements, see “To save your measurements” on 
page A–14.

To download the calibration curve, see “Downloading Calibration Curves” on 
page A–13

If you wish to view or edit either target/measured curves or calibration 
curves, see “Viewing and Editing Calibration Curves” on page A–21.
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Using Other Densitometers to Measure the Calibration Patches

If you have connected an X-Rite 404, X-Rite 408, or Gretag D 186P 
densitometer to your Macintosh, your measurements are automatically 
entered into the fields in the Measurements window. If you are using a 
densitometer that is not supported by the Calibrator, or if you do not have a 
cable to connect your densitometer to your Macintosh, you must enter the 
measurements manually by typing them into the appropriate fields in the 
Measurements window. Procedures for using both methods are provided in 
this section.

The Measurements window contains four columns: cyan, magenta, yellow, 
and black. Each column consists of 18 rows. Each row has three numeric 
input fields and one calculated field. The numeric input fields correspond to 
the calibration patches that you printed. The calculated field displays the 
average of the three measurements in that row.

It is important that you measure the patches in the same order as the cursor 
advances through the Measurements window when you press down on the 
densitometer (automatic data entry) or press Tab on the keyboard (manual 
data entry).

When you specify one measurement per row in the Calibrator Preferences 
dialog box, the Calibrator utility enters the same value into all the fields of 
that row, including the “average” field. You can measure any one of the 
patches in a row.

When you specify three measurements per row, the cursor moves through 
the fields in the Measurements window left to right within a row and top to 
bottom within the column for each color component.

In general, valid measurements for all patches fall within the range of -0.05 to 
3.05. If you enter a measurement that is out of range, the Calibrator displays 
an alert box. In this case, you cannot advance the cursor to the next field until 
the out-of-range measurement is corrected. Check your densitometer setup 
before re-measuring the patch. The Save and Save As commands are not 
available when the Measurements window contains an out-of-range value.

When you specify three measurements per row, the density measurements 
within a single row should be almost the same. When the measurements 
within the same row differ by more than 0.20, you see a message box. After 
you click OK in the message box, the measurement is displayed in bold type 
and the cursor advances to the next field. (When you open this 
measurements file in the future, the Calibrator will remind you that some of 
the measurements have questionable values.)

There are several steps you can take to correct for an out-of-range 
measurement:

• Re-measure all three patches in the row.

• Be careful not to inadvertently measure a patch in the row above or below 
the row you should be measuring.
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• If you are entering measurements manually, check to see if you have 
misplaced the decimal or transposed two digits.

• If you are entering measurements automatically, double-check your setup.

• Make sure you have properly zeroed the densitometer.

If you continue to have out-of-range measurements, your printer may need 
service.

Entering Measurements Automatically

When your hand-held densitometer is connected to your Macintosh, and 
Densitometer is selected as the input source in the Preferences dialog box, 
the Calibrator automatically enters the measurements into the 
Measurements window. At the end of each row, the Calibrator enters an 
average value.

To measure patches automatically:    

1. If you selected one measurement per row in Calibrator Preferences, 
center the aperture of the densitometer carefully over any color patch in 
the first row in the Cyan column, and measure the density.

The Calibrator enters the measurement into all three measurement fields 
in the first row of the Measurement window and enters the average (the 
same number) into the rightmost field in that row.

2. If you selected three measurements per row, measure the leftmost patch 
in the first row of the Cyan column.

The Calibrator enters the measurement only in the first field in the 
Measurements window.

If a measurement is not entered into the Measurements window, check 
your densitometer setup and the connector. Make sure that you have 
selected Densitometer as the input source in the Calibrator Preferences.

Note: The first row of patches should measure zero, or close to it. If the 
measurements entered into the first row in the Measurements 
window are not close to zero, they are displayed in bold type and 
you see the message, “Near-zero values expected for this row. 
Please calibrate your densitometer to blank paper.” When you 
see this message, zero your densitometer. See “Setting Up and 
Calibrating Your Densitometer” on page A–27. If you continue to 
get out-of-range measurements in this first row, your printer may 
need service.

3. If you selected one measurement per row, measure a patch in the second 
row. Continue in this way until you have measured one patch in each row 
of each column.

The calibrator displays a message when the Measurements window is 
completely filled in.

To save the measurements, “To save your measurements” on page A–
14.

If you are ready to download the calibration, skip to the section 
“Downloading Calibration Curves” on page A–13.
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If you want to view or edit either target/measured curves or calibration 
curves, see “Viewing and Editing Calibration Curves” on page A–21.

4. If you selected three measurements per row, measure the second and 
third patches in the first row in the cyan column. 

Continue in this way until you have measured all the patches in each 
column.

When you have measured all three patches in a row, the Calibrator enters 
the average of the three measurements into the rightmost field in the first 
row.

Always measure the patches in the order in which the cursor advances 
through the Measurements window (left to right within each row and top 
to bottom within each column) before moving to the next column or color.

The Calibrator displays a message when the Measurements window is 
completely filled in.

If you are ready to download the calibration, skip to “Downloading 
Calibration Curves” on page A–13.

To save the measurements, “To save your measurements” on page A–
14.

If you want to view or edit either target/measured curves or calibration 
curves, see “Viewing and Editing Calibration Curves” on page A–21.

Entering Measurements Manually

If your densitometer is not supported by the Calibrator, or if you do not have 
a cable to connect your densitometer to your Macintosh, enter your 
measurements manually by typing the values into the fields in the 
Measurements window. When you finish typing one or all three 
measurements in a row (depending on the measurements per row setting), 
the Calibrator enters the average value in the rightmost field.

To measure patches manually:    
1. If you selected one measurement per row in Calibrator Preferences, 

center the aperture of the densitometer over any calibration patch in the 
first row of the cyan column, and measure the density.

2. If you selected three measurements per row, measure the leftmost patch 
in the first row of the cyan column.

3. In the Measurements window, type the measurement in the row and field 
of the cyan column that corresponds to the patch you measured, and then 
press Tab.

4. If you selected one measurement per row, the Calibrator enters that 
measurement into all the fields in that row, and the cursor moves to the 
first field in the second row of the Cyan column.

If you selected three measurements per row, the Calibrator enters the 
measurement into the first field in the row, and the cursor moves to the 
second field in the same row.

If you selected one measurement per row, continue in this way until you 
have measured one patch in each row of each column.
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The Calibrator displays a message when the Measurements window is 
completely filled in.

If you are ready to download the calibration, skip to the section 
“Downloading Calibration Curves” on page A–13.

To save the measurements, see “To save your measurements” on page 
A–14.

If you want to view or edit either target/measured curves or calibration 
curves, see “Viewing and Editing Calibration Curves” on page A–21.

5. If you selected three measurements per row, measure the second and 
third patches in the first row of the Cyan column and type in the 
measurements, pressing Tab after each entry.

When you have entered all three measurements in a row, the Calibrator 
averages the three measurements and enters the result in the rightmost 
field in the first row.

6. Continue in this way until you have measured all the patches in each 
column.

You can use the Cut, Copy, Paste, and Delete commands to assist you 
in entering measurements into the Measurements window.

The Calibrator displays a message when the Measurements window is 
completely filled in.

If you are ready to download the calibration, skip to “Downloading 
Calibration Curves” on page A–13.

To save the measurements, see “To save your measurements” on page 
A–14.

If you want to view or edit either target/measured curves or calibration 
curves, “Viewing and Editing Calibration Curves” on page A–21.

Downloading Calibration Curves

When you have finished measuring the color patches, the Calibrator 
compares the measured densities with the optimal target densities contained 
in the EFICOLOR profile. It then creates calibration curves that you can 
download to the printer.

The calibration curves you download bring your printer to an optimal level of 
print quality by changing its response to requested densities. After you have 
downloaded the calibration curves, the calibration remains resident in the 
printer, and all users of that printer will see the effects of calibration.

Note: If you have previously calibrated your printer with another calibration 
program, you must first remove that calibration from your printer.

To download calibration curves to your printer:    

1. Make sure the appropriate printer is selected in the Chooser.

Select the Chooser name of the direct connection (IBMnetcolor_Direct).

If the name of the direct connection does not appear in the Chooser list, 
ask the system administrator to enable the direct connection on
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the printer. ENABLE DIRECT Q is an item in the QUEUE SETUP menu. 
For more information about this setting, see the Administrator’s Guide.

Note: The Calibrator will not download calibration curves if you are 
connected to one of the printer queues (Direct, Print, Printed, or 
Hold).

2. If the measurements file you want to download is not already open, open 
it.

For additional information, see “Saving and Re-opening Your 
Measurements” on page A–14.

3. Choose Download To Printer from the Calibration menu. The Download 
dialog box is displayed.

4. Click on Calibration Curves if it is not already selected. Click on 
Download.

You see the message, “This action will change the colors on the printer 
for all the users that may print to it later. Do you want to proceed with 
this?”.

5. Click on the Proceed button. The message, “Calibration successfully 
downloaded” is displayed.

Saving and Re-opening Your Measurements
Saving your calibration measurements in a file allows you to:

• Keep a record of your printer’s performance

• Download calibration curves to the printer at a later time

• Save a partial set of measurements, which you can complete later

• Link your measurements to the Linear CMYK Device profile

Instructions for linking measurements to the Linear CMYK Device profile are 
found on page A–17. Procedures for saving and loading a measurements file 
follow.

To save your measurements:    
1. After you have measured the calibration patches, choose Save from the 

File menu. The Save dialog box appears.

2. Double-click on the Measurements folder to open it. The directory 
displays a list of existing measurements files.

If you have more than one IBM Network Color Printer, the best way to 
organize your measurements files is to create a folder for each printer 
within the Measurements folder.

3. Type the name you want for the measurements file.

For example, you might assign the printer name and current date as the 
name of a measurements file.

4. Click on the Save button. The measurements file is saved in the 
Measurements folder under the name you assigned.
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Opening a Measurements File

Opening an existing measurements file allows you to:

• Download calibration curves from measurements you made earlier

• Assess the color output of your printer over time by comparing different 
measurements files

• Complete a partial set of measurements

• Link a set of measurements to the Linear CMYK Device profile (see page 
A–17).

To open an existing measurements file:    

1. Choose Open Measurements from the File menu. The Open 
Measurements dialog box is displayed.

2. Double-click on the Measurements folder to open it. The directory 
displays a list of the existing measurements files.

3. Click on the measurements file you wish to open. The Open dialog box 
displays the name of the profile to which the selected measurements file 
is linked.

4. Click on the Open button.

You see the contents of the measurements file displayed in the 
Measurements window. The measurements are linked to the profile that 
was chosen in the Save dialog box when the file was saved.

Linearizing Your Printer
When you calibrate your printer using the profile for that printer, your 
Calibrator utility changes the densities to match the optimal target contained 
in the profile.

For certain print jobs you may not want to change the range of densities you 
are using to conform with that target. Instead, you may want to enhance the 
overall quality of your output while maintaining the existing range of 
densities. This is especially useful if your applications do not support 
EFICOLOR. The Calibrator includes a Linear CMYK Device profile that you 
can use to linearize your printer within the existing range of densities.

Note: When you use the Linear CMYK Device profile instead of the profile for 
your specific printer, you sacrifice predictable color across time and 
consistent output across printers of the same kind. If you are using an 
EFICOLOR-supporting application, output from a linearized printer 
may not match output from other printers.

When you linearize your printer, the entire measured density range in each 
color channel is divided into equal steps. Equal steps in ink percentage, such 
as 0%, 10%, and 20% will be printed in equal steps in density and will appear 
as roughly equal visual steps. This gives a linear response using the range of 
densities available. 
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If you recently calibrated your printer and saved the measurements file, you 
do not need to use the procedure that follows to linearize your printer. Just 
open the measurements file and change its link from the profile for your 
printer to the Linear CMYK Device profile, then download that file to your 
printer. For instructions, see “Linking Measurements to the Linear CMYK 
Device Profile” on page A–17.

If you do not have a measurements file from a recent printer calibration, you 
will need to print and measure a page of patches, as summarized below.

To linearize your printer:    

1. Using the printers setup menus, select the following settings:

– ENABLE APPLETALK = YES (NETWORK SETUP menu)

– ENABLE DIRECT Q = YES (QUEUE SETUP menu)

– COLOR MODE = CMYK (PRINTER SETUP menu) 

For more information on these settings, see the Administrator’s Guide.

2. From the Macintosh Chooser, select the printer you want to linearize.

Select the name of the Network Color Printer direct queue.

3. Start the IBM Network Color Printer Calibrator.

4. Click on the Welcome screen and choose Query Printer from the 
Calibration menu.

An information screen informs you whether a calibration is loaded. If a 
calibration is loaded, remove the calibration before proceeding. (From the 
Calibration menu, choose Remove from Printer, click on Proceed, and 
then click on OK)

5. Choose Page Setup from the File menu, set the paper size to Letter or 
A4, as appropriate, and then click on OK.

6. Choose New Measurements from the File menu. The Profiles dialog box 
is displayed.

7. Click on Linear CMYK Device and then click on Select. The Calibrator 
Preferences dialog box in which you entered the communication and 
measurement preferences is displayed.

8. Click on the Print Patches button. The Print dialog box is displayed.

9. With a PostScript Level 2 driver, click on Options. Make sure that all 
options are set to Printer’s Default, and then click on OK.

10. Click on the Print button. The Calibrator prints a test page of calibration 
patches.

11. Measure the calibration patches.

For additional information, see “Using an X-Rite DTP 32 to Measure the 
Calibration Patches” on page A–8 or “Using Other Densitometers to 
Measure the Calibration Patches” on page A–10.

12. Choose Save from the File menu. The Save dialog box is displayed. For 
additional information on saving measurements, see “Saving and Re-
opening Your Measurements” on page A–14.
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13. Choose Download To Printer from the Calibration Menu.

14. Click on Calibration Curves if it is not already selected. Then click on the 
Download button.

A message box is displayed, saying, “This action will change the colors 
on the printer for all users that may print to it later. Do you want to proceed 
with this?”

15. Click on the Proceed button. The message, “Calibration successfully 
downloaded” is displayed.

Note: The linear calibration will be used for all printing.

Linking Measurements to the Linear CMYK Device Profile

Your IBM Network Color Printer Calibrator is preset to link your 
measurements to the profile you selected when you opened the New 
Measurements window. However, you can choose to link your 
measurements to the Linear CMYK Device profile when you save a 
measurements file (using Save As). This is useful if you set out to calibrate 
your printer to a target, but later decide you’d like to linearize your printer 
using the same measurements.

Note: You can use the same method to link your measurements to any other 
profile, but you should only change the link from your printer profile to 
the Linear CMYK Device profile, or vice versa. Do not change the link 
from one printer profile to another printer profile.

To link a measurements file to the linear CMYK device profile:    

1. Display the measurements in the Measurements window.

You can use measurements you just obtained with a densitometer or an 
existing measurements file you have opened.

2. Choose Save As from the File menu, then double-click on the 
Measurements folder to open it.

3. From the Profile pop-up menu, choose the Linear CMYK Device profile.

4. Type a different name for the linear measurements file.

5. Click Save.

The measurements file is saved under that name in the Measurements 
folder. To linearize your printer immediately, download the linear 
measurements to your printer. Go to step 13. on page A–17 for 
information on how to do this.

To linearize your printer at a later time, open the linear measurements file 
and download it to your printer.

Loading A Default Calibration
If you do not have a densitometer to measure printed output from your 
printer, you can use a default set of measurements from an “average” printer 
of the same make and model. When you download these measurements as 
a calibration to the printer, they correct the output to the extent that your 
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printer behaves like the printer that was used for creating the default curves. 
The Measurements folder installed with the Calibrator contains a default set 
of measurements for your printer model.

You may find that downloading calibration curves from the default 
measurements is preferable to using no calibration curves at all, and that the 
default curves give improved printed output.

The same general method is used for downloading a custom calibration. 
Creating a custom calibration is described on page A–25.

To download a default calibration:    

1. Using the printers setup menus, select the following settings:

– ENABLE APPLETALK = YES (NETWORK SETUP menu)

– ENABLE DIRECT Q = YES (QUEUE SETUP menu)

– COLOR MODE = CMYK (PRINTER SETUP menu) 

For more information on these settings, see the Administrator’s Guide.

2. In the printer control panel Setup screens, select the options Enable 
Appletalk, Enable Direct, and select CMYK for Color Mode.

3. From the Macintosh Chooser, select the printer you want to calibrate. 
Select the name of the IBM Network Color Printer direct queue.

4. Start the Calibrator and choose Open Measurements from the File menu.

5. Double-click on the Measurements folder to open it. The Open 
Measurements dialog box is displayed; it shows the list of measurements 
files in the Measurements folder.

6. Click on the default measurements file for the printer you wish to 
calibrate, then click on Open.

To link a measurements file to the linear CMYK Device profile:    

1. Display the measurements in the Measurements window.

You can use measurements you just obtained with a densitometer or an 
existing measurements file you have opened.

2. Choose Save As from the File menu, and then double-click on the 
Measurements folder to open it.

3. From the Profile pop-up menu, choose the Linear CMYK Device profile.

4. Type a different name for the linear measurements file.

5. Click on the Save button.

The measurements file is saved under that name in the Measurements 
folder. To linearize your printer immediately, download the linear 
measurements to your printer.

To linearize your printer at a later time, open the linear measurements file 
then and download it to your printer.
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Printing with a Calibrated Printer
When users print to a calibrated printer, the calibration curves are applied to 
every print job.

With applications that specify RGB color, calibration curves are applied after 
the RGB color values have been transformed to CMYK.

If you are accustomed to correcting colors on uncalibrated systems by 
changing application settings or print options, this may not be necessary 
when you print to a calibrated printer. Using printer defaults may give you 
optimal output.

If you do override printer defaults, do it on a job-by-job basis when you want 
to achieve particular results. The same holds true for overriding default print 
settings in the Spooler utility and the Downloader utility.

Among the options that should only be changed on an individual job basis 
when printing to a calibrated printer are:

• Brightness, Media Type, and Rendering Style settings in the Print Options 
dialog box and the Spooler

• Gamma settings in the Downloader

For more information about print settings and printing from applications, see 
the User’s Guide.

Scheduling Calibration
Your printer has a self-calibration feature that optimizes toner densities on 
warm-up, after service, and at periodic intervals. You can use the Calibrator 
in conjunction with this feature. Using the printer’s self-calibration feature 
alone will not necessarily bring output densities from your printer to the target 
values in the printer profile.

Note: You can adjust printed color from the density control panel. You can 
increase or decrease toner density for one or all toner colors. Make 
sure that these settings remain the same (preferably at a neutral 
position) prior to calibration with the Calibrator, and from one job to the 
next one. For more information, see Operator’s Guide.

If you do not have a densitometer for measuring printed output from your 
system on a regular basis, you can also monitor printer output visually to help 
you decide when calibration is needed.

Set up a standard printing environment by selecting default printing options 
that correspond to the way you usually print. Then print one or more standard 
color pages. Besides the patches page, you can print the test page, the color 
pages, and the CMYK Reference page. All of these pages include fully 
saturated color patches and pale tints of cyan, magenta, yellow, and black. 
You can save and compare pages you printed at different times. If there is a 
noticeable change in the appearance of tints, you should calibrate or 
linearize your printer.
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If your solid density patches (100% cyan, magenta, yellow, or black) look 
less saturated with time, show the pages to the CE or service representative 
to find out if an adjustment can be made to improve the output.

Checking the Date of Last Calibration

Before printing a job, you can check to see whether calibration curves are 
loaded and when the printer was last calibrated. You can get this information 
by querying the printer from the Calibrator utility.

To find out when a printer was last calibrated:    

1. If you want to check the date of the last calibration, make sure the 
appropriate printer is selected in the Chooser.

2. Select the name of the direct queue. If the direct queue does not appear 
in the Chooser list, ask the system administrator to enable it.

3. If it is not already running, start the Calibrator by double-clicking on the 
Calibrator icon.

4. Choose Query Printer from the Calibration menu. The message, 
“Querying printer” is displayed, followed by a dialog box indicating the 
time and date the printer was last calibrated, the user who performed the 
calibration, and the profile to which the measurements file was linked.

Note: Self-calibration performed by the printer does not change the 
calibrator data that appears on the START page.

Removing a Calibration from a Printer

If you need to remove a calibration from your IBM Network Color Printer, you 
can use the Remove From Printer command.

To remove a calibration from your printer:    

1. Make sure the appropriate printer is selected in the Chooser. 

2. Select the name of the direct queue. If the direct queue does not appear 
in the Chooser list, ask the system administrator to enable it.

3. If it is not already running, start the Calibrator utility by double-clicking on 
the Calibrator icon.

4. Choose Remove From Printer from the Calibration menu. This message 
is displayed: “This will remove all corrections that might have been 
previously downloaded to the printer. This will affect all users. Do you 
want to proceed?”

5. In the message box, click on the Proceed button, then click on OK.
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Viewing and Editing Calibration Curves
The Calibrator utility allows you to view information about your printer’s 
calibration and provides tools for customizing both the target you are 
calibrating to and the calibration curves.

In this section, you will learn more about your remaining calibration options, 
such as how to:

• Interpret the information presented in the Target/Measured curves window, 
which compares the actual, measured densities your printer printed with the 
optimal, requested densities contained in the profile for your printer.

• Interpret the calibration curves displayed in the Calibration Curves window, 
which illustrate how the requested ink percentages must be adjusted to 
achieve the desired output densities.

• Tailor the target contained in the profile to your specific equipment or print 
requirements.

• Create a custom calibration curve when you want to achieve a result that is 
different from the target contained in the profile.

Calibration Options
When downloading a calibration to the printer, you have these choices:

• EFICOLOR calibration - adjusts you printer response to conform as closely 
as possible to the EFICOLOR target curve based on the profile for your 
printer. For most users, this is the preferred calibration method.

• Linear calibration - also downloaded as an EFICOLOR calibration, this 
makes your printer response correspond to a linear CMYK target curve. 
Linear calibration results in output which divides the maximum measured 
density for each color into equal density steps.

• Calibration with edited EFICOLOR target curves - changes the calibration 
target from the EFICOLOR target, within a certain range. The maximum 
density of the target can be changed (within plus or minus 100% of the 
EFICOLOR target maximum density), the midtone density can be changed 
(within plus or minus 100% of the EFICOLOR target midtone density), or 
both can be changed. This calibration adjusts your printer response to 
conform as closely as possible to the edited target curves.

• Custom calibration (custom response) - allows you to create or edit a 
calibration curve or load a transfer curve created in Adobe Photoshop. 
Separate curves can be downloaded for cyan, magenta, yellow, and black, 
or the same curve can be downloaded for all colors. The Calibrator saves 
one current set of custom calibration curves in the FPC Preferences. 
Whenever you download Custom calibration curves, these are the curves 
that are used, until you load a different set or edit the existing curves.

• Composite Calibration Curve - combines your custom calibration curve with 
an EFICOLOR calibration curve to create a composite curve. The 
composite curve as well as the two source curves can be viewed in the 
Calibration Curves window.
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• Default Calibration - uses factory measurements from the same printer 
model to simulate the behavior of your printer. Its usefulness depends on 
just how similar your system is to the system that was measured. Given the 
number of variables involved, it is much better to create a baseline 
calibration from densitometer measurements than from factory 
measurements.

The standard EFICOLOR calibration options (EFICOLOR target, Linear and 
Default) were covered in “Standard Calibration Procedure” on page A–4. The 
remaining calibration options, which can be used regularly or for occasional 
special effects, are described in this chapter.

Comparing Target Densities with Measured Densities
The Calibrator displays four graphs that illustrate the relationship between 
the optimal or target densities contained in the profile and the actual, 
measured densities your printer delivered.

The graphs provide a quick way to detect possible problems with your printer 
and provide a visual reference for customizing the calibration target and 
creating a calibration curve. The graphs also offer a guideline as to whether 
your Calibrator can bring the printer to an acceptable performance level, or 
when a visit from a service representative or other remedy may be needed.

Because the graphs are frequently useful in diagnosing a specific problem, 
show them to your service representative when maintenance is required. For 
example, if all the curves deviate from the target in the same manner, the 
service representative would know that the problem is general for all color 
channels. On the other hand, if only one color channel differs from the target, 
the service representative would know to adjust only the appropriate 
channel.

To compare measured densities with target densities:    

1. Open a new measurements file, print and measure patches, and enter 
values in the Measurements window. Or, open a previously created 
measurements file.

Either option results in a filled-in Measurements window. The View Menu 
is grayed out and cannot be selected until you display a Measurements 
window on your screen with all the measurements entered.

2. Choose Target/Measured Curves from the View menu.

You see the Target/Measured Curves window, with target curves and 
measured curves.

The calibration patches page is a series of ink percentage specifications. 
The thin blue (measured) curve shows the density measurements that 
correspond to the ink percentages specified for the patches. The thicker 
red (target) curve shows the ink densities that would be optimal for the 
corresponding patches, according to the EFICOLOR profile that 
characterizes your printer.

The objective of calibration is to bring the measured values represented by 
the blue curve to the target values represented by the red curve.
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Based on these measurements, the Calibrator creates calibration curves, 
which you then download to your printer to bring your print output to the 
target.

Before you decide to download a calibration:

• Check each measured color channel to see that the densities increase 
steadily. If you detect a spike in a density curve or a sawtooth shape in one 
of the channels, you may want to re-measure the corresponding patches.

• Check to see how the curves of the measured and target densities 
compare. The closer the measured densities are to the target densities, the 
better the results you’ll get from calibration. Still, even when the curves do 
not overlap at all, the Calibrator will usually be able to compensate for 
deviation from the target.

Look at the right edge of the graph for each color channel. The point where 
the measured density curve intersects the right edge represents the 
maximum density (Dmax).

• If the maximum measured density is the same as or slightly higher than the 
maximum target density, calibration can successfully bring your printer to 
the optimal (target) state.

• If the measured density is higher by 15% or more, printed images may 
exhibit contouring, banding, or quantization after calibration. This is 
especially noticeable if you are printing images with degrades (vignettes, 
ramps). In this case, you may consider using the Linear CMYK Device 
profile (see“Linearizing Your Printer” on page A–15) or asking your service 
representative to reduce the overall print density of the affected channels.

• If the maximum measured density is slightly lower than the target curve, 
you colors will not be as saturated as recommended. However, because 
the Calibrator was designed to compensate for some decrease in density, 
your printed images will result in minimal visual degradation as long as the 
density decrease is not drastic. If images look washed out even after 
calibration, you can ask your service representative to boost the densities.

Editing the Target Densities
When you download your measurements, the Calibrator brings the response 
of your printer to a target contained in the EFICOLOR profile. For important 
jobs, you may print a proof before you print a large run. After examining the 
proof, you may decide to adjust the EFICOLOR profile target to achieve a 
particular result. For example, the proof may be too dark overall or the 
magenta density may be too high. The Calibrator lets you customize the 
target for maximum density (Dmax) and midtones.

IBM recommends that you take the following steps to determine the best 
course of action. Custom calibration curves are described later in this 
chapter. 

• Measure your printer’s ink densities and download the calibration curves.

• Print from your application and examine the printed results.
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• If you are dissatisfied with the printed results, either customize the 
calibration curve (which indirectly changes the target) or customize the 
target.

• Download the Composite Curves, print from your application, and examine 
the printed result. If you still are not satisfied, download Custom Calibration 
Curves and print again. (For additional information about these options, see 
“To download an edited calibration curve or edited target curve” on page A–
26.

To edit target density and midtone curves:    

1. Choose Target/Measured Curves from the View menu. The Target/
Measured Curves window appears.

2. In the Target/Measured Curves window, click on Edit Target Curves, or 
click in any of the individual curves. The Edit Target Curves dialog box 
appears. This box allows you to edit the target contained in the 
EFICOLOR profile you are currently using.

3. To edit all four colors at once, confirm that All Same is selected. To edit a 
single color, click on All Same to deselect it, then click the color you want 
to edit. 

When you deselect All Same, the individual colors become available.

4. To edit the maximum density target, drag the Max Density slider to the 
density level you want.

You can also select the Max Density field (using the Tab key) and type 
the percent change you want to make to the target density. To increase 
or decrease the target density slightly, click on the arrow at the 
appropriate end of the slider.

Changes in maximum density and midtones are relative to the target 
contained in the EFICOLOR profile you are using. For example, if you 
move the maximum density slider to 20%, you are requesting the target 
maximum density plus 20%.

Click on Default to return to the default target. Click on Revert to return to 
the last saved values.

5. To edit the midtones target, drag the Midtones slider to the level you want.

You can also select the Midtones field and type the target midtone value 
you want. To increase or decrease the midtone density slightly, click the 
arrow on the appropriate end of the slider.

6. Click on the OK button.

In the Target/Measured Curves window, the target curve is re-plotted to 
reflect your edited target.
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Viewing Calibration Curves
The principle of calibration involves a request and a response: the ink 
percentage, or dot-area-coverage, that is requested (sent from the computer 
to the printer) and the controller’s response, the ink percentage specification 
that it sends to the print engine. The calibration curves illustrate the mapping 
between the request and the response.

In the optimal case there is no need to adjust (calibrate) the printer. In this 
case, the mapping graphs would be a straight line (for example, 50% input is 
mapped in 50% output). The closer the curve is to a straight line, the closer 
the specific printer is to the target.

The right side of the curves represents the mapping of the requested 
maximum density (Dmax). When the curve intersects the right side, as 
opposed to the top-right corner, it means that the printer Dmax is currently 
higher than the recommended target values. The closer to the bottom the 
curve intersects the side, the more quantization will occur.

To view calibration curves:    

1. Open a new measurements file, print and measure patches, and enter 
values in the Measurements window. Or, open a previously created 
measurements file.

Either option results in a filled-in Measurements window. The View Menu 
is grayed out and cannot be selected until you display a Measurements 
window on your screen with all the measurements entered.

2. Choose Calibration Curves from the View menu. The Calibration Curves 
window is displayed.

Creating Custom Calibration Curves

The target used by the Calibrator is the target contained in the EFICOLOR 
profile. This target provides optimal results when you are printing with an 
EFICOLOR-supporting application. You may not want to use EFICOLOR at 
all times, or you may feel that you can achieve better results by creating your 
own calibration curves. If your printed image is too dark overall, you have the 
option of either reducing the density of the target or reducing the output 
density on all calibration curves.

To create a custom calibration curve:    

1. Choose Edit Calibration Curves from the Edit menu. Or, click on Edit 
Calibration Curves in the Calibration Curves window; or click in any 
individual curve in the Calibration Curves window.

The Edit Calibration Curves dialog box is displayed. This box enables you 
to create a custom calibration curve from scratch. Because you are not 
editing or otherwise modifying an existing calibration curve, there is no 
need to open a measurements file first.

2. To apply one calibration curve to all four colors, click on All Same. The 
individual colors are disabled, and the graph changes to black and white.

3. Alternatively, to apply a curve to a single color, deselect All Same, and 
then click on the color you want.
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When you click to deselect All Same, the individual colors become 
available.

4. Enter the calibration values either by typing them into the fields (as 
custom percentages), or by plotting points on the graph with the mouse.

When plotting points, position the cursor where you want a point, and 
then press the mouse button. You can also drag the curve or drag in the 
area around the curve to get a smooth curve.

Click on the Revert button to return to the last curve saved. Click on the 
Default button to return to the original Input = Output curve (a 45 degree 
straight line).

Use the Save button if you want to apply the calibration curve in the future 
to get similar printed results. Use the Load button to open a set of transfer 
curves saved from the Calibrator or from Adobe Photoshop.

5. Click on the OK button.

In the Calibration Curves window, click on EFICOLOR Calibration to view 
the curves based on the EFICOLOR profile, before or after edits are 
applied.

Click on Custom Calibration to display your custom calibration curve.

Click Composite to display a composite of both curves. You can 
download any of these curves to the printer.

To download an edited calibration curve or edited target curve:    

1. After editing an EFICOLOR calibration curve or creating a custom 
calibration curve, choose Download To Printer from the Calibration menu. 
The Download dialog box appears.

2. To download the EFICOLOR calibration curves, with or without changes 
to the target maximum densities and midtones, click EFICOLOR 
Calibration curves. To download curves you created, click on Custom 
Calibration curves.To download a composite EFICOLOR calibration 
curve and custom calibration curve, click on Composite Curves.

If you have previously saved a calibration curve, click on Load Curve and 
select the curve you want. Then select the download option you want.

3. Click on Download. In the message box, click on the Proceed button. The 
message, “Calibration successfully downloaded” is displayed.

4. Click on the OK button.
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Setting Up and Calibrating Your Densitometer
If you wish to enter density measurements into the Measurements window 
manually, you can use any Status T reflection densitometer. You simply zero 
the densitometer, measure the densities, and enter the measurements into 
the Measurements window.

If you want to enter density measurements automatically, you need an X-Rite 
DTP 32, an X-Rite 404 or X-Rite 408, or a Gretag D 186P (polarized) 
densitometer, and the appropriate interface cable. You may need to order 
the interface cable separately.

This section provides the basic information you need to set up and use the 
densitometers mentioned above.

Note: Although the Calibrator supports only the X-Rite DTP 32, X-Rite 404, 
X-Rite 408, and Gretag D 186P, you may get satisfactory results with 
other models.

Setting Up the X-Rite DTP 32
The X-Rite DTP 32 comes with a Macintosh data interface cable that allows 
you to plug into an ADB port on your Macintosh.

Note: If you are using a Macintosh PowerBook, see “To connect the X-Rite 
DTP 32 to a PowerBook” on page A–28.

To connect the X-Rite DTP 32:    

1. Plug the square end of the interface cable (like a modular phone plug) into 
the I/O port on the side of the X-Rite DTP 32.

2. Attach the round 8-pin mini-connector to the modem port on the back of 
your Macintosh.

The modem port is a serial port, meaning that it transmits computer 
information serially.

3. Attach the round 4-pin mini-connector to one of the Apple Desktop Bus 
(ADB) ports.

The ADB port provides power to the densitometer.

Alternatively, use the optional AC adapter (available from X-Rite) to 
provide power. This is the configuration used with a PowerBook. 

4. If you use the optional AC adapter, plug the small connector on the 
adapter cable into the side of the X-Rite DTP 32 and plug the adapter into 
a wall outlet.

To calibrate the X-Rite DTP 32, use the Auto-Cal strip that came with the 
densitometer.
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To connect the X-Rite DTP 32 to a PowerBook:    

1. Turn the PowerBook off.

2. Connect the network cable to the PowerBook’s EtherTalk port.

3. Plug the square end of the densitometer interface cable into the I/O port 
on the side of the X-Rite DTP 32.

4. Attach the round 8-pin mini-connector to the serial port on the 
PowerBook.

5. If the densitometer display indicates that densitometer battery power is 
low, use the external AC adapter for the densitometer.

Note: Do not connect the densitometer to the PowerBook ADB port.

6. Configure the densitometer to factory defaults and save the settings. See 
the manual supplied with the densitometer for details.

Factory default settings for the X-Rite DTP 32 are:

7. Turn on the PowerBook.

8. In the PowerBook Setup Control Panel, select Normal for Modem 
Controls.

9. Calibrate the densitometer, as described below.

To calibrate the X-Rite DTP 32:    

1. On the X-Rite DTP 32, simultaneously press the two buttons marked 
MENU. The words MAIN MENU appear on the display.

2. Press the p1 key until p2 appears.

3. Press the cal key. CALIBRATION appears in the display.

4. Press the den key. CALIBRATING TRANSMISSION is displayed, 
followed by the words INSERT CAL STRIP.

5. Position the strip guide at 5.

6. Insert the arrow end of the Auto-Cal strip into the entrance of the X-Rite 
DTP 32 until the roller starts pulling the strip.

READING appears momentarily, followed by the density values and 
CALIBRATION OK. If UNRECOGNIZABLE STRIP appears, try cleaning 
the strip; for information, see your X-Rite DTP 32 operating instructions.

You are now ready to calibrate your printer. For details, see “Standard 
Calibration Procedure” on page A–4.

Page 1 LANG (ENG) TONE (loud) TYPE (ser)

Page 2 BAUD (9600) HAND (xon) AXMT (on)

Page 3 DPT (on) SEP (spc) DLIM (crlf)

Page 4 DEF (off) X10 (off) DAP (off)

Page 5 M/M (max) LOCK (off)
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Setting Up the X-Rite 404 or X-Rite 408
When you first unpack the X-Rite 404 or X-Rite 408, the shoe, or bottom 
plate, is locked to the main unit.

To unlock the shoe:    

1. Turn the unit upside down.

2. Hold the shoe against the unit.

3. Slide the black switch on the bottom of the unit toward the back of the unit.

4. Slowly release the shoe. 

Before you can use your densitometer, you need to charge the batteries 
using the AC adapter. The unit should be charged before use; however, 
it can be operated while the batteries are being charged.

To charge the battery:    

1. Confirm that the battery charger is intended for the voltage you are using. 
The charger is available in 115V and 230V models.

2. Plug the small connector on the adapter cable into the back of the X-Rite 
404 or X-Rite 408.

3. Plug the AC adapter into a wall outlet.

The X-Rite 404 or 408 batteries should be fully charged in 14 hours.

Now you are ready to turn on the X-Rite 404 or X-Rite 408 and adjust the 
display.

To prepare the X-Rite 404 or X-Rite 408 for use:    

1. Your X-Rite 404 or X-Rite 408 automatically turns itself on when a 
measurement is taken or a key is pressed.

2. Press a key on the control panel (on the top of the unit) to activate the 
display.

3. Turn the angle adjustment wheel (on the right side of the unit) to adjust 
the display so it can be viewed from your line of sight.

Before using the X-Rite 404 or 408, you need to confirm that it is properly 
calibrated. If it is not, you will need to calibrate it.

To check the X-Rite 404 or X-Rite 408 calibration, measure the patches 
on the Color Reference card that came with the X-Rite 404 or 408. Then 
compare the measurements with the reference values provided on the 
envelope in which the reference card is stored.

To see if the X-Rite 404 or X-Rite 408 needs calibration:    

1. Set the Reference status to REF OFF:

a. Press the zero key once to display the Reference status. You see 
either REF OFF or REF ON.

b. If you see REF OFF, proceed to step 2.

c. If you see REF ON, press the zero key again. REF OFF is displayed.
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2. Press the down arrow key on the X-Rite 404 or 408 to change the X-Rite 
to measurement mode. The last measurement taken with the X-Rite 404 
or 408 is displayed.

3. Measure the white patch on the Color Reference card that came with your 
X-Rite 404 or X-Rite 408.

a. Place the shoe, or bottom plate, of the densitometer on the Color 
Reference card.

b. Center the target window over the white patch on the Color Reference 
card.

c. Press down on the unit and keep it pressed down until the 
measurement appears on the display.

4. Compare the measurement with the reference value provided on the 
envelope in which the Color Reference card is stored.

Status T values for white, cyan, magenta, and yellow are in the row 
preceded by the letter “T” on the Color Reference card.

5. Measure the remaining five patches in numerical order.

Check each measurement against the color reference values provided by 
the X-Rite.

When you measure the patches, make certain that you are not 
inadvertently measuring a portion of the black circle around the color 
patches.

If any one measurement varies from the reference value by plus or minus 
0.02, your densitometer needs calibration. Follow the steps in the next 
section, “To calibrate the X-Rite 404 or X-Rite 408”.

If all of your measurements are within plus or minus 0.02 of the 
appropriate color reference values, skip the next section and go directly 
to “To zero the X-Rite 404 or X-Rite 408” on page A–31

To calibrate the X-Rite 404 or X-Rite 408:    

1. Press the down arrow key and the Color key together. The display shows 
N cal T Y.

2. Press the Zero key to indicate Yes. You see N Qcal Y, asking if you 
want to use the Quick calibration.

3. Press the down arrow key to indicate that you want the extended 
calibration. The words SET LO are momentarily displayed. Then the 
current settings for the first value are displayed.

4. If necessary, change the value displayed on the X-Rite to correspond to 
the value on the Color Reference card.

The correct value for visual (white) is provided at the far left of the top row 
in the list of reference values. If the value displayed on your X-Rite is 
different, you need to change it to match the value provided.

To change the value displayed on the X-Rite, press the Zero key and 
down arrow, or the Zero key and up arrow until you see the correct value.

5. Set the reference values for cyan, magenta, and yellow values (of the 
white patch).
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Press the Color key to advance through the component colors.

You will find the correct values in the top row on the list of reference 
values. If any value displayed on your X-Rite is different, you need to 
change it to match the value provided.

6. Press the Color key when you finish setting the yellow value.

The words SET HI appear momentarily, followed by the X-Rite’s current 
setting for visual black.

7. If necessary, set the value for Visual (black).

Compare the value displayed on your X-Rite with the reference value for 
visual (black) and adjust your densitometer accordingly.

8. Enter the reference values for cyan, magenta, and yellow.

Press the Color key to advance through the component colors.

If necessary, change the values displayed on your X-Rite to correspond 
with the Color Reference card values.

9. Press the Color key after you set the yellow values.The display shows 
READ WHT.

10. Measure the white patch on the Color Reference card that came with your 
X-Rite 404 or 408.

Confirm that the measurement is the same as the reference value. If the 
measurement is off by plus or minus 0.02, repeat the calibration 
procedure. When you release the unit, READ BLK is displayed.

11. Measure the black, cyan, magenta, and yellow patches in the same way. 
All the measured values should match the corresponding Color 
Reference card values.

After you have confirmed that the yellow measurement matches the 
reference value, you are ready to zero the X-Rite. You should do this 
before you start calibrating your printer. Zero the X-Rite on the white area 
of the printer paper on which the color patches are printed.

To zero the X-Rite 404 or X-Rite 408:    

1. Set the Reference status to REF ON.

a. Press the Zero key once to display the Reference status. You see 
either REF ON or REF OFF.

b. If you see REF ON, proceed to step 2.

c. IF you see REF OFF, press the Zero key once again. You see REF 
ON.

2. Press the down arrow key to change the X-Rite 404 or 408 to 
measurement mode.

3. Press the Color key until you see AUTO.

4. Position the aperture of your densitometer over the white area of the 
printer paper on which the color patches are printed.
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To increase accuracy and maintain consistency during the measurement, 
place a sheet of black paper under the page on which the color patches 
are printed.

5. Hold the densitometer down and then press the Zero key. ALL? Z is 
displayed on the display.

For additional information on zeroing, see the instruction manual that came 
with your densitometer.

To connect the X-Rite 404 or X-Rite 408:    

To connect the densitometer to your Macintosh, you will need to obtain a 
data interface cable from X-Rite (part number 418-79). The cable should 
have a square, modular phone connector on one end and an 8-pin mini-
round connector on the other end.
1. Plug the square end of the interface cable (like a modular phone plug) into 

the I/O port on the back of your X-Rite 404 or 408 densitometer.

2. Attach the end with the round 8-pin mini-connector to the modem port on 
the back panel of your Macintosh or the serial port on the PowerBook.

The modem port on your Macintosh is marked with an icon that looks like 
a telephone handset.

Your X-Rite 404 or 408 has been calibrated, zeroed, and connected to your 
Macintosh. You are now ready to print and measure patches so you can 
download a calibration to your printer. See “Standard Calibration Procedure” 
on page A–4 for details.

Setting Up the Gretag D 186P
If your Gretag needs to be charged, charge it for at least 14 hours before 
using it. The procedure follows here.

To charge the battery:    

1. Confirm that the battery charger is intended for the voltage you are using.

2. Plug the small connector on the adapter cable into the back of your 
Gretag.

3. Plug the AC adapter into a wall outlet. 

The Gretag batteries should be fully charged in 14 hours.

Now you are ready to turn on the Gretag and adjust the display. Your Gretag 
turns itself on automatically when a measurement is taken or a key is 
pressed.
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To turn on the Gretag D 186P:    

Press a key on the control panel to activate the display.

Before using your Gretag, you need to confirm that it is properly calibrated. If 
it is not, you need to calibrate it.

To check your Gretag’s calibration, first zero the densitometer. Then 
measure the patches on the calibration cards that came with it and compare 
the measurements with the reference values provided on the cards.

To see if the Gretag D 186P needs calibration:    

1. On your Gretag densitometer, press the F key until you set the function 
to “Meas.” (measurement), the mode to Density, and the filter selection to 
Auto.

2. Zero your densitometer. Measure the white patch (zero) on the yellow 
calibration card that came with your Gretag.

a. Place the densitometer on the calibration card.

b. Center the measuring aperture over the Zero patch on the yellow 
calibration card.

c. Press the Zero key while pressing down on the rear of the unit until a 
measurement appears on the display.

You see Z 0.00 briefly on the display. The “Z” stands for zero and 
confirms that the procedure was performed correctly.

3. Measure the color patches on each of the four calibration cards and 
compare the results with the reference values printed on the cards.

If any one measurement varies by plus or minus 0.01, your densitometer 
needs calibration. If so, follow the steps in the next section, “To calibrate 
the Gretag D 186P”.

If all of your measurements are within plus or minus 0.01 of the reference 
values, skip the next section and go directly to “TO ZERO the GRETAG 
DENSITOMETER”.

To calibrate your Gretag, you switch the function to calibration, measure 
the four color patches, and change each result so it matches the 
corresponding reference value provided on the calibration cards.

To calibrate the Gretag D 186P:    

1. Press the red button on the rear of the unit at the same time as you press 
the F key. The function changes to “Cal.” 

2. Measure the Zero patch on the yellow calibration card. The display shows 
0.00 and sequence II.

3. Measure the yellow patch on the appropriate card and compare the value 
displayed on your Gretag with the reference value on the calibration card.
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4. If necessary, increase or decrease the displayed value until it matches 
the reference value on the card.

a. To decrease the value, press the down arrow Mode key.

b. To increase the value, press the up arrow Mode key.

5. Continue in this way until you have measured each color and adjusted the 
display value to the actual density.

6. When all colors are calibrated, press the F key. The densitometer 
displays Density and Meas.

You are now ready to use the Calibrator to print patches. See “Standard 
Calibration Procedure” on page A–4 for details.

Note: After printing the calibration patches from your printer and before 
measuring them, zero your densitometer on a white area of your 
printer paper.

To zero the Gretag D 186P:    

1. On your Gretag densitometer, press the F key until you set the function 
to “Meas.” (measurement), the mode to Density, and the filter selection to 
Auto.

2. Position the aperture of your densitometer over a white area of the printer 
paper on which the color patches are printed.

To increase accuracy and maintain consistency during measurement, 
place a sheet of black paper under the page on which the color patches 
are printed.

3. Press the Zero key and, at the same time, press the rear of the 
densitometer downward.

You see Z (zero) briefly on the display and 0.00, which indicates that the 
measurement was performed correctly. 

If you need additional information on zeroing, see the instruction manual 
that came with your densitometer.

You are ready to start measuring the calibration patches. You will need to 
obtain a data interface cable from Gretag. The cable should have an 8-pin, 
circular mini-connector on one end and an 8-pin, half-inch circular connector 
on the other end.

To connect the Gretag D 186P:    

1. Attach the half-inch circular connector (the larger connector) to the I/O 
port on the back of your Gretag densitometer.

2. Plug the other end of the interface cable into the modem port on the back 
panel of your Macintosh or the serial port on the PowerBook.

The modem port on your computer is marked with an icon that looks like 
a telephone handset.

The Gretag has been calibrated, zeroed, and connected to your Macintosh, 
and you have printed the calibration patches. You are now ready to measure 
the patches so you can download a calibration to your printer.
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Troubleshooting
This section presents common problems you may encounter when using 
your Calibrator utility, and it describes steps you can take that should correct 
these problems. 

Common Problems
These are some of the common problems experienced in calibration.

• After calibration, the magenta (or another toner color) density is too high

Choose Target/Measured Curves from the View menu to open the Edit 
Target Curves dialog box. Click on All Same to deselect it, then click on 
Magenta (or the color whose density is too high), and move the Max 
Density slider to the left. Then download the Custom Calibration curve. For 
details, see page A–24 and page A–26.

• After calibration, the image is too dark all over.

Open the Edit Target Curves dialog box. With All Same selected, move the 
Max Density slider to the left. Then download the Custom calibration curve. 
For details, see page A–24.

• You see the message, “Near-zero values expected for this row.”

Make sure you have properly zeroed your densitometer and then re-
measure. See “Setting Up and Calibrating Your Densitometer” on page A–
27.

If upon visual inspection, there is toner in the row of patches, you may need 
to have your printer served. If the problem persists, contact your 
densitometer manufacturer.

• A measurement is out of range.

– If you are entering measurements automatically, check your 
densitometer setup. Make sure you have selected “Densitometer” as the 
input source.

– If you have entered measurements manually, check to see if you have 
misplaced the decimal or transposed two digits.

– Make sure you have properly zeroed your densitometer.

• After calibration, dark patches on the test page are too saturated or too 
weak.

– If the colors are too weak, check the toner level.

– Check to see if your densitometer needs calibration.

– Make sure that you are using the correct profile.

– Check your printer’s density control panel settings.

– Remove the calibration from your printer. If the problem persists, your 
printer needs service.

• Density measurements are not being entered into the Measurements 
window.
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The baud rate entered in the Preferences dialog box may not match the 
baud rate for which the densitometer is set.

– Open the Preferences dialog box and confirm the communications 
setting. Make sure you have selected Densitometer as the input source.

– Check your densitometer setup, including the cable connections and 
densitometer mode.

• Nothing happens when you press down on the densitometer unit.

Your densitometer may have locked up. The solution is to clear the unit’s 
memory.

a. Disconnect the densitometer from its power supply.

b. Remove the batteries from the unit for a minute.

c. Calibrate and zero your densitometer before continuing.

• The DTP 32 densitometer displays “Transmitting Data,” but no data is 
transmitted. The densitometer appears stuck or frozen.

A data transmission error may have occurred.

a. If there are any values in the Measurements window, choose Clear 
Measurements from the Edit menu.

b. On the X-Rite DTP32, press the two keys marked MENU.

c. On the densitometer, press “pap”. “FPCStrp” is displayed.

d. Re-measure the patches.

• You need to return to factory default settings for any reason.

Quit the Calibrator, delete the FPC Preferences file from the Preferences 
folder in your System Folder, and start the Calibrator again.
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Abbreviations and Acronyms
ac alternating current

ADB Apple Desktop Bus

AIX Advanced Interactive Executive

ANSI American National Standards 
Institute

APC automatic photoemission control

C centigrade

CCITT Comité Consultatif International 
Télégraphique et Téléphonique

CCW channel command word

CD-ROM compact disk read-only memory

CE customer engineer

CPU central processing unit

CRC cyclical redundancy check

CRD color-rendering dictionary

CRT cathode-ray tube

CRU customer replaceable unit

dB decibel

dc direct current

DEV developer

dpi dots per inch

DRAM dynamic random access memory

DTP desktop publishing

EBCDIC extended binary-coded decimal 
interchange code

EC engineering change

EEPROM electronically erasable 
programmable read-only memory

EPROM erasable programmable read-only 
memory

ERP error recovery procedure

F Fahrenheit

FIFO first in first out

FM fan

FRU field-replaceable unit

 GDI graphics device interface

GND ground

GUI graphical user interface

H fuser heater

HVT high-voltage transformer

Hz herz

IC integrated circuit

I/O input/output

ipm impressions per minute

IPX Internet package exchange

IPX/SPX Internet packet exchange/sequenced 
packet exchange

ISO International Organization for 
Standardization

JIS Japanese Industry Standard

K kilo

KB kilobyte 

kg kilogram

laser light amplification by stimulated 
emission of radiation

LED light-emitting diode

LGL legal

lpi lines per inch

LPR local printer

LPT local port

MB megabyte 

mm millimeter

OHP overhead projection

OPC organic photoconductor

PC personal computer, photoconductor

PCB printed circuit board

PDF printer description file

PEL pixel

pixel picture element

POST power-on self-test

ppi pixels per inch

ppm pages per minute

RAM random access memory

RH relative humidity

RIP raster-image processor

RISC reduced instruction set computer

ROM read-only memory

SCSI small computer system interface
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SEF short edge feed

SIMM single inline memory module

spool simultaneous peripheral operations 
online

TCP/IP transmission control protocol/Internet 
protocol

TIFF tagged image file format

TP test point

V ac volts alternating current

V dc volts direct current
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Glossary
The following terms are defined as they are used in 
this publication. If you do not find the term you 
need, see the IBM Dictionary of Computing, New 
York, McGraw-Hill, 1994, and the IBM Dictionary of 
Printing, G544-3973.

The following cross-references are used in this 
glossary:

• Deprecated term for refers to a term that should 
not be used and lists the preferred term.

• Contrast with refers to a term that has an opposite 
meaning.

• See refers to a preferred term with the same 
meaning.

• See also refers to related terms.

Numerics

60,000-Page Usage Kit.   An air filter, ozone filter, 
transfer drum cleaning assembly, separation 
corona unit, and fuser to be installed in the printer 
by the operator after 60,000 prints. The 60,000-
page Usage Kit is available for the low-voltage (110 
V) and high-voltage (220 V) models.

A

actuator.   A device that initiates mechanical 
motion.

administrator.   See network administrator.

Adobe Acrobat Reader.    A program used to view 
the online documentation supplied with the printer.

Adobe Illustrator.   A professional illustration 
program for Macintosh computers and PCs that 
produces object-oriented images and prints them 
on PostScript laser printers.

air filter holder.   The area on the back of the 
printer that holds the printer’s air filter and gives you 
access to the printer’s ozone filter.

air ventilation system.   Horizontal slots on the 
back and left sides of the printer that prevent 

overheating and ensure that the printer works 
reliably.

AIX operating system.   IBM’s version of the UNIX 
operating system.

aliasing.   Unwanted effects such as Moiré 
patterns in an image. These patterns, called 
artifacts, look like two sets of parallel lines or two 
halftone screens superimposed. 

anti-aliasing.   The rendering of hard-edged 
objects so that they blend smoothly into the 
background. 

Apple Desktop Bus (ADB).   An interface 
standard for connecting a keyboard, mouse, 
trackball, or other input devices to an Apple 
Computer Macintosh SE, Macintosh II, or 
Macintosh IIGS computer.

AppleShare.   A network operating system 
developed by Apple Computer, Inc., that transforms 
a Macintosh computer into a file server for an 
AppleTalk network. See also AppleTalk.

AppleTalk.   A local area network (LAN) standard 
developed by Apple Computer, Inc. AppleTalk can 
link as many as 32 Macintosh computers, PCs, and 
peripherals such as laser printers.

auxiliary tray.   A paper feeder tray that holds 
either 100 sheets of plain paper (at 80 g/m2) or 20 
transparencies.

B

banding.   Visible steps between shades in a 
gradient. See also gradient.

batch printing.   The queueing of one or more 
documents to print in a separate job as a 
background process.

bias.   An electrical charge applied to a component 
of the printer such as the toner cartridge, transfer 
drum, discharge roller, attraction roller, or 
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separation corona unit. The bias can be ac or dc or 
a combination of both.

bindery context.   An option that allows you to use 
the printer with Novell NetWare release 4.x. Bindery 
context is explained in the Novell NetWare 
documentation.

bindery emulation mode.   See bindery context.

bitmap.   An image formed by a rectangular grid of 
pixels. Each pixel in the grid is assigned a value to 
denote its color. 1-bit images are black and white 
only, 8-bit images are 256 colors or grays, and 24-
bit images are full color. CMYK images are 32-bit 
per pixel to encode 256 levels in each of 4 
channels. Also called raster image. See also pixel, 
raster, raster image.

bond.   A paper formulated with at least 80% wood 
pulp. Bond is the best paper to use in the printer.

burr.   A thin ridge or area of roughness produced 
in cutting or shaping metal.

C

calibration.   The process of ensuring that a device 
works consistently according to a set of 
specifications.

Calibrator utility.   See IBM Color Calibrator.

cam.    A rotating or sliding piece in a mechanical 
linkage used especially in transforming rotary 
motion to linear motion and vice versa.

cassette.   A deprecated term for tray 1 or tray 2 on 
the printer. See universal cassette.

caution notice.   A notice that calls attention to a 
condition that is potentially dangerous to people.

Chooser.   A Macintosh desktop accessory that 
governs the selection of printer drivers.

cleaning connector cover.   The electrical 
connector cover for the transfer drum cleaning 
brush.

client.   In a local area network (LAN), a 
workstation with processing capabilities such as a 
PC that can request information or applications 
from the network’s file server.

CMYK.   Cyan, magenta, yellow, and black, the four 
basic colors used in offset printing, as opposed to 
red, green, and blue (RGB), the three basic colors 
of light. 

CMYK_REF.PS file.   A file consisting of PostScript 
color pages that enable you to specify percentages 
of cyan, magenta, yellow, and black and get an 
exact rendering of those percentages in your 
document.   

coated paper.   Paper with a surface coating 
applied to produce smoothness.

color lights.   The lights on the printer’s density 
control panel that turn green when you choose the 
color next to each light to change the density of that 
color.

color pages.   Pages you can print to see the red, 
green, and blue (RGB); cyan, magenta, yellow, and 
black (CMYK); and PANTONE colors available on 
the printer.

color reference pages.   See color pages.

color-rendering dictionary (CRD).   A feature on 
PostScript level-2 color printers that gives improved 
matching between the monitor and printed output. 
Color-rendering dictionaries are used by the 
printer’s PostScript interpreter when converting 
RGB data sent to the printer to CMYK data used by 
the print processor. See also rendering style.

color-rendering style.   See rendering style.

COLOR SELECT push button.   A button on the 
printer’s density control panel that you press to 
choose a color whose density you want to change.

configuration page.   A page you can print to see 
the printer’s current server and device 
configuration. 

connector.   A means of establishing electrical 
flow.

consumable supplies.   A deprecated term for 
supplies. See supplies.

container.   An entity in a computer such as a 
storage area that holds other entities such as files 
or programs.
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control unit.   The printed circuit board (PCB) that 
supplies the printer’s connection path to the 
customer’s network. The control unit also gives 
commands to the print engine dc controller PCB to 
manipulate the motors, solenoids, and actuators 
during a print cycle. See also actuator, solenoid.

controller.   See control unit.

corona.   See separation corona.

cursor-position push buttons.   The left and right 
arrow buttons that you press to enter text and 
numbers for some menu settings (such as a 
password or a numeric setting).

customer CD-ROM.   A CD-ROM holding the user 
software for the printer, including the IBM Color 
Calibrator, Downloader, and Spooler utilities and 
the PostScript color pages.

customer engineer (CE).   An IBM representative 
who services IBM products at the customer’s site.

cutout.   An area of the printer that is shaped (“cut 
out”) to hold a connecting mechanism such as a tab 
on another part of the printer.

D

daemon.   A software program that runs 
unattended.

danger notice.   A notice used to call attention to a 
condition that is potentially deadly or extremely 
dangerous to people.

dedicated file server.   In a local area network 
(LAN), a file server whose function is to provide 
services to the users of the network and to run the 
network operating system.

densitometer.   An instrument that measures 
density according to a specified standard. Status T 
and XRite densitometers are two such color 
calibration devices.

density.   A precise measurement of the light 
energy transmitted or reflected by a surface in the 
presence of a standard light source.

density control panel.   The set of controls on the 
back of the printer that enable you to adjust the 

density of any of the four colors: magenta, cyan, 
yellow, or black.

density detection sensor.   A device on the printer 
containing a light source and a sensor. The density 
detection sensor measures the specific density of 
toner applied to known surface to regulate the 
quantity of toner applied during the print process. 
The reflectance of light on toner varies with the 
density and color of that toner. Thus the density 
detection sensor emits a specific amount of light on 
a toner patch and estimates the density of the toner 
patch by the amount of light reflected from the toner 
patch.

density gauge.   A row of indicators on the printer’s 
density control panel. When you make a test print, 
the indicator on the gauge goes on to confirm the 
test pattern you chose for the test print: solid colors, 
solid white, gradient, horizontal lines, vertical lines, 
or grid pattern. See also gradient.

dequeue.   To remove items from a queue. 
Contrast with queue.

desktop.   In a graphical user interface (GUI), a 
computer representation of day-to-day work; for 
example, a desktop with open file folders.

desktop publishing (DTP).   The use of a PC or 
other platform as an inexpensive production system 
for generating typeset-quality text and graphics.

dialog box.   In a graphical user interface (GUI), an 
on-screen message box that interacts with the user 
to convey or request information. See also 
graphical user interface (GUI).

diagnostic mode.   A mode of operation in which 
the printer can check itself in case of a problem. 

Direct queue.   A storage area for the printer that 
supplies a direct connection to the printer. When 
you submit a job to the Direct queue, the printer 
accepts the job when it is ready to print the job. 
Jobs in the Direct queue are not stored on the 
printer’s hard disk and are not spooled. See also 
Hold queue, Print Queue, Printed queue, spooling.

discharging.   The application of ac bias by the 
printer’s discharge roller to remove any charges 
remaining on the transfer drum surface after 
separation of the paper.
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diskette.   A thin, flexible, magnetic disk enclosed 
in a protective jacket.

display panel.   The area on the printer where 
information such as error messages is displayed. 

dots per inch (dpi).   The number of dots that can 
be printed per inch by a laser printer. Each dot is 
either on or off, printed or not printed. See also 
pixels per inch (ppi).

Downloader utility.   See IBM Color Downloader.

driver.   A disk file that holds information needed to 
operate a peripheral such as a computer monitor or 
printer.

duplex printing.   Printing or reproducing a 
document on both sides of the page so that the 
verso (left) and recto (right) pages face each other 
after the document is bound.

E

electrostatic latent image.   The image formed on 
the photoconductor drum surface by a negative 
charge where the laser beam has not irradiated.

encapsulated PostScript.   Any file containing the 
PostScript page-description language that 
conforms to Adobe 2.0 document-structuring 
conventions and the Adobe conventions that allow 
the file to be included by other applications. 

end user.   A person, device, program, or computer 
system that uses a computer network for data 
processing and information exchange.

enqueue.   To put items in a queue. Contrast with 
dequeue.

error log.   A file in the printer that stores error 
messages for later access. 

error message.   An operator message that you 
see on the display panel and that causes the 
Attention light to flash. Error messages are listed in 
the Operator’s Guide.

\ETC\HOSTS file.   A file that allows you correlate 
TCP/IP addresses with the names of the devices 
(such as printers, workstations, and PCs) those 
addresses represent. See also TCP/IP.

Ethernet.   A 10-megabit, baseband local area 
network (LAN) that allows multiple stations to 
access the transmission medium at will without 
previous coordination, avoids contention by using 
carrier sense and deference, and resolves 
contention by using collision detection and 
transmission.

F

feeder.   See paper feeder.

feeder access door.   A door on the upper right 
side of the printer that gives you access to the 
paper feeder area to remove jammed paper, do 
maintenance tasks, or replace the transfer drum 
cleaning unit.

feeder access door on tray 2 paper feeder.   A 
door on the optional tray 2 paper feeder that gives 
you access to the tray 2 paper feeder area to 
remove jammed paper.

file server.   In a local area network, a PC that 
provides access to files for all the workstations in 
the network.

folder.   A file used to store documents 
electronically.

font.   A family of characters of a given size and 
style.

format.   The size, style, kind of page, margins, 
printing needs, and other aspects of a printed page.

frame.   The bits in a packet that are assigned to 
control and synchronize data transfer over a 
network. See also packet.

fuser.   The part of the printer that uses heat and 
pressure to embed toner into the fibers of paper 
and make a permanent bond.

fuser access door.   A door on the upper right side 
of the printer that gives you access to the paper 
output area to remove jammed paper and replace 
the fuser.

fuser access strap.   A strap on the fuser access 
door that is attached to the upper locking tab on the 
printer’s frame to keep the door from dropping down 
when you open it.
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fuser cleaning belt.   Part of the mechanism on 
the fuser cleaning unit that cleans the fuser upper 
roller.

fuser jam-release lever.   A lever to the right of the 
paper guide inside the printer that is used to pump 
fuser oil from the oil bottle and to free jammed 
paper in the fuser area. 

fuser nip width check.   A procedure done by the 
customer engineer (CE) to get a specific 
measurement that shows if the right fuser roller 
pressure is supplied during the fusing process.

fuser oil.   Oil that helps the release of paper from 
fuser rollers.

fuser oil bottle.   A bottle inside the front door of 
the printer that holds the fuser oil. See also fuser oil.

fuser rollers.   The hardware devices used to 
transfer the heat and pressure needed for the toned 
image on the paper during the fusing process.

fuser slide plate.   A metal plate in the printer onto 
which you slide a fuser when installing it in the 
printer.

G

gateway address.   The computer location of a 
device that connects two dissimilar local area 
networks (LANs) or that connects a LAN to a wide 
area network (WAN), minicomputer, or mainframe.

gradient.   A test print that shows an image with 
multiple stripes that begin in full color on one end 
and gradually reduce the color content to nearly 
zero so that only the white paper is visible on the 
other end.

graphical user interface (GUI).   A design for the 
part of a software program that interacts with the 
user and takes advantage of the bitmapped 
graphics displays of PCs. A GUI uses pull-down 
menus, dialog boxes, icons, and a variety of visually 
attractive on-screen typefaces. See also icon.

graphics device interface (GDI).   The graphics 
and display technology used on computers running 
the Windows operating system. GDI is the 
equivalent of the PostScript language that sends 
words and pictures to the printer.

grayscale.   A series of shades from white to black.

H

halftone.   A printing method that simulates 
continuous-tone shading using dots of varying sizes 
laid out on a regular grid. Larger dots simulate 
darker tones and vice versa. 

help map.    A document you can print to guide you 
to the printer’s operator panel, push buttons, and 
panel lights. The help map lists the menus and tells 
you how to access each menu.

Hold queue.   A job storage area for the printer. 
When you submit a job to the Hold queue, the 
printer gets the job immediately and stores it on the 
hard disk. Jobs in the Hold queue do not print or 
clear from the printer until someone uses the IBM 
Color Spooler to move them to the Print queue or to 
discard them from the printer’s hard disk. See also 
Direct queue, Print queue, Printed queue, spooling.

I

IBM Color Calibrator.   A software utility program 
that enables you to keep the printer’s colors at a 
consistent performance level across time.

IBM Color Downloader.   A software utility 
program that enables you to print PostScript and 
encapsulated PostScript files directly to the printer 
without using the application in which the files were 
created. Printing with the Downloader is faster than 
printing from applications and also enables you to 
manage the printer fonts installed on the printer.

IBM Color Spooler.   A software utility program 
that enables you to view the order and priority of 
print jobs, customize printer settings for jobs, delete 
jobs, and move jobs between queues. You can also 
use the Calibrator to see a list of the jobs the printer 
has finished.

icon.   In a graphical user interface (GUI), an on-
screen symbol that represents a function or 
resource of the software program or computer 
hardware. See also graphical user interface (GUI).

ISO sizes.   A set of paper sizes used in data 
processing and chosen from paper sizes that are 
standardized by the International Organization for 
Standardization (ISO).
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Internet.   A wide area network (WAN) connecting 
thousands of disparate networks in business, 
technology, education, government, entertainment, 
and research. The Internet uses the TCP/IP as the 
standard for transmitting information. See also 
TCP/IP.

Internet address.   The numbering system used in 
TCP/IP internetwork communications to specify a 
network or host computer on a network. See also 
TCP/IP.

J

jam.   See paper jam.

job.   The result of a command to desktop 
publishing software to print a document. The 
PostScript language allows for single PostScript 
files holding multiple jobs and single jobs spread 
over multiple files. 

job log.   A list of the printer’s last 40 jobs. The job 
log includes information such as user name, 
document name, time and date printed, and 
number of pages printed for each job.

jumper.   A short wire used to close a break or cut 
out part of a circuit.

K

kilobyte (KB).   1024 bytes.

L

landscape orientation.   Text and images that are 
printed parallel to the longer side of the paper. 
Contrast with portrait orientation.

laser (light amplification by stimulated emission 
of radiation).    A device that emits a beam of 
coherent light.

laser diode.   A laser that uses a forward-biased 
semiconductor junction as the active medium.

laser interlock.   The mechanical blockage of the 
laser beam when the printer’s front door is open. 
The front door panel has a plastic protrusion that 
fits into an opening in the printer and mechanically 
forces the interlock open.

latent toned image.   See electrostatic latent 
image.   

lens.   A piece of transparent material such as 
glass that has two opposite regular surfaces, either 
both curved or one curved and the other flat. A lens 
is used either singly or combined in an optical 
instrument for forming an image by focusing rays of 
light.

local area network (LAN).   A network of 
workstations within a limited area connected by 
high-performance cables so that users can 
exchange information, share peripherals such as 
printers, and have access to the resources of a 
secondary storage unit called a file server. See also 
file server.

M

megabyte (MB).   1,024,000 bytes.

menu-scrolling push buttons.   The up and 
arrow buttons that you press to scroll through the 
menus on the printer’s display panel.

microcode.   The microprogramming stored on a 
microcode diskette. Microcode is used by the 
controller to manage the printer and its functions.

Microsoft Excel   A graphics-oriented 
spreadsheet program developed by Microsoft 
Corporation for IBM PC-compatible computers and 
Macintosh computers.

monitor style.   A rendering style that produces 
color similar to the color on a computer monitor. 
See also photographic style, presentation style, and 
solid-color style.

multifeed.   A condition in which more than one 
sheet of paper at a time is inserted into the printer’s 
feed roller. A multifeed prevention mechanism on 
the printer separates the extra sheets to correct the 
condition.

N

named color.   A color that is defined according to 
a custom color system. For example, PANTONE 
107C is a named color.
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native file format.   The default file format an 
application uses to store data on disk.

NET_WSCK.INI file.   A file used by the utilities 
running over the TCP/IP and IPX/SPX protocols to 
find printers on the network.

network administrator.   In a local area network 
(LAN), the person responsible for maintaining the 
network and helping its users.

Novell NetWare.   A network operating system for 
80286- and 80386-based DOS computers.

NuBus.   Apple Computer’s hardware standard for 
expansion cards. 

O

offset.   An unintentional transfer of ink such as 
from a freshly printed page. 

operating environment.   The physical 
environment of the printer; for example, 
temperature, humidity, layout, and power source.

operator panel.   The area on the front of the 
printer with lights, push buttons, and a display panel 
that help you use the printer.

optical character recognition (OCR).   The 
conversion of scanned text to editable ASCII 
characters using optical recognition software.

optional tray 2 paper feeder.   A tray for feeding 
paper to the printer that comes with a universal 
cassette and two locking pins to fasten it to the 
printer. See also universal cassette.

P

packet.   A block of data bytes that contains a 
header, data, and a trailer. The format of a packet 
depends on the network protocol used to transfer 
the data. See also frame.

PageMaker.   A popular page layout program for 
Windows and Macintosh computers typically used 
for generating documents such as newsletters, 
brochures, reports, and books.

paper-amount indicator.   A blue bar on the front 
of the printer below the front door. When the blue 

bar has completely disappeared, it is time to add 
paper to the tray.

paper feeder.   The mechanism that inserts paper 
into the printer.

paper guides.   Guides on the auxiliary tray that 
adjust the width of the tray to fit the paper, and 
guides on the paper feeder trays that adjust both 
the width and the length of the tray to fit the paper.

paper jam.   A condition in which paper wedged 
into the paper path prevents the printer from 
working.

paper path.   The entire route that paper travels 
through the printer during processing. 

paper-size indicator.   A bar on the front of the 
printer that tells you the size of the paper in the 
printer.

PANTONE Matching System.   A standard color-
selection system for professional color printing that 
works with high-end illustration programs like 
Adobe Illustrator and PageMaker 4.0.

PANTONEC.PS.   A PANTONE coded file that 
allows you to choose a named PANTONE color for 
a document rather than CMYK percentages. See 
also CMYK_REF.PS file, named color, PANTONE 
Matching System.

PANTONEU.PS.   A PANTONE uncoded file that 
allows you to choose a named PANTONE color for 
a document rather than CMYK percentages. See 
also CMYK_REF.PS file, named color, PANTONE 
Matching System.

parallel-attached.   See parallel printer.

parallel port.   A port that supplies the 
synchronous, high-speed flow of data along parallel 
lines to peripheral devices, especially parallel 
printers. See also parallel printer.

parallel printer.   A printer designed to be 
connected to a computer’s parallel port. See also 
parallel port.

pel.   See pixel.

photoconductor drum.   A light-sensitive surface 
that when electrically charged can be discharged by 
the laser light beam. The remaining charged area 
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attracts applied toner particles from the toner 
cartridge and transfers the particles to the paper to 
produce a latent toned image. See also 
electrostatic latent image.

photoconductor drum cartridge.   A customer-
replaceable unit (CRU) that holds the 
photoconductor. See also photoconductor drum.

photoconductor drum cover.   A cover that holds 
the used toner bottle in place on the 
photoconductor drum cartridge.

photoconductor drum shield.   The orange cover 
installed on the photoconductor drum cartridge that 
protects the photoconductive surface from light 
when the cartridge is not installed in the printer. See 
also photoconductor drum cartridge.

photodiode.   A photoelectric semiconductor 
device for detecting and measuring radiant energy 
such as light.

photographic style.   A rendering style that 
preserves tonal relationships in images. 
Unprintable colors are mapped to printable colors in 
a way that keeps differences in lightness and 
slightly sacrifices color accuracy as necessary.

photosensitive drum.   A deprecated term for 
photoconductor drum. See photoconductor drum.

PICT.   A Macintosh graphics file format developed 
by Apple Computer. PICT files consist of separate 
graphics objects like lines, arcs, ovals, or 
rectangles that you can independently edit, size, 
move, or color.

pixel (pel).   (1) The smallest distinct element of a 
raster image or an image displayed on a monitor. 
(2) The elementary graphical cell that constitutes an 
image. (3) An element of a raster pattern or a point 
where a toned area on a photoconductor can 
appear. 

pixels per inch (ppi).   The number of pixels per 
linear inch. Unlike dots, which are bilevel entities, 
pixels can hold multiple levels of information. See 
also dots per inch, pixel.

point.   A unit of about 1/72 of an inch that is used 
to measure typefaces.

point size.    See point.

port.   An entry or exit boundary mechanism that 
controls and synchronizes the flow of data into and 
out of a processor from and to external devices 
such as printers and modems.

portrait orientation.   Text and images that are 
printed parallel to the wider side of the paper. 
Contrast with landscape orientation.

PostScript.   The page-description language 
developed by Adobe Systems that has become a 
standard for graphic design and layout software. 
PostScript files can hold both vector and raster 
data, and fonts are defined with PostScript coding. 
Many desktop publishing systems output PostScript 
data that is interpreted by a laser printer.

PostScript level 2.   The current version of 
PostScript language that is used to print and display 
pictures and text. PostScript level 2 includes many 
enhancements to older versions of PostScript, 
including improved color matching and the ability to 
control printer-specific features from applications.

Power Saver.   A mechanism on the printer that 
sets the amount of time the printer stays idle before 
changing to a lower power-consumption mode.   

power-on self-test (POST).   A series of electrical 
and mechanical tests made by the printer. If the 
tests reveal an electrical or mechanical problem, 
you see an error message on the display panel.

presentation style.   A rendering style that does 
not match printed colors to displayed colors 
precisely. Presentation rendering is used for bright 
saturated colors in illustrations and graphs.

print job.   See job.

print mode.   The working mode in which the 
printer gets information from the controlling 
computer system and produces printouts. Contrast 
with diagnostic mode and test mode.

print quality.   The quality of printouts in relation to 
existing standards and to printouts from earlier jobs.

Print queue.   A storage area for the printer that 
supplies a job storage, queueing, and spooling. 
When you submit a job to the Print queue, the 
printer gets the job immediately and stores it on the 
printer’s hard disk. Jobs in the Print queue print in 
the order the printer receives them. You can use 
the IBM Color Spooler to move jobs from the Print 
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queue to the Hold queue or to discard them. 
Finished jobs in the Print queue are automatically 
moved to the Printed queue if it is enabled. See 
also IBM Color Spooler.

Printed queue.   A storage area for the printer that 
moves a finished job from the Print queue to the 
Printed queue for temporary storage. You can then 
use the IBM Color Spooler to move the job into the 
Print queue or the Hold queue, or to discard it from 
the printer’s hard disk. See also IBM Color Spooler.

primary charging.   The uniform charging of the 
photoconductor drum cartridge with negative 
potential.

process color.   A mixture of CMYK inks that 
simulates a specified color. Process color is the 
traditional method for reproducing continuous-tone 
color images. See also spot color.

protocol adapter.   A device for attaching a printer 
to a token-ring network through a parallel port. The 
AXIS Protocol Adapter: Token Ring, available from 
retail suppliers, is the recommended device. See 
also token-ring network.

Q

QuarkXPress.   A page layout program developed 
by Quark, Inc., for Macintosh computers and PCs 
that accepts documents of unlimited length and 
includes many word processing functions.

Quickdraw.   The graphics and display technology 
built into Macintosh computers. Quickdraw is the 
equivalent of the PostScript language to send 
words and pictures to printers.

R

raster.   (1) On a computer monitor or television 
screen, the horizontal pattern of lines that forms the 
image. (2) A pattern of dots that consist of different 
data depths. For example, images with only black-
and-white values are 1-bit (on or off), grayscale 
images are 8-bit (256 levels), RGB images are 24-
bit (3 channels of 8 bits each), and CMYK images 
are 32-bit (4 channels.) Also called a bitmap.

raster image.   A series of pixels arranged in scan 
lines to form an image.

raster image processor (RIP).   A computer 
processor that renders PostScript instructions into 
dot patterns that are transferred to the final print 
medium. Most RIPs use reduced instruction set 
computer (RISC) processors to achieve extremely 
high throughput. A RIP typically includes a 
substantial amount of RAM to store the image as it 
is formed and a hard disk to buffer multiple pages. 
See also “ripping.”

red, green, blue (RGB).   The colors of computer 
monitor phosphors. RGB images are for monitor 
display only and are converted to CMYK images 
before printing.

registration.   In printing, the relative print positions 
of images that are printed at different times. For 
example, when you print on preprinted forms, the 
registration is good if the new image is aligned 
correctly with the preprinted image. Print that 
extends beyond box edges and text that overlaps 
other text are examples of poor registration.

rendering style.   A feature of the printer’s color 
management software that enables the best 
possible translation of color from one color device 
to another. The color-rendering styles that you can 
choose using their respective color-rendering 
dictionary (CRD) name are monitor, photographic, 
presentation, and solid color. See also rendering 
style, monitor style, photographic style, 
presentation style, solid-color style.

relocation kit.   The packaging and instructions 
you need to safely move the printer a substantial 
distance.

rendering.   See color-rendering style, 
photographic rendering.

“ripping.”   Raster-image processing. See also 
raster-image processor.

route power cable.   A cable that connects the 
power outlet on the optional tray 2 paper feeder 
with the power receptacle on the body of the printer.

S

scanner.   A device that examines OCR, MICR, or 
bar code patterns, generates electrical signals 
corresponding to the patterns, and sends the 
signals to a computer for processing.
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scatter.   To cause a beam of radiation to diffuse or 
disperse.

security paper.   Specially formulated paper used 
for negotiable documents like checks to prevent 
fraud.

separation.   The process of separating a color 
image into cyan, magenta, yellow, and black, the 
primary color components for printing. 

separation corona.   The unit in the printer that 
electrically charges paper to attract photoconductor 
toner onto the paper. The separation corona has a 
thin, electrically charged wire inside a metal tube 
with a narrow opening.

separation corona mode.   The voltage control 
mode for the separation corona. You can adjust the 
mode on the printer’s density gauge to resolve print 
quality problems by choosing voltage control on, 
off, or on or off in response to the environment. See 
also density control panel, density gauge, 
separation voltage.

separation voltage.   The ac corona charges 
applied in the separation charging unit to prevent 
image distortion in low-temperature, low-humidity 
environments. See also separation corona, 
separation corona mode.

server.    See file server.

SETUP.EXE file.   The file used to run a utility such 
as the IBM Color Downloader.

side-registration adjustment dial.   A dial at the 
back of the printer that adjusts the side registration 
of the tray 2 paper feeder.

single inline memory module (SIMM).   A plug-in 
memory module holding all the chips needed to add 
256K or 1M of random access memory (RAM) to a 
computer.

shipping spacers.   Any of several kinds of 
materials used to secure parts of the printer during 
shipping. 

side output tray.   When open, a tray that receives 
printouts faceup. The side output tray holds 
approximately 20 sheets of plain paper at 80 g/m2.

simplex printing.   Printing or reproducing in which 
only one side of the page is printed or reproduced.

small computer system interface (SCSI).   A 
standard for attaching peripheral hardware to 
computers.

soft font.   A printer font that must be transferred 
from a computer’s or printer’s hard disk to the 
printer’s random access memory (RAM) before the 
printer can use the font. Also called downloadable 
font.

solenoid.   An electrical conductor wound as a 
helix with a small pitch or as two or more coaxial 
helixes.

solid-color style.   A rendering style that maps 
unprintable colors to the closest printable colors 
when color accuracy is crucial. See also color-
rendering style, photographic rendering, and 
presentation rendering.

Spooler utility.   See IBM Color Spooler.

spooling.   The use of auxiliary storage as buffer 
storage to reduce processing delays when 
transferring data between peripheral equipment 
and the processors of a computer.

spot color.   Individual colored inks formulated to 
match a specified color exactly. See also process 
color.

star network.   A local area network (LAN) with a 
centralized topology and the physical layout of a 
star. See also Ethernet, token-ring network.

status message.   An operator message that you 
see on the display panel reporting on the current 
state of the printer.

subnet mask.   A filter for Internet protocol (IP) 
addresses that allows those addresses local to the 
network to be visible to the printer.

supplies replacement log.   A form provided in the 
Operator’s Guide on which you note printer 
supplies you replace and the date and print count at 
the time you replace them.

SyQuest.   A hard disk with removable media that 
is useful for the rapid transfer of large files between 
systems.
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T

tagged image file format (TIFF).   A bitmapped 
graphics format for scanned images of up to 300 
dpi.

TCP/IP transmission control protocol/Internet 
protocol.   The standard used by the Internet for 
transmitting information.

telnet.   In TCP/IP, an application protocol that 
allows a user at one site to access a remote system 
as if the user’s computer were locally attached. 
Telnet uses TCP as the underlying protocol. See 
also TCP/IP.

test mode.   The operational mode in which the 
printer can produce print samples, accept 
configuration changes, and control traces. 

test page.   A page you can print to see samples of 
color and grayscale on the printer.

text orientation.   The position of text as a 
combination of print direction and baseline 
direction. See also orientation.

thermistor.   A semiconductor device whose 
electric resistance is dependent on temperature.   

token.   In a local area network (LAN), a message 
or bit pattern that signifies permission to transmit. 
The token is passed successively from one 
workstation to another to indicate the workstation 
temporarily in control of the transmission medium. 
See also token-ring network.

token-ring network.   A local area network (LAN) 
with an architecture that combines token-passing 
with a hybrid star-and-ring topology. See also 
Ethernet, star network, token.

toner.   In color printing, the material that forms an 
image on paper. Toner adheres to the exposed 
areas on the photoconductor drum during the 
developing process and is then transferred to the 
paper to form the developed image on the paper. 

toner cartridge.   A cylindrical unit that supplies 
the toner for one of the four colors (cyan, magenta, 
yellow, and black) used for color printing. Four toner 
cartridges fit in the printer’s turret. See also turret.

toner cartridge position mark.   A mark on the 
printer’s turret that you use to align with the arrow 
on a toner cartridge.

toner projection development.   The process in 
which, when the area on the printer’s 
photoconductor drum cartridge that is irradiated by 
the laser beam comes close to the negatively 
charged toner on the cylinder, the difference in 
potential causes the toner to jump across and 
adhere to the drum surface.

topology.   The geometric arrangement of nodes 
and cable links in a local area network (LAN).

top output tray.   When the side output tray is 
closed, a tray that receives printouts facedown. The 
top output tray holds approximately 20 sheets of 
plain paper at 80 g/m2.

torque.   A force that produces rotation or torsion.

trailing edge.   The edge of the paper that goes 
into the printer last as it is inserted by the paper 
feeder.

transceiver chip.   Semiconductor material used 
for transmitting and receiving signals.

transfer drum.   The part of the printer where a 
toned image on the photoconductor drum is 
transferred to the paper. 

transfer sheet.   A special plastic-like material that 
surrounds the transfer drum and can maintain an 
electrical charge for paper attraction and image 
transfer. See also transfer drum.

transmission control protocol/Internet protocol 
(TCP/IP).   The standard used by the Internet for 
transmitting information.

transparency.   An acetate sheet that holds 
information to be shown by an overhead projector.

transparency film.   See transparency.

tray.   A receptacle to store paper or transparencies 
for printing. The printer has three trays: tray 1 used 
for paper, tray 2 used for paper, and an auxiliary 
tray used for paper and transparencies.

TrueType.   A font technology that offers scalable 
fonts to Macintosh and Windows systems for 
display on monitors and for use on printers.
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turret.   A rotating device in the printer that 
positions a selected toner cartridge for transferring 
toner to the photoconductor drum.

turret rotation knob.   The knob on the printer’s 
turret that you push and turn to replace a toner 
cartridge.

U

universal paper cassette.   A receptacle that fits 
into the printer’s tray 1 paper feeder or optional tray 
2 paper feeder. The universal paper cassette 
accepts Letter, Legal, A4, and JIS B5 paper sizes, 
and holds about 250 sheets (at 80 g/m2) of plain 
paper. 

used-toner bottle.    A bottle on the inside of the 
printer’s front door that receives excess toner not 
fused during the print cycle.

V

vector.   Absolute coordinate points and lines in 
space. PostScript files can hold vector graphics 
(also called object-oriented artwork). Vector files 
are converted to rasters in a raster image processor 
(RIP) during printing, giving the vector graphics 
device independence.

vector image.   Graphics created on computers in 
which the pixels are defined mathematically as lines 
or curves between points. Graphics created in 
illustration and page layout applications are also 
vector images. 

W

warning message.   An operator message that 
causes the Attention light to flash to alert you to an 
upcoming problem. You press ENTER to see the 
message on the display panel. See also error 
message, status message.

wire cleaner.   A small metal tool stored inside the 
printer and used to clean the separation corona 
wire and the window of the density detection 
sensor.

workstation.   In a local area network (LAN), a 
desktop computer that runs application programs 

and serves as an access point to shared network 
resources.

Z

zone.   In a local area network (LAN), a subgroup of 
networked workstations set aside and named by 
the network administrator to be treated as a group.
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